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Introduction About This Guide

| ntroduction

Welcome  Welcometo IBM® Sterling Gentran: Server® for Microsoft Windows Forms Integration
subsystem, an Electronic Data Interchange (EDI) form-generation software for the
Microsoft Windows operating system. Sterling Gentran: Server provides you with thetools
that you need to design forms to facilitate the keying and printing of EDI documents.
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About This Guide

What' s in this manual

What’sin this manual

Overview

Related manuals

I ntended audience

Prerequisite
knowledge

Thismanual contains atutorial for Sterling Gentran:Server Forms I ntegration, using the
TRADACOMS 92.1 standard. Thistutorial includes a print form example (purchase
order) and a screen entry form example (invoice). The purpose of this tutorial isto break
the form creation process into concise and understandabl e steps, using examples that
enable you to understand and master the tasks and processes required to create your own
forms.

Complete the print form tutorial first. After you have mastered the stepsinvolved in
creating a print form, you can begin the tutorial for the screen entry form.

To access reference information, refer to the online Help or IBM® Serling

Gentran: Server® for Microsoft Windows Forms Integration User Guide. For additional
information on the various tasks described in this manual, refer to the IBM® Serling
Gentran: Server® for Microsoft Windows Forms Integration User Guide.

Thismanual isintended for the following users:

»  Technical users—userswith adetailed knowledge of the Microsoft Windows
operating system, networking, databases, and communications.

» Novice-to-average experienced users—users who are new to Sterling Gentran: Server,
EDI, or both.

» EDI Coordinators—usersresponsiblefor creating and maintaining the transfer of EDI
data between Trading Partners.

The audience using this software should be familiar with:
» PC and Microsoft Windows functions

» EDI concepts

» EDI standard structure

» theinternal application format

» data mapping concepts

» Sterling Gentran:Server

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



Description of Contents About This Guide

Description of Contents

Overview  The Forms Integration TRADACOMS Tutoria contains the tasks associated with using
the Forms Integration subsystem.

Organization of  Thetutoria guideis organized into the following chapters:

chapters » Chapter 1, Getting Started, explains the content, organization, conventions, and

system requirements. This chapter describes how to build forms and how to
customize global EDI date formats.

» Chapter 2, Creating a Print Form, explains the tasks necessary to create a print form
for an TRADACOMS purchase order (ORDERS).

» Chapter 3, Creating a Screen Entry Form, explains the tasks necessary to create a
screen entry form for an TRADACOMS invoice (INVOIC).

» TheGlossary contains definitions of Forms Integration and Sterling Gentran: Server
terms and concepts.
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About This Guide Online Help

OnlineHelp

Overview  The mgjority of the IBM® Serling Gentran: Server® for Microsoft Windows Forms
Integration User Guide documentation is aso contained in the online Help system.
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Getting Support About This Guide

Getting Support

How To Get Help

IBM® Sterling Customer Center provides awealth of online resourcesthat are
available around the clock to enrich your business experiencewith IBM® Sterling
Gentran®. By using Sterling Customer Center, you gain access to many self-
support tools, including a Knowledge-Base, Documentation, Education, and Case
Management. Access this site at: Sterling Customer Center. (http://
customer.sterlingcommerce.com)

Oncelogged in, select Support Center from the top navigation menu, and then
locate Sterling Gentran product-specific support information from the left
navigation menu.

Additionally, our Customer Support Reference Guide outlines our support hours,
contact information, and key information that will enhance your support
experience with us. For detailed information about Customer Support, pleaserefer
to the Customer Support Reference Guide accessible from the login page. (http://
customer.sterlingcommerce.com)
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Introducing Forms I ntegration

Overview  The Sterling Gentran: Server Forms Integration subsystem enables you to design forms to
facilitate the keying (screen entry) and printing (print) of EDI messages that you receive
inbound or send outbound.

What isaform? A formisaset of instructions you define in the Forms Integration subsystem that indicates
how the system should format data. When you compile the form, Sterling Gentran: Server
generates a tranglation object. After you register the trandation object with Sterling
Gentran: Server and associate the tranglation object with a partner relationship, the system
uses the tranglation object to format EDI messages. The Forms Integration subsystem
enables you to create print and screen entry translation objects.

What isaprint A print translation object organizes and formats the printout of EDI messages that are
trandation object?  received from or sent to the trading partner(s) for which you have established atrading
relationship (inbound or outbound) that utilizes that print translation object. The print
transl ation object enables you to view the EDI message in an easily readable format.

What isascreen A screen entry translation object provides a standardized format for keying an EDI
entry trandation message into the Document Editor, for translation and transmission to your trading
object?  partner(s), for which you have established an outbound trading relationship that utilizes
that screen entry translation object. The screen entry trangation object ensures that your
users key all the data necessary to create the required EDI message.

Sterling Gentran:Server generates the actual format of the translation object based on the
EDI file format (in the EDI File Format Pane), and displaysit in the Layout Pane.
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Navigation

Overview  The Sterling Gentran: Server Forms I ntegration Window allows you to access its
functionality in four different ways, as follows:

» Click the menu option from the Main Menu Bar.
» Click the appropriate button on the Main Tool bar.
» Click or double-click the appropriate part of the form.

» Click aform component (EDI File Format Pane or Layout Pane) with the right mouse
button to access a shortcut menu that contains all the functions that are currently
available for that form component. The shortcut menus enable you to quickly and
easily access available functionality. The content of the shortcut menus will vary,
depending on the type and level of the selected form component.

Note

When you start Sterling Gentran:Server, the Main Menu Bar contains a subset of menu
items. The full set of menu itemsis displayed after you create a new form or open (load)
an existing form.

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



Forms|ntegration

This diagram illustrates the Forms Integration Window.
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Forms Integration
Window partsand
functions

This table describes the parts of the Sterling Gentran: Server Forms | ntegration Window.

Part Function

Main Menu Bar The Main Menu Bar contains the drop-down menus.

Unavailable items are dimmed.
Note

Detailed descriptions of each of the commands on these
menus are found in the online Help.

Main Toolbar The Main Toolbar gives you access to some of the

most common operations in Sterling Gentran: Server.
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(Contd)
Part Function

EDI File Format Pane The EDI File Format Pane contains the EDI file
format. When you click a ssgment or group in the EDI
file format, the corresponding frame is displayed in the
Layout Pane. When you click an element in the EDI file
format, the corresponding layout component is
highlighted in the Layout Pane.

Layout Pane The Layout Pane contains the actual format of the
translation object. Each group (with a maximum usage
greater than one) and repeating segment has a
corresponding frame in the Layout Pane. When you
click asegment or group in the EDI file format, the
corresponding frame is displayed in the Layout Pane.
When you click an element in the EDI file format, the
corresponding layout component is highlighted in the
Layout Pane.

Status Bar The Status Bar displays status information about a
selection, command, or process, defines menu items as
you highlight each item in the menu, and indicates any
current keyboard-initiated modes for typing (e.g., CAP
for the “Caps Lock” key, NUM for the “Num Lock”
key, etc.).

Main Toolbar ~ The Main Toolbar gives you access to some of the most common operationsin Sterling
Gentran:Server. Unavailable items are dimmed. The Main Toolbar is a dockable tool bar,
so you can affix it to any edge of the client window. This diagram illustrates the Main

Toolbar.
Tree Only
New Cut Constants Split Add Text Change
‘ Sa‘ve Pa|ste Cod‘e Lists ‘ Deactivate Un‘do ViTW
EEEEEEEEEEEEEIEEE = EEE ]
| | |
Open CoLy Syntax Activate Lock Labels Layout
) _ Tokens Only
Compile Session Promote Generate Redo
Rules Layout
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EDI File Format Pane

Overview  TheEDI File Format Pane (left side of the Forms Integration subsystem main window)
contains the EDI file format. The EDI file must contain all the information that you need
to include to either create a message using the Document Editor (screen entry translation
object) or print messages (print translation object), so that your system can accurately
process the data.

Generating EDI Sterling Gentran: Server will generate an EDI file for you, based on the standard (agency),
files  version, transaction set, and release (for the TRADACOM S standard only) you selected.
The system includes all the groups, segments, composites, and elements that are defined
by the standards agency for the version of the message you selected.

Reference

See Defining the Type of Form on page 2 - 19 (print) or Defining the Type of Formon
page 3 - 22 (screen entry) for moreinformation on generating an EDI file when you create
anew form.

You will typically need to customize the system-generated EDI file by modifying the
properties of the form components, and using specialized Sterling Gentran: Server
functions to manipulate the EDI file structure.

Generating If you want to use a specialized version of an EDI standard that is not availablein the
specialized EDI Sterling Gentran Standards database, it may be appropriate for you to define the EDI file

standard versions  yourself.

Regardless of whether the system generates the EDI file or you defineit, the specific EDI
form components that you will use will depend on the type of form you are creating. This
includes the standard, version, and transaction set (message) selected, and which groups,
segments, composites, and elements your company requires. We recommend that you
determine which form components you will be using before generating or defining an EDI
file
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Form components  Thistable described the form components that Sterling Gentran: Server uses to define the
EDI file format.

Note
When an element has an operation performed against it, ared checkmark is displayed over
the element icon.

Icon Description

A group isalooping structure that contains related segments
=P and/or groups that repeat in sequence until either the group data

ends or the maximum number of timesthat the loop is alowed to
repeat is exhausted. Groups are defined by the EDI standards. A
group that is subordinate to another group is a sub-group (this
corresponds to a nested looping structure — aloop within aloop).
The EDI fileisagroup and therefore, it is visually represented
the same way as other groups and sub-groupsin Sterling
Gentran: Server.

A segment contains a group of related elements or composite
data elements that combine to communicate useful data.
Segments are defined by the EDI standards. A segment can occur
once or can repeat multiple times.

5 A composite is a data element that contains two or more
component data elements or sub-elements. Composites are
defined by the EDI standards that use them (EDIFACT,
TRADACOMS, and certain ANSI X12 standards).

- An element isthe smallest piece of information defined by the
EDI standards. An individual element can have different
meanings depending on the context. Therefore, elements are
normally not considered to have useful meaning until they are
combined into segments.

» When afield has a mapping operation performed against it,
ared checkmark is displayed over the field icon.

» When afield contains a standard rule a black asterisk
appears to the right of the element icon.
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L ayout Pane

Overview  The Layout Pane (right side of the Forms I ntegration subsystem main window) contains
the actual format of the translation object. Sterling Gentran: Server uses frames to format
the EDI filefor the trandlation object. Each frame contains the groups, repeating segments,
and elements at that level (single segments are not represented on the frame).

List formats  For screen entry translation objects, groups (with a maximum usage greater than one) and
repeating segments are formatted as list boxes. Elements are formatted as edit boxes
(fields) or drop-down list boxes on the frame. Elements will typically be formatted as
fields, but will be formatted as a drop-down list box if you apply a standard rule that
allows a selection of multiple items. Each group and repeating segment also has a
corresponding frame that contains all the groups (with amaximum usage greater than
one), repeating segments, and elements at that level.

Field formats  For print translation objects, groups, repeating segments, and elements are always
formatted asfields. Each group and repeating segment also has a corresponding frame that
contains all the groups (with amaximum usage greater than one), repeating segments, and
elements at that level.

Displaying  When you click asegment or group in the EDI File Format Pane, the corresponding frame
information isdisplayed in the Layout Pane. When you click an element in the EDI File Format Pane,
the corresponding layout component is highlighted in the Layout Pane.
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Building a Form with Forms I ntegration

Overview  This section defines how to proceed with building aform using the Sterling
Gentran: Server Forms Integration subsystem.

Sagesof building  Thistable describes the steps required to build a form using Forms I ntegration.

aform

Sage

Description

1

Prepareand Analyze.

Obtain alayout of how you want the form to be displayed and determine
how it corresponds to the EDI standard you will be using. Determine what
operations need to be performed to generate the required layout.

Set Global Defaults (first time only).
Thefirst time you use Sterling Gentran:Server, you should establish the
default date format that the system will use.

Reference

See Verifying the Global EDI Date Formats on page 2 - 18 (print) or
Verifying the Global EDI Date Formats on page 3 - 21 (screen entry) for
more information.

Create, Save, and Name a New Form.

Reference
See Design and Create the Form on page 2 - 18 (print) or Design and
Create the Form on page 3 - 21 (screen entry) for more information.

Activate the Appropriate EDI Groups, Segments, Composites, and
Elements.

Reference

See Activating Groups, Segments, Composites, and Elements on
page 2 - 24 (print) or Activating Groups, Segments, Composites, and
Elements on page 3 - 26 (screen entry) for more information.

Promote, Split, and Change Segments and Groups.

Reference

See Madify Form Components on page 2 - 30 (print) or Modify Form
Components on page 3 - 31 (screen entry) for more information on
promoting, splitting, and changing segments and groups.

Customize the EDI Data.

Reference
See Customize the EDI Data on page 2 - 37 (print) or Customize the EDI
Data on page 3 - 39 (screen entry) for more information.
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(Contd)
Sage

Description

7

Definethe Layout of the Form.

Reference

See Verifying EDI Delimiters on page 2 - 28 (print) or Verifying EDI
Delimiters and Adding Frame Help Text on page 3 - 29 (screen entry) for
more information on customizing your EDI file, including verifying the
EDI delimiters.

Compilethe Form.

Reference

See Compiling the Form on page 2 - 95 (print) or Compiling the Formon
page 3 - 145 (screen entry) for more information on compiling the form
and trandation object naming conventions.

Print the Report.
Validate and review the form, and make modifications as needed.

Reference
See Printing the Report on page 2 - 96 (print) or Printing the Report on
page 3 - 147 (screen entry) for more information.

10

Test the Translation Object.

For a screen entry translation object, create a new message in Document
Editor, using the screen entry translation object. For a print trandation
object, print a message. Verify that the output is correct.

Reference
See Testing the Trandlation Object on page 2 - 97 (print) or Testing the
Translation Object on page 3 - 148 (screen entry) for more information.

Sterling Gentran:Server — May 2011
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How to Launch Forms I ntegration

Overview  This section describes how to launch the Forms Integration subsystem by means of
Sterling Gentran:Server.

Procedure  Usethis procedure to launch the Forms I ntegration subsystem.

Sep Action
1 Select Programs from the Microsoft Windows Start menu.
2 Select Gentran Server Forms I ntegration from the Gentran Server
Programs group.

System Response
The system displays the Forms Integration subsystem.
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How to Install Sterling Gentran Standards

Overview  Note
You need to install Sterling Gentran Standards only if you installed Integration

Components during the Sterling Gentran:Server installation.

Reference
See the appropriate Sterling Gentran Standards card for information about installing the
Sterling Gentran Standards.

Sterling Gentran:Server — May 2011 Forms Integration TRADACOMS Tutorial Guide



CHAPTER

2

Creatinga Print Form

CONLENES  OVEINVIBW .ottt et e ettt e e 2-3
D INtroduction ... ... 2-3

» Phasesof DesigningaForm ... 2-5

D GettingStarted ........... 2-6
AnalyzetheEDI File ....... ... .. i 2-7
D BasiCTaskS. ..o 2-7

Design and CreatetheForm ... ... .. .. ... .. ... . i, 2-16
» VeifyingtheGlobal EDI DateFormats ....................... 2-16

» Definingthe Typeof Form......... ... . i, 2-17

» Activating Groups, Segments, andElements . ................... 2-21

» VerifyingEDI Delimiters. . ... 2-24
Modify Form Components ...t 2-27
» Promoting and Changing Segmentsand Groups . ................ 2-27

» Modifying the Maximum Use of the REF Segment .............. 2-28

» InsertingaNew N4 Group . ......cvviiiiii i 2-29

» Modifying the Maximum Use of thePID Group ................. 2-32

» PromotingtheDTM:2Segment ............covviiineennn.. 2-34

D CreatingaCTT GrOUP . .o vv ettt e 2-37

» GeneratingtheForm........... ... i 2-40
CustomizetheEDI Data .............iiiiiiiiii i 2-42
D OVEIVIBIW ot 2-42

» CustomizingtheBEG Segment ..............ccoiviiiineinn... 2-44

» CustomizingtheNTESegment ................coviiriennn... 2-53

» CustomizingtheREF Segment .......... ... . ... . .o ion... 2-55

» CustomizingthelTD Segment ...............ciiiiiininnn... 2-58

» CustomizingtheNLGroup ............coiiiiiiiiiiinannnn.. 2-64

» CustomizingtheN1Segment...............cciiiiiininnn... 2- 66

» CustomizingtheN3Segment............ ... ... ... 2-71

» CustomizingtheN4Segment..............cc e, 2-73

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



» CustomizingthePO1Group ...........coiiiiiiinnnnnnnn... 2-76
» CustomizingthePOlSegment ...............c.ccoiiiiieinn... 2-78
» CustomizingthePID Group ...t 2-86
» CustomizingtheDTM:4Segment ..., 2-88
» CustomizingtheDTM:2Segment ...............cccivvivnan... 2-95
FormatthePrint Form ........ ... . .. . . . . . 2-100
D OVEIVIBIW oot 2-100
» ResizingtheHeaderFrame .............. ... ..., 2-101
» AddingaTitletotheForm .......... .. ... .. .. ... 2-102
» Arranging the Header Fields (BEG and REF Segments) .......... 2-104
» Arrangingthe NoteField........... ... .. .. . . it 2-107
» Arrangingthe Termsof SaleFields ......................... 2-109
» Arranging the Nameand AddressFields ..................... 2-111
» ArrangingtheLineltemsFields............................. 2-115
» Resizingthe Transaction Total Frame .. ...................... 2-132
Finalizethe Form . ...... .. . e 2-133
D OVEIVIBIW o 2-133
» CompilingtheForm ......... ... ... . i 2-134
» PrintingtheReport . .......... .. 2-136
» TedtingtheTrandationObject ................ ... ... oin.. 2-137

Sterling Gentran:Server — May 2011

Forms Integration TRADACOMS Tutorial Guide



Overview

| ntroduction

Inthischapter  Thischapter includes the following topics associated with creating a print form:
» Formanalysis
» Creating, saving, and setting up a new form
» Customizing the form, including the groups, segments, and elements
» Formatting the form, including fields and field labels
» Finaizingtheform

Purposeof this  Thistutorial explains how to customize and format aform beforeit is compiled into a
tutorial tranglation object. The form that you create is a sour ce form. After that source formis
compiled, the result is a compiled tranglation object. You must register the translation
object with Sterling Gentran: Server before you can use the translation object to print
messages of that type.

Formcriteria  Sterling Gentran:Server generates a basic form based on the following criteriayou
specify:
» Typeof form (e.g. print or screen entry)
» Standard agency (e.g. TRADACOMS, EDIFACT)
» Standard version (e.g. ANAOOL, 92.1)
» Messagetype (e.g. ORDERS, INVOIC)
» Release (message version) (e.g. 9)

Mandatory  All mandatory groups, segments, composites, and elements for the standard, version, and
components  message you specify are available for use (activated) when Sterling Gentran: Server
creates aform. Only these mandatory form components (groups, segments, composites,
and elements) are activated automatically. You must activate additional form components
to accommaodate the data you expect to receive from your trading partner, and then
customize and format the form so that it is appropriate and useful for your company’s
needs.
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Beforeyou begin  Before you begin to customize a print form, you should be familiar with the following
elements of form design:

» EDI standards (how EDI standards work and how the information your users need is
tranglated to and from the standards)

» Your users (the individuals who will be using the print forms to create printouts of
processed EDI data)

» Your trading partners (the organisations that send you or that you send the EDI datato
be processed and printed)

You can create adifferent print form for each combination of message, trading partner,
standard version, and release. There is no limit to the number of print forms you can
create, and the number of print forms you create is not affected by the number of screen
entry forms you create.

Recommendation

We recommend that you mock up alayout of the print form the way you ultimately want it
to look. Asyou are designing the layout, you should take into consideration the people
who will be using the printouts. Make sure that the form makes sense to the people who
will be using it. By analyzing your company’s needs before you actually create the print
form, you will reduce the amount of time spent later on redesigning or reformatting the
form. Specifically, you should include the following design considerationsin your form
planning:

» Which fields should be printed, and which are necessary for the EDI data but do not
need to be displayed on the printout

» Wherefields should be located on the form

» What labelsyou will use to identify the fields on the form

Note

Press F1 from any area of the system to access the online Help for that function. The
online Help system contains field definitions and other detailed information.
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Phases of Designing a Form

Design phases  There are four phasesin designing aform. These phases generally are completed in the
order in which they are listed below, although the form design processis an iterative one
(that is, the phases may overlap). Thistutorial is designed to guide you through each of
these four phasesin sequential order, completing one phase before proceeding to the next.
However, when you create your own forms, the phases may overlap, and usually you will
return to one or more of the phases several times before the form is compl eted.

Phase Description
1 Analyze the EDI file.
2 Design and create the form.
3 Modify form components.
4 Customize the EDI data.
5 Format the form.
6 Finalize the trandl ation object.
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Getting Sarted

Overview  Thistutorial is meant to be completed in its entirety. We strongly recommend that you
complete each task sequentially. The purpose of completing each task in this tutorial in
sequential order, asif it were your own scenario, is hot only to teach you how to perform
the individual tasks, but also to teach you alogical approach and methods that should be
used when you create your own form.

This section guides you in completing the stepsin the first phase of form design. In this
section, you will create anew print form based on a scenario we have defined for you.
This section includes the basics of creating the form, such as defining the scenario and
analyzing the purpose of the form, creating and saving the form, and setting up the form.
You can find techniques for customizing the segments, elements, and groups in the form,
aswell asfor formatting the organisation and appearance of the form, later in this chapter.

Print form For thistutorial, you will create a print form for the ORDERS message (purchase order),
scenario using the TRADACOMS ANAOQOL release 9 standard. The steps involved in creating this
form are broken down into manageabl e pieces so that you can learn the tasks and
procedures involved in creating a print form. Then, you can apply the knowledge gained
from using thistutorial to create your print forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures awide
variety of pet suppliesfor pet stores. You will create aform that formats and arranges the
EDI datayou receive from one of your trading partners, Pet Zone (alarge pet supply
retailer), to produce a printout of a purchase order. You do not want to alter the integrity of
the EDI data. However, you will want to interpret some of the codes included in the EDI
message into more meaningful text.
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Analyzethe EDI File

Basic Tasks

Introduction

To analyze the EDI fileg, first you must determine what data your trading partner will send
you. You and your partner must agree on which standard, version, message, and release
you will be using. In thistutorial, you are using a TRADACOMS ANA0O1 ORDERS
release 9 purchase order. It isimportant to know the information that your partner will
send you in the purchase order, and what data will be contained in each element used.

It isvery helpful to review the EDI standard that you will use before analyzing the EDI
file. We recommend that you obtain an EDI standard manual for the standard and version
that you will use. Standard manuals are available from EDI standard agencies.

The TRADACOMS standard uses a header with each interchange (ORDHDR for the
ORDERS message). The header message contains information that pertainsto each
message in the interchange. Sterling Gentran: Server copies the header segmentsto the
beginning of each document, to ensure that all the relevant information is contained in the
document. Therefore, you will need to load the header message (ORDHDR) into the
ORDERS EDI file, so that all the segments and elements are available for use.

After discussing with your partner what they will send, determining which segments and
elements your company requires, and reviewing the EDI standard, you can list the items
that you will need to use. Then, you will make the form components you need available
for use (activate). When Sterling Gentran: Server generatesthe EDI file format, the system
includes all the groups, segments, composites, and elements that are defined by the
standard agency for the version of the message you selected. The system activates all the
groups, segments, composites, and elements that are defined as mandatory (must be
present) by the standard. The system does not enable you to deactivate mandatory groups,
segments, composites, and elements.
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Mandatory For aTRADACOMS ANAO0OL ORDERS release 9 purchase order, the following groups,
components  segments, composites, and elements have been defined as mandatory by the standards
committee.

This table describes the components that are activated automatically when you create a

new form.
Group Segment Composite Element Description
ORDHDR Order File Header
TYP Transaction Type Details
CD02 Transaction Code

SDT Supplier Details
SIDN

CDT Customer Details
CIDN

FIL File Details
FLGN File Generation Number
FLVN File Version Number
FLDT File Creation Date

CLO Customer’s Location
CLOC

ORD Order References
ORNO

OoLD
OTR Order Trailer
LORD Lines Ordered

When translating data, the system does not process groups, segments, composites, and
elements that are not activated. Therefore, you must make available (activate) the form
components that are not defined as mandatory by the standard, but that you have
determined you need to use in the form.
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Form analysis  Thefirst step in creating aform isthe analysis of the form requirements. If the analysis
you perform is complete, you will have all the information you need to create the formin
an efficient and logical manner. If you omit this critical step and proceed directly to
creating the form, it islikely that creating the form will be a much longer and arduous
task, and the form may not work the way you need it to, due to oversights and omissions.

Creating a print form for the TRADACOMS ORDERS purchase order requires several
steps. Some steps are performed at the message level (such as activating form
components), and others are iterative steps that are performed for each group, segment, or
element in the form. In this analysis phase, you must determine what EDI data Pet Zone
will be sending you, as well as what information you want to print for the purchase order.
The fields on the form must accommaodate all information that you want to print from the
purchase order your trading partner sends you.

Required Thistable lists the form components that are required (need to be activated) and are not
components  mandatory for the standard.

Note

When you activate aconditional group, segment, or composite, the mandatory subordinate
segments, composites, and elements are activated automatically. A conditional group,
segment, or composite isused only if thereis EDI data available for an element in it.

Data Code Value/Format
Element Description Type | Length to Be Assigned

Order File Header (ORDHDR Group) (Already Activated)

Supplier Details (SDT Segment) (Already Activated)

SDT SIDN SIDO Supplier's ANA String | 13
Location Code

SDT SNAM Supplier’s Name String | 40

Customer Details (CDT Segment) (Already Activated)

CDT CIDN CIDO Customer’'s ANA String | 13
| dentity/Loc

CDT CNAM Customer’s Name String | 40

CDT CADD CADO Customer’s Address String | 35
Linel

CDT CADD CAD1 Customer’s Address String | 35
Line2

CDT CADD CAD2 Customer’s Address String | 35
Line3

CDT CADD CAD3 Customer’s Address String | 35
Line4
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(Contd) Data Code Value/Format
Element Description Type | Length to Be Assigned
CDT CADD CAD4 Customer’'sPost Code | String | 8

Customer’s Location (CLO Segment) (Already Activated)

CLOCLOC CLOO Customer’'s ANA String | 13
Location Code
CLO CNAM Customer’s Name String | 40
CLO CADD CADO Customer’s Address String | 35
Linel
CLO CADD CAD1 Customer’s Address String | 35
Line2
CLO CADD CAD2 Customer’s Address String | 35
Line3
CLO CADD CAD3 Customer’s Address String | 35
Line4
CLO CADD CAD4 Customer’s Post Code String | 8
Order References (ORD Segment) (Already Activated)
ORD ORNO ORNO Customer’s Order String | 17
Number
ORD ORNO ORN2 Date Order Placed by Dt/Tm | 6 Screen Format =
Customer DD/MM/YY
ORD CDO07 Order Code String |1 Any valid code
Delivery Instructions (DIN Segment)
DIN LDAT Latest Delivery Date Dt/Tm | 6 Screen Format =
DD/MM/YY

Order Line Details (OLD Group) (Already Activated)

Order Line Details (OLD:2 Segment)

OLD:2 SPRO SPR1 Supplier’'s Code for the | String | 30
Traded Unit

OLD:2 CPRO CPR1 Customer’'sitem Code | String | 30

OLD:2 UNOR UNOQO Consumer Unitsin String | 15 Format = NO
Traded Unit

OLD:2 UNOR CD0O4 M easure Indicator String | 6

Sterling Gentran:Server — May 2011

Forms Integration TRADACOMS Tutorial Guide




(Contd) Data Code Value/Format

Element Description Type | Length to Be Assigned
OLD:20QTY OQTO0 Number of Traded Units | String | 15 Format = NO
Ordered
OLD:2 OUCT OUCO Cost Price Redl 14 Screen Format = R4

OLD:2 TDESTDEO Traded Unit Descr. Line | String | 40
1

OLD:2 TDESTDEL1L Traded Unit Descr. Line | String | 40
2

Segment analysis  For each segment activated (either mandatory or optional), you must answer the following
guestions:

» Isthe segment agroup?
»  Will the segment have a maximum use greater than one?
» What composites and elements need to be activated for the segment?

This table describes the segment components used in this tutorial.

Component Description

Group Contains related segments and/or groups that repeat in
sequence until either the group data ends or the maximum
number of times that the loop is allowed to repeat is
exhausted.

Repeating segment Consists of elementsthat repeat (in sequence) until either the
data ends or the maximum number of times the segment is
allowed to repeat is exhausted.

Composite Contains two or more component data elements or
subelements. Composites are defined by the EDI standards
that usethem (TRADACOMS, EDIFACT, and certain ANSI
X12 standards).
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(Contd)Component Description

Maximum use Refers to the number of times that a segment can be used
within the structure in which the segment is defined. For
example, if asegment can be used only once within agroup,
but the group can be used multiple times, the segment still
has a maximum use of one within each occurrence of the
group. The standard defines the maximum number of times
a segment can be used, but you must determine which of
these segments will be used, based on what your trading
partner will be sending you.

Elements Each segment contains elements. Some elements are
mandatory and others are optional to the standard but
necessary for your needs. You must define all the elements
that you will be expecting from Pet Zone for each segment.

Customisation Sterling Gentran: Server generates a form based on the groups, segments, composites, and
tasks elementsyou activate. At this point, the form is compliant with the standard and it
contains all the necessary components based on the data Pet Zone will send you. However,
you need to customize the form components to produce a printed report that |ooks the way
your company expectsit to look.

This table lists the customisation tasks described in this tutorial.

Form Component Description Customisation Task

ORDHDR group Order FileHeader | You will promote this group so that the
fieldsin this group are placed on the
parent frame.

TYP CDO02 element | Transaction Code This element isrequired in the purchase
order, but is not meaningful for your
purposes. Therefore, you will prevent this
field from being printed on the printout.

SDT SIDN SIDO Supplier's ANA This element isrequired in the purchase
element Location Code order, but is not meaningful for your
purposes. Therefore, you will prevent this
field from being printed on the printout.

SDT SNAM Supplier’s Name Thiselement isrequired in the purchase
element order, but is hot meaningful for your
purposes. Therefore, you will prevent this
field from being printed on the printout.

CDT CIDN CIDO Customer’s ANA This element is required in the purchase
element | dentity/Loc order, but is not meaningful for your
purposes. Therefore, you will prevent this
field from being printed on the printout.
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(Contd)
Form Component

Description

Customisation Task

CDT CNAM Customer’'sName | You will change the field name to

element “Customer”, which better describes the
datain thisfield for your company.

CDT CADD CADOQ | Customer’s The datain this element will be self-

element AddressLinel explanatory, so you will remove the label
from thisfield.

CDT CADD CAD1 | Customer’s The datain this element will be self-

element AddressLine2 explanatory, so you will remove the |abel
from thisfield.

CDT CADD CAD2 | Customer’s The datain this element will be self-

element AddressLine 3 explanatory, so you will remove the label
from thisfield.

CDT CADD CAD3 | Customer’s The datain this element will be self-

element AddressLine4 explanatory, so you will remove the label
from thisfield.

CDT CADD CAD4 | Customer’s Post The datain this element will be self-

element Code explanatory, so you will remove the |abel
from thisfield.

FIL FILGN File Generation This element isrequired in the purchase

element Number order, but is not meaningful for your
purposes. Therefore, you will prevent this
field from being printed on the printout.

FIL FILVN element | File Version This element isrequired in the purchase

Number order, but is not meaningful for your

purposes. Therefore, you will prevent this
field from being printed on the printout.

FIL FILDT element

File Creation Date

This element isrequired in the purchase
order, but is not meaningful for your
purposes. Therefore, you will prevent this
field from being printed on the printout.

CLOCLOC CLOO | Customer’'s ANA This element isrequired in the purchase
element Location Code order, but is not meaningful for your
purposes. Therefore, you will prevent this
field from being printed on the printout.
CLO CNAM Customer’'sName | You will change the field name to
element “Location”, which better describes the

datain thisfield for your company.
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(Contd)

Form Component Description Customisation Task
CLOCADD CADO | Customer’s The datain this element will be self-
element AddressLine 1 explanatory, so you will remove the label

from thisfield.

CLOCADD CAD1 | Customer’s The datain this element will be self-
element AddressLine?2 explanatory, so you will remove the label

from thisfield.

CLOCADD CAD2 | Customer’s The datain this element will be self-
element AddressLine 3 explanatory, so you will remove the |abel

from thisfield.

CLOCADD CAD3 | Customer’s The datain this element will be self-
element AddressLine 4 explanatory, so you will remove the label

from thisfield.
CLOCADD CAD4 | Customer’s Post The datain this element will be self-
element Code explanatory, so you will remove the label
from thisfield.

ORD ORNO Customer’s Order You will set up the document name (which

ORNO element Number enables you to differentiate between
messages in the document browsersin
Sterling Gentran: Server) in this element.
Also, you will change the field nameto
“Order Number”, which better describes
the datain thisfield for your company.

ORD ORNO Date Order Placed | You will change the field nameto “ Order

ORNZ2 element by Customer Date”, which better describes the datain
thisfield for your company. Also, the date
in the EDI datawill be in the format
“YYMMDD”, but you want the date to be
printed in the format “DD/MM/YY”, so
you will set the screen format accordingly.
In addition, you will change the field and
element lengths to reflect the longer date
format.

ORD CDO07 Order Code The code from this element will be used to

element look up the description in a code values

list, and the description will be printed in
another field that you create. You will
prevent the Order Code field from being
displayed on the printout, because the
more meaningful description will be
printed instead.
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(Contd)

Form Component Description Customisation Task
DIN LDAT element | Latest Delivery The date in the EDI datawill be in the
Date format “YYMMDD”, but you want the

date to be printed in the format “DD/MM/
YY", so you will set the screen format
accordingly. Also, you will change the
field and element lengths to reflect the
longer date format.

OLD group

Order Line Details

After you customize and format the fields
in the OLD group, you will copy and paste
the OLD group at the same level in the
EDI file. The original OLD group will
contain column headings for the line item
detail, but you will prevent the column
headings from being printed for al line
items after the first. You will change the
maximum use of the first OLD group to
one so that the column headings are
printed only once (for thefirst line item).
You will change the maximum use of the
second OL D group to 999,998. Up to
999,999 line items (one from the first
OLD group and

999,998 from the second OLD group) can
be printed on the printout (without
printing the column headings for each line
item).

OLD:2 SEQA
element

First Level
Sequence Number

The standard allows a maximum length of
ten digits, but you expect a number no
longer than five digits from your partner.
You will change the maximum length of
the element and the display length of the
field to five. You will change the field
nameto “Line”, which better describesthe
datain thisfield for your company.

OLD:2 SPRO
SPR1 element

Supplier’'s Codefor
the Traded Unit

The standard allows a maximum length of
thirty characters, but you expect a string
no longer than ten characters from your
partner. You will change the maximum
length of the element and the display
length of the field to ten. You will change
the field nameto “Prod ID”, which better
describes the datain thisfield for your
company.
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Form Component

Description

Customisation Task

OLD:2 CPRO
CPR1 element

Customer’s ltem
Code

This element isrequired in the purchase
order, but is not meaningful for your
purposes. Therefore, you will prevent this
field from being printed on the printout.

OLD:2 UNOR
UNOO element

Consumer Unitsin
Traded Unit

The standard allows a maximum length of
fifteen characters, but you expect a
number no longer than ten digits from
your partner. You will change the
maximum length of the element and the
display length of thefield to ten. Also, you
will change the data type from string to
number, and assign EDI and screen
formats of NO (indicating a number with
an implicit decimal point and no decimal
places). In addition, you will change the
field name to “Cons. Units”, which better
describes the datain thisfield for your
company.

OLD:2 UNOR
CD04 element

Measure Indicator

You will change the field name to “Unit”,
which better describesthe datain thisfield
for your company.

OLD:2 OQTY
OQTO0 element

Number of Traded
Units Ordered

The standard allows a maximum length of
fifteen characters, but you expect a
number no longer than six digits from
your partner. You will change the
maximum length of the element and the
display length of thefield to six. Also, you
will change the data type from string to
number, and assign EDI and screen
formats of NO (indicating a number with
an implicit decimal point and no decimal
places). In addition, you will change the
field name to “Qty Ord”, which better
describes the datain thisfield for your
company.
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(Contd)
Form Component

Description

Customisation Task

OLD:2 OQUCT
OUCO element

Cost Price

The standard allows a maximum length of
fourteen digits, but you expect a number
no longer than ten digits from your
partner. You will change the maximum
length of the element and the display
length of the field to ten. Also, you will
change the screen format of the datato R4
(indicating a number with an explicit
decimal point and four decimal places). In
addition, youwill changethefield nameto
“Price Each”, which better describes the
datain thisfield for your company.

OLD:2 TDES
TDEO element

Traded Unit Descr.

Linel

The datain this element will be self-
explanatory, so you will remove the label
from thisfield.

OLD:2 TDES
TDE1 element

Traded Unit Descr.

Line2

The datain this element will be self-
explanatory, so you will remove the |abel
from thisfield.

OTR segment

Order Trailer

You want this segment to print the total
number of lineitems at the end of the
printout. However, if the form were
generated now, the total would be printed
at the beginning of the printout (because
the fieldsin the OTR segment would be
displayed on the same frame as the fields
in the ORDHDR group). You will change
the arrangement of the form, while
maintaining the integrity of the EDI data,
so thetotal is printed at the end of the
purchase order.

OTR LORD
element

Lines Ordered

You will change the field nameto
“Number of Line Items’, which better
describes the datain thisfield for your
company.
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Design and Create the Form

Verifying the Global EDI Date Formats

Introduction

Procedure

Sterling Gentran: Server enables you to customize the global EDI date formats (for all
forms). You can specify the default EDI format of dates for both six-character dates and
eight-character dates. When you customize the global EDI date formats, the settings are
valid for all forms created in the current session of Sterling Gentran: Server. However, you
can override the default date formats for an individual element on the Element Properties
dialog for that element.

You must verify that you are using the correct global date formats the first time you use
Sterling Gentran: Server. Typically, you will verify the global EDI date formats one time
only. You can change the default date formats if they do not match the formats you intend
to use.

Use this procedure to verify the global EDI date formats.

Sep Action

1 Select Preferences from the Options menu to display the Preferences
dialog. The Preferences dialog is a property sheet that enables you to set
global defaults for Sterling Gentran: Server.

2 Verify that the Standard Formats tab displays the default date formats that
are used when elements are read from the standards database.

3 Verify that the Six-character dates drop-down list box contains
YYMMDD to define the format of the six-character EDI datesin your
forms.

4 Verify that the Eight character dates drop-down list box contains
YYYYMMDD to define the format of the eight-character EDI datesin
your forms.

5 Click OK to accept the default date formats for 6- and 8-character date
fields and exit the Preferences dialog.

Note

To change the order in which the date formats appear in the Six-character
dates and Eight character dates drop-down list boxes or to add a new date
format to the lists, select Date For mats from the Options menu.
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Defining the Type of Form

Overview  Thefirst task in creating a new form isto define the type of form and EDI standard,
version, transaction (message), and release. In thistutorial, you are creating aprint form
so that you can print the purchase orders that your partner sends you. Instead of defining
the ORDERS message to the system yourself, you want Sterling Gentran:Server to use the
standards database on your system to build the purchase order according to the
TRADACOMS standard.

Procedure  Usethis procedure to create the new print form.

Step

Action

Select New from the File menu to display the New Form Wizard.

From the What kind of form list, select Print to indicate that the
translation object you are creating is a print transl ation object.

In the What is the name of the form box, enter Print TRADACOM S
ORDERS Pet Zone. This description provides a brief explanation of the
compiled trandlation object that enables you to differentiateit from similar
translation objects in Sterling Gentran: Server.

Example
Print TRADACOMS ORDERS Pet Zone is the description of a
TRADACOMS ANAOO1 purchase order (ORDERS) for partner Pet Zone.

Verify that the name that appearsin the What is your name box is
accurate.

Click Next to advance the wizard.

Select Delimited EDI asthe dataformat syntax that you want to use.

Click Customize.

System Response
The system displays the New Delimited EDI Wizard.

Click Next to continue.

From the Data Source list, select Gentran Sandards ODBC data source.

10

Click Next to continue.

11

From the Agency list in the Standards section, select [A] Tradacoms,
which isthe EDI standard you will use for this translation object.
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(Contd)
Step

Action

12

From the Version list, select [ORDERS] ORDER DETAILS, whichis
the version of the standard you use for thistranslation object. The versions
that are available depend on which standard you selected.

13

From the Transaction list, select [850] PURCHASE ORDER, whichis
the transaction set (document) you use for this translation object. The
documents that are avail able depend on which standard and version you
selected.

14

From the Release drop-down list, select 9, which is the message version
you will use for this trandation object. The message versionsthat are
available depend on which message (transaction) you selected.

15

Click Next to continue.

16

Click Finish. This may take afew seconds.

System Response
The system displays the New Form Wizard dialog box.

17

Click Next to continue.

18

Click Finish to create the EDI file (it may take afew secondsto create the
file).

System Response
Theform is displayed as follows:

= Prnt TRADACDIME DADERS Pet Zone

EORDERS - M - 1 ORDER DETAILS
w0 M - 1 CUSTOMER'S LOCATION
ORD - M - 1 DRDER REFERENCES

QLD - - Sroereg
OTR <M« TORDER TRAILER

<l |

19

From the Edit menu, select Details.

System Response
The Translation Object Details box is displayed.

20

Verify that Print is selected from the Translation Object Function list.

21

In the Major version box, enter 1 to designate the version number for this
translation object.
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Sep

Action

22

In the Minor version box, accept the default value O that designates the
release number for this translation object.

Hint

When you make amajor change to this form, increase the version to the
next higher sequential number (e.g., 2.0, 3.0). If you make aminor change
to the form, increase the rel ease to the next higher sequential number (e.g.,
2.1,22).

23

The Input and Output boxes (Agency, Version, Transaction, Release, and
F Group) contain information only if the Input and/or Output sides of the
form are of EDI format. For thistutorial, do not change the information in
these boxes.

Note

The system alows you to change the information in the Input and Output
boxes, but modifying this information does not alter the content of the
form. An example of when you might want to ater these boxes is when
you want the form to reflect a standard version that is not loaded on your
system. You can change the version on this dialog, and then physically
ater the form to be compliant with that version.

24

Click OK to save the trandlation object details.

25

Select Save from the File menu.

Recommendation

We recommend that you save the form as often as possible, to mitigate the
possible loss of additions or modificationsin the event of a hardware or
system error.

Note

If you have performed any function that invalidates the current format of
the translation object, the Save function is unavailable until you
regenerate the layout (click Generate Layout on the Main Toolbar).

26

Verify that the Savein list reflects the drive\folder where Sterling
Gentran:Server isinstalled.

Default
The default drive\folder is GENSRVNT\Forms.
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(Contd)
Sep

Action

27

In the File name box, enter pettordp.stp to replace the default file name.
You allocate afile name to aform when you save the form for the first
time or use the Save As function to save a copy of the form under a
different name. The name of the form must be one to eight unique
characters that define the form in a meaningful way. For example,
“PET_850P” isthe name of aprint form for an ANSI X12 purchase order
message (850) for partner Pet Zone.

Note

The default file extension for formsis .STP. Using this extension
distinguishes source form files from other types of files, such as compiled
tranglation objects. The naming conventionsin Sterling Gentran: Server
are asfollows:

» Thesourceform (form created in Sterling Gentran: Server) should be
named using the file extension .STP (e.g., PET_850P.STP).

» Thecompiled trandation object (trandlation object that is the result of
compiling the source form) should be named using the samefile
name that was allocated to the source form, but with thefile extension
.TPL (e.g., PET_850PTPL).

Recommendation

We recommend that you use these naming conventions to distinguish
source forms and compiled translation objects from other types of files.
Use the same file name (different file extension) for a source form and the
tranglation object that was compiled from it.

28

Click Save to save the form.
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L oading the ORDHDR Message

Overview  The TRADACOMS standard uses a header with each interchange (ORDHDR for the
ORDERS message). The header message contains information that pertainsto each
message in the interchange. Sterling Gentran: Server copies the header segmentsto the
beginning of each document, to ensure that all the relevant information is contained in the
document. Therefore, you need to |oad the header message (ORDHDR) into the ORDERS
EDI file, so that all the segments and elements are available for use.

Procedure  Usethis procedure to load the ORDHDR message into the ORDERS EDI file.

Step

Action

1

Click the ORDERSEDI fileicon to select it.

Select Create Sub from the Edit menu.

Select Transaction Set from the Create Sub cascading menu. You will be
prompted to select an ODBC data source name. Select the appropriate
DSN and click OK to display the Insert Transaction Set From Standards
dialog.

From the Agency drop-down list box, select [A] Tradacoms, which isthe
EDI standard you will use for the inserted message.

From the Version drop-down list box, select [ANAQO1], which isthe
version of the standard you will use for the inserted message. The versions
that are available depend on which standard you selected.

From the Transaction drop-down list box, select [ORDHDR] ORDER
FILE HEADER, which isthe transaction set (message) you will use for
the inserted message. The transactions that are available depend on which
standard and version you selected.

From the Release drop-down list box, select 9, which is the message
version you will use for the inserted message. The message versions that
are available depend on which message (transaction) you selected.

Click OK to load the ORDHDR message into the ORDERS EDI fileasa
subordinate group.
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Activating Groups, Segments, Composites, and Elements

Overview

Example

When Sterling Gentran: Server generates the form, the system includes all the groups,
segments, composites, and elements that are defined by the standard agency
(TRADACOMYS) for the version (ANA001), message (ORDERS), and release (9) you
selected. The system activates all the groups, segments, composites, and elementsthat are
defined as mandatory (must be present) by the standard. The system does not enable you
to deactivate the mandatory groups, segments, composites, and elements.

In the example below, the CL O segment and CLO CLOC composite are mandatory for the
purchase order. You do not need to activate these components. The CLO CLOC CL OO,
CLO CLOC CLO1, CLO CLOC CLO2, and CLO CNAM elements and the CLO CADD
composite are not mandatory, so they are dimmed on the form. To view the segments,
composites, and elements in a group, segment, or composite on your form, double-click
the form component in the EDI File Format Window (left side of the Forms main
window). To activate an inactive form component, click Activate on the Main Toolbar,
then click the form component. The component is no longer dimmed.

=4l RCDERS - b - 1 ORDER DETAILS

—J) ORCHOR - - 1 ORDER FILE HEADER

- CLO - M - 1 CUSTOMER'S LOCATION
. CLOC - M-

o
o
o
5

K

You must activate the groups, segments, composites, and elements that are not defined as
mandatory by the standard, but that you have determined that you need to use in the form.
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Groups, segments,
elements, and
compositesused in
thistutorial

Forms Integration TRADACOMS Tutorial Guide

Thistable lists the groups, segments, elements, and composites used in this tutorial.

Group Segment Composite Element
ORDHDR SDT SIDN SIDO
(already (already activated) | (already activated)
activated)

SNAM
CDT CIDN CIDO
(already activated) | (already activated)
CNAM
CADD CADO
CAD1
CAD2
CAD3
CAD4
CLO CLOC CLOO
(already activated) | (already activated)
CNAM
CADD CADO
CAD1
CAD2
CAD3
CAD4
ORD ORNO ORNO
(already activated) | (already activated)
ORN2
CDO07
DIN LDAT
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Procedure

(Contd)

Group Segment Composite Element
OLD OLD:2 SPRO SPR1
(already (mandatory for
activated) OLD:2)

CPRO CPR1

UNOR UNOO

(mandatory for

OLD:2) CDo4

OQTY 0OQT0

(mandatory for

OLD:2)

OUCT ouCo

TDES TDEO
TDE1

Use this procedure to activate the required groups, segments, composites, and elements.

Step

Action

Double-click the groups, segments, and composites listed in the previous
table to open them. The table lists al the groups, segments, composites,
and elements that you need to activate. Opening all the necessary groups,
segments, and composites before you start to activate enables you to scroll
down the form and activate the segments, composites, and elements
sequentialy.

Note

When you activate a conditional group, segment, or composite, the
mandatory subordinate segments, composites, and elements are activated
automatically.

Click Activate on the Main Toolbar.

Click each inactive segment that you need to use. Clicking these segments
will activate the segments.

Note
If you accidentally click asegment that you did not mean to activate, right
click the segment and select Deactivate from the shortcut menu.

Sterling Gentran:Server — May 2011

Forms Integration TRADACOMS Tutorial Guide



(Contd)
Sep

Action

4

Click each inactive composite that you need to use. Clicking these
composites will activate the composites.

Note

If you accidentally click a composite that you did not mean to activate,
click the composite with the right mouse button to access the shortcut
menu. Select Deactivate from the shortcut menu.

Click each inactive element that you need to use. Clicking these elements
will activate the elements. When you activate an element in a print form,
the tag “ Printed” is displayed before that element’s description to indicate
that thisfield will be printed. If you later prevent afield from being
displayed on the printout, then the tag “Not Printed” is displayed before
that element’s description.

Note

If you accidentally click an element that you did not mean to activate,
click the element with the right mouse button to access the shortcut menu.
Select Deactivate from the shortcut menu.

Click Activate on the Main Toolbar to turn activation mode off.
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Verifying EDI Delimiters

Overview  You are using an EDI standard that contains composite elements, so you must verify that
Sterling Gentran: Server is specifying the correct delimiters. Delimiters are flags that you
define to the system as separating specific EDI components. Delimiters are necessary for
all variable field-length standards, because the data is compressed (and the leading zeroes
and trailing blanks are removed). The fields vary in length, so the system needs aflag to
determine where one element ends and another begins. For example, an element delimiter
marks the beginning of a new element.

Recommendation

Although verifying EDI delimitersin Sterling Gentran: Server is mandatory only if you are
using a standard with composite elements or subelements, we recommend that you
perform this task regardless of which standard you use.

EDI delimiters  Thistableliststhe valid EDI delimiters.

table
EDIFACT Default EDIFACT Default Hex
Field Char acter Value
Tag Delimiter = (equa sign) Ox3D
Segment Delimiter " (apostrophe) Oox27
Element Delimiter + (plus sign) Ox2B
Sub Element Delimiter : (colon) Ox3A
Decimal Separator . (full stop) Ox2E
Release Character ? (question mark) Ox3F
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Procedure  Usethis procedure to verify EDI delimiters.

Step

Action

Click the Ordersfileicon with the right mouse button to access the
shortcut menu.

Select Properties from the shortcut menu to display the File Format
Properties dialog.

Click Delimiter sto access the Delimiters dialog.

File Format Properties

Mame Delimiters | Loop Extended Hulesl

Tag Delimiter |= Sub Element Delimiter Ii
Seqgment Delimiter I Decimal Separator I
Element Delimiter |+ Releaze Character I?

ok I Cancel | Spply | Help |

Verify that the correct delimiters are being used for the TRADACOMS
standard. If the delimiters differ from the default values listed in the table
below, you can enter either the character or the hexadecimal value in the
correct field. The default delimiters for TRADACOMS are the following:

Note
If you use the default hex value, the value must begin with “0x” (the
number zero and the letter “x”).

Note

The Stream segments check box on the Delimiters dialog currently is not
marked. For thistutorial, do not mark this check box, so the translator will
continue to insert a carriage return after every segment. If the Stream
segments check box is marked, then a carriage return is not used after
every segment, and the segments are “ streamed”.

Click OK to save the delimiters and exit the Delimiters dialog.

Click Close to exit the File Format Properties dialog.
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Modify Form Components

Promoting the ORDHDR Group to the Parent Frame

Introduction The Promote function extracts one iteration (instance) of a group or repeating segment.
Promote is a specialized function that preserves the integrity of the EDI structure.

By default, the fields corresponding to each group and repeating segment are displayed on
a separate frame from the rest of the fields in the message. When you promote a group to
the parent frame, the fields corresponding to the group are displayed on the frameto which
the group is subordinate. If you do not promote a group to the parent frame, the fields
corresponding to the group are displayed on their own frame.

Procedure  Usethis procedure to promote the ORDHDR group to the parent frame.

Step

Action

1

Click the ORDHDR group with the right mouse button and select
Properties from the shortcut menu.

System Response
The Group Properties dialog is displayed.

Select the Print tab.

Click the Promote group to parent frame check box to display the fields
in this group on the same frame as the fields in the parent group.

Note

Although this group has a maximum use of one, if you do not mark the
Promote group to parent frame check box, then the fieldsin this group will
not be displayed on the same frame in the Layout Window asthefieldsin
the parent group.

Click OK to exit the Group Properties dialog.
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Creatingan OTR Group

Overview  The OTR segment contains Order Trailer summary information for the purchase order. If
the form were generated now (displaying the layout of the fieldsin the form on the right
side of the Forms main window), the total number of line items would be printed along
with the ORDHDR fields at the beginning of the purchase order (because the fields in the
OTR segment would be displayed on the same frame asthe fieldsin the ORDHDR group).

To print the total number of lineitems at the end of the printout and maintain the integrity
of the purchase order, you must create an OTR group with a minimum use and a
maximum use of one, then cut the OTR segment and paste it as a subordinate to the group
you just created. By moving the OTR segment to the new OTR group that you create, the
total number of line items will be displayed on its own frame, separate from the header
(ORDHDR) information.

Procedure  Usethis procedure to create an OTR group.

Sep Action
1 Select the OTR segment.
2 Select Insert from the Edit menu.
3 Select Group from the cascading menu.

System Response
The Group Properties dialog is displayed.

[Gowlwpetios |

rlden:ifizzt on

e |

e |
| S e I

rLacp Corcnct

Min U zocs Mo _zogz

] 1

Mues...

~Dlisp ay

I “romoce group o pare k Fae

Fimi 1= Cerpilinm I
Liz: Capizt I
Fii 1= Hel 1 Tral | i HApn Tre
* +
_
* L3
4] ] [+] | [* +

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



(Contd)

Sep Action
4 In the Name field, enter OTR_Group as the segment loop identification
code.
Caution

Do not use spaces or hyphens (-) in the Name field. You can use the
underscore (_) to separate words

5 In the Desc field, enter OTR Group to provide a brief explanation of the
loop.

6 Select the L ooping tab.

7 In the Min Usage field, enter 1 to make this group mandatory. Changing

the minimum use of a segment or group from zero to one changes the
status of the segment or group from conditional to mandatory. If EDI data
is not present for a segment or group that has a minimum use of one or
greater, a compliance error will occur during translation for that segment
or group.

8 Click OK to create the group. Sterling Gentran: Server prompts you that
the frame caption for the group will default to the name of the group. (The
frame caption is the name of the frame for the group. When the frame
caption is not specified, then Sterling Gentran: Server usesthe value in the
Name field as the frame caption.)

9 Click OK to accept the message.
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How to cut and Use this procedure to cut and paste the OTR segment.

pastethe OTR

segment Sep

Action

1

Verify that the OTR segment is selected.

Click Cut on the Main Toolbar.

Select the OTR group, which isthe group for which you want to paste the
OTR segment as a subordinate.

Click Paste on the Main Toolbar to paste the OTR segment. Sterling
Gentran: Server prompts you to specify whether you want the contents of
the Clipboard pasted as a child (subordinate) of the selected group, or at
the same level asthe group.

The Paste as a child of selected item radio button is selected asthe
default. Accept the default to paste the Clipboard contents as a child
(subordinate) of the group. Click OK to exit the dialog.
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Generating the Form

Overview  Generating aform is different from compiling aform. When you compile aform, the
source form istrandated into a compiled translation object. When you generate aform,
the fields of the form are displayed on aframe in the Layout Window (right side of the
Forms main window), based on the groups, segments, and elements that are activated.

Note

You can, and should, regenerate (or refresh) the form several times as you customize and
format the form to ensure that you are viewing the most recent changes to the Layout
Window.

Procedure  Usethisprocedure to generate the print form based on the groups, segments, and elements

you activated.
Sep Action
1 Select the ORDERS fileicon. Selecting the ORDERSfileicon before you

generate the layout enables you to view the beginning of the purchase
order layout in the Layout Window after the layout is generated. However,
selecting the ORDERS file icon is hot a required prerequisite to
generating the layout.
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(Contd)
Sep

Action

2

Click Generate L ayout on the Main Toolbar.

System Response
The layout of the print form will be displayed in the Layout Window.
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Note

You should regenerate the form periodically as you customize the print
form to ensure that the most recent changes to the frame are reflected in
the Layout Window.

When you generate the form, there is one field on the right side of your
screen (Layout Window) for every activated element on the left side of
your screen (EDI File Format Window). You can click either thefield or
its corresponding element to select it. To access the Element Properties
dialog for afield/element, either double-click the element, or use theright
mouse button to click the field or element, then select Properties from the
shortcut menu.

Note

When you first generate the form, each field in the Layout Window is
|abelled with the same name as its corresponding element in the EDI File
Format Window. As you customize the form, however, you will change
some of the labels and remove others, so al the fields will not be labelled
the same astheir corresponding elements. Even though you will change or
remove some field labels, each field still will correspond to one element.

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



After generating  After the print form is generated, each group and repeating segment has a corresponding
theform frame in the Layout Window that contains all the groups, segments, and elements at that
level. Fieldsin groups or segments that have a maximum use of only one are displayed on
the frame corresponding to the group to which the groups or segments are subordinate. For
example, the following fields are displayed on one frame (all the groups and segmentsin
which these fields are contained are subordinate to the same group):

» Transaction Code (TYP CDO02)

» Supplier’'sANA Location Code (SDT SIDN SIDQ)
» Supplier’'sName (SIDN SNAM)

» Customer’'s ANA Identity/Loc (CDT CIDN CIDO)
Note

There are several other fields on thisframe. All of the fields on this frame are subordinate
to the same group.

In print forms, the frames are not titled in the Layout Window (asthey are in screen entry
forms). To identify the frame that currently is displayed, click one of the fields on the
frame, then check the EDI File Format Window to determine in which segment or group
the field is contained.
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Customize the EDI Data

Overview

I ntroduction You can customize the form, including the properties of each type of form component
(group, segment, and element).

Customizing the formis an iterative process. Thistutorial guides you through al the steps
involved in customizing the form, component by component. When you create print
forms, you usually will activate the form components you need to use, then compile the
form, test it, and print the EDI data using the compiled translation object. Asyou
substantially customize the form, you usually will compile and print the form several
times to view your changes before the form truly isfinalized.

This section explains how to customize the form components for each sequential
component.

How to set up the  We recommend that you set up a Document Name for each form. The document name
document name  makesthe identification of a message created by the form easier in Sterling

Gentran: Server. Setting up the document name enables you to differentiate between
messages in the document browsersin Sterling Gentran: Server. If you set up the document
name in the Forms I ntegration subsystem, the Name field of the document browsers that
contain this message in Sterling Gentran: Server will contain the data from that element.
You can choose any element as the document name, but we strongly recommend that you
select an element that occurs only once in the message and has a data type of string. For a
TRADACOMS ANAQ001 ORDERS release 9 purchase order, the document name usually
is the Customer’s Order Number.

Use this procedure to set up the document name.

Sep Action

1 Double-click the ORD ORNO ORNO el ement.

System Response
The Element Properties dialog is displayed.

Note

In this tutorial, we recommend that you select this element becauseitisa
non-recurring and mandatory element, and it will help identify this
message meaningfully in Sterling Gentran: Server.

2 Select the Use Sandard Rule tab.

3 Select the Update option.
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(Contd)
Sep Action

4 From the Table/Group drop-down list box, select Document record to
indicate that you are updating the document record in Sterling
Gentran:Server.

5 From the Column/Field drop-down list box, select Document Name to
indicate that you are updating the Name field in the document browsers
with the contents of the ORD ORNO ORNO element.

The dialog now should look like this:

Element Properties E

Mame I Validationl Priit I Extended Rule  Standard Rule |E0nditinns|

Fleaze zelect the standard rule to uze IUpdate j

Fleaze zelect the table [or group] to update
ID-:u::umenl record j

Fleaze zelect the column [or field] to update

QK I Cancel Sppi Help

6 Click OK to set up the document name.
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Customizing the ORDHDR Group

Overview  The ORDHDR group (Order File Header) is used to print the header details pertaining to
the ORDERS message. You aready promoted this group to the parent frame (the
ORDERSfile).
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Customizing the TYP Segment

Overview

How to customize
the TYP CDO0O2
element

The TY P segment (Transaction Type Details) contains the transaction code for this

message.

The TYP CDO02 element (Transaction Code) isamandatory element that contains the code
for the type of ordersthat follow (e.g. new orders, cancelled orders, etc.). You do not need
to print the code on the printout, so you will prevent (hide) the Transaction Code field
from being printed.

Use this procedure to prevent the Transaction Code field from being printed.

Sep Action
1 Double-click the TYP CDO02 element.
System Response
The Element Properties dialog is displayed.
2 Select the Print tab.
3 Clear the Includein print check box to turn the option off.
4 Click OK to exit the diaog.
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Customizing the SDT Segment

Overview  The SDT segment (Supplier Details) contains details about the supplier. In this tutorial,
the supplier isyour company, MWT Manufacturing Co.

How to customize  The SDT SIDN SIDO element (Supplier’s ANA Location Code) contains the code
the SDT SIDN assigned by the Article Numbering Association for the supplier’s location. Your trading
SIDO eement partner will send you this code, but you do not need the code to be printed on the printout.
Therefore, you will hide thisfield.

Use this procedure to hide the Supplier’'s ANA Location Code field.

Sep Action

1 Double-click the SDT SIDN SIDO €l ement.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includein print check box to turn the option off.
4 Click OK to exit the diaog.

How to customize  The SDT SNAM element (Supplier’'s Name) contains the name of the supplier (in this
the SDT SNAM tutorial, you are the supplier). Your trading partner will send you this name, but you do not
dement need the name to be printed on the printout. (All purchase orders you receive from
customers should have your company designated as the supplier.) Therefore, you will hide
thisfield.

Use this procedure to hide the Supplier’s Name field.

Sep Action

1 Double-click the SDT SNAM element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includein print check box to turn the option off.
4 Click OK to exit the dialog.
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Customizing the CDT Segment

Overview  The CDT segment (Customer Details) contains details about the customer (your trading
partner, Pet Zone). In thistutorial, the CDT segment contains details relating to the Pet
Zone corporate office.

How to customize  The CDT CIDN CIDO element (Customer's ANA Identity/L oc) contains the code
the CDT CIDN assigned by the Article Numbering Association for the customer’s location. Your trading
CIDO e ement partner will send you this code, but you do not need the code to be printed on the printout.
Therefore, you will hide thisfield.

Use this procedure to hide the Customer’s ANA Identity/Loc field.

Sep Action

1 Double-click the CDT CIDN CIDO element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includein print check box to turn the option off.
4 Click OK to exit the diaog.

How to customize  TheCDT CNAM element contains the Customer’s Name. For brevity, you will change the
the CDT CNAM field label to Customer.

element
Use this procedure to change the field label for the Customer’s Namefield.

Sep Action

1 Double-click the CDT CNAM €element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Labd field, enter Customer: to replace the existing field label.
4 Click OK to exit the dialog.
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How to customize
the CDT CADD
CADO element

How to customize
the CDT CADD
CAD1 element

The CDT CADD CADO eement (Customer’s Address Line 1) containsthefirst line of the
customer’s address. The address will correspond to the nameinthe CDT CNAM element,
so you do not need to print alabel for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 1 field.

Sep Action
1 Double-click the CDT CADD CADO element.
System Response
The Element Properties dialog is displayed.
2 Select the Print tab.
3 Inthe Label field, delete the existing field label.
4 Click OK to exit the dialog.

The CDT CADD CAD1 element (Customer’s Address Line 2) contains the second line of
the customer’s address. The address will correspond to the name in the CDT CNAM
element, so you do not need to print alabel for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 2 field.

Sep Action
1 Double-click the CDT CADD CAD1 element.
System Response
The Element Properties dialog is displayed.
2 Select the Print tab.
3 Inthe Label field, delete the existing field label.
4 Click OK to exit the dialog.
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How to customize
the CDT CADD
CAD2 element

How to customize
the CDT CADD
CAD3 element

The CDT CADD CAD2 element (Customer’s Address Line 3) contains the third line of
the customer’s address. The address will correspond to the namein the CDT CNAM
element, so you do not need to print alabel for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 3 field.

Sep Action
1 Double-click the CDT CADD CAD?2 element.
System Response
The Element Properties dialog is displayed.
2 Select the Print tab.
3 Inthe Label field, delete the existing field label.
4 Click OK to exit the dialog.

The CDT CADD CAD3 element (Customer’s Address Line 4) contains the fourth line of
the customer’s address. The address will correspond to the name in the CDT CNAM
element, so you do not need to print alabel for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 4 field.

Sep Action
1 Double-click the CDT CADD CAD3 element.
System Response
The Element Properties dialog is displayed.
2 Select the Print tab.
3 Inthe Label field, delete the existing field label.
4 Click OK to exit the dialog.
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How to customize  TheCDT CADD CAD4 element (Customer’s Post Code) contains the post code of the
the CDT CADD customer’s address. The post code will correspond to the name in the CDT CNAM
CAD4 e ement element, so you do not need to print alabel for thisfield.

Use this procedure to remove the field |abel for the Customer’s Post Code field.

Sep Action

1 Double-click the CDT CADD CAD4 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label field, delete the existing field label.
4 Click OK to exit the dialog.
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Customizing the FIL Segment

Overview  TheFIL segment (File Details) contains details about the ORDHDR message. These
elements must be present in the ORDHDR message, but you do not need to print them on
aprintout.

How to customize  The FIL FLGN element (File Generation Number) contains the sequential number
theFIL FLGN assigned to this message by your trading partner. Your trading partner will send you this
dement number, but you do not need the number to be printed on the printout. Therefore, you will
hide thisfield.

Use this procedure to hide the File Generation Number field.

Sep Action

1 Double-click the FIL FL GN element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includein print check box to turn the option off.
4 Click OK to exit the diaog.

How to customize  TheFIL FLVN element (File Version Number) contains the number corresponding to this
theFIL FLVN version of the message. The first version of the message is always version one, and
dement subsequent copies of the message are incremented by one. Your trading partner will send
you this number, but you do not need the number to be printed on the printout. Therefore,
you will hide thisfield.

Use this procedure to hide the File Version Number field.

Sep Action

1 Double-click the FIL FLVN element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includein print check box to turn the option off.
4 Click OK to exit the dialog.
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How to customize  TheFIL FLDT element (File Creation Date) contains the date on which the message was
theFIL FLDT created. Your trading partner will send you this date, but you do not need the date to be
dement printed on the printout. Therefore, you will hide this field.

Use this procedure to hide the File Creation Date field.

Sep Action

1 Double-click the FIL FLDT element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 Clear the Includein print check box to turn the option off.

4 Click OK to exit the dialog.

5 Click Generate Layout on the Main Toolbar to refresh the display of the
print form.

The print form now should look like this:

Customer:

Customer's Ana Location Code [:::::::::::]

Customer's MName | |

Customer's Address Line 1

-
1 | 3
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Customizing the CLO Segment

Overview  The CLO segment (Customer’s Location) contains details about the specific customer
location pertaining to this purchase order. In thistutorial, the CLO segment contains
details relating to the specific Pet Zone store to which the order should be sent. Earlier in
thistutorial, you customized the CDT segment, which contains details relating to the Pet
Zone corporate office.

How to customize  The CLO CLOC CLOO element (Customer's ANA Location Code) contains the code
theCLO CLOC assigned by the Article Numbering Association for the customer’s location. Your trading
CL OO0 dement partner will send you this code, but you do not need the code to be printed on the printout.
Therefore, you will hide thisfield.

Use this procedure to hide the Customer’s ANA Location Code field.

Sep Action

1 Double-click the CLO CLOC CL OO0 eement.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includein print check box to turn the option off.
4 Click OK to exit the dialog.

How to customize  The CLO CNAM element contains the Customer’s Name (for the specific location to
the CLO CNAM which the order should be sent). For brevity, you will change the field label to Location.

element
Use this procedure to change the field label for the Customer’s Namefield.

Sep Action

1 Double-click the CLO CNAM element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Labdl field, enter L ocation: to replace the existing field label.
4 Click OK to exit the dialog.
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How to customize
the CLO CADD
CADO element

How to customize
the CLO CADD
CAD1 element

The CLO CADD CADO dement (Customer’s Address Line 1) containsthefirst line of the
customer’s address. The address will correspond to the name in the CLO CNAM element,
so you do not need to print alabel for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 1 field.

Sep Action
1 Double-click the CLO CADD CADO element.
System Response
The Element Properties dialog is displayed.
2 Select the Print tab.
3 In the Label field, delete the existing field label.
4 Click OK to exit the diaog.

The CLO CADD CAD1 element (Customer’s Address Line 2) contains the second line of
the customer’s address. The address will correspond to the name in the CLO CNAM
element, so you do not need to print alabel for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 2 field.

Sep Action
1 Double-click the CLO CADD CAD1 element.
System Response
The Element Properties dialog is displayed.
2 Select the Print tab.
3 In the Label field, delete the existing field label.
4 Click OK to exit the diaog.
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How to customize
the CLO CADD
CAD2 element

How to customize
the CLO CADD
CAD3 element

The CLO CADD CAD2 element (Customer’s Address Line 3) contains the third line of
the customer’s address. The address will correspond to the name in the CLO CNAM
element, so you do not need to print alabel for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 3 field.

Sep Action
1 Double-click the CLO CADD CAD2 element.
System Response
The Element Properties dialog is displayed.
2 Select the Print tab.
3 In the Label field, delete the existing field label.
4 Click OK to exit the diaog.

The CLO CADD CAD3 element (Customer’s Address Line 4) contains the fourth line of
the customer’s address. The address will correspond to the name in the CLO CNAM
element, so you do not need to print alabel for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 4 field.

Sep Action
1 Double-click the CLO CADD CAD3 element.
System Response
The Element Properties dialog is displayed.
2 Select the Print tab.
3 Inthe Label field, delete the existing field label.
4 Click OK to exit the dialog.
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How to customize  The CLO CADD CAD4 element (Customer’s Post Code) contains the post code of the
the CLO CADD customer’s address. The post code will correspond to the name in the CLO CNAM
CAD4 e ement element, so you do not need to print alabel for thisfield.

Use this procedure to remove the field |abel for the Customer’s Post Code field.

Sep Action

1 Double-click the CLO CADD CAD4 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 Inthe Label field, delete the existing field label.

4 Click OK to exit the dialog.

5 Click Generate Layout on the Main Toolbar to refresh the display of the
print form.

The section of the print form that contains the fields in the CL O segment
now should look like this (you may need to scroll down the form to see
these fields):

Customer: | | il

Location:

|
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Customizing the ORD Segment

Overview

How to customize
the ORD ORNO
ORNO element

How to customize
the ORD ORNO
ORN2 element

The ORD segment (Order References) contains reference information pertaining to this
purchase order, such as the purchase order number, the date the order was placed, and the
purchase order code.

The ORD ORNO ORNO element (Customer’s Order Number) contains the purchase order
number assigned by the customer. You already used a standard rule for this element to
assign the document name. For brevity, you will change the field label to Order Number.

Use this procedure to change the field label for the Customer’s Order Number field.

Sep Action

1 Double-click the ORD ORNO ORNO element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 In the Labdl field, enter Order Number: to replace the existing field
label.

4 Click OK to exit the dialog.

The ORD ORNO ORN2 element (Date Order Placed by Customer) contains the date on
which the customer placed the purchase order. You will change the screen format for the
purchase order date to DD/MM/YY. Also, this element is defined by the standard to be a
six-digit date. In thistutorial, the purchase order date will be printed as an eight-digit date,
so you will change the element and field lengths to accommodate the longer date. For
brevity, you will change the field label to Order Date.

Use this procedure to change the screen format, change the element and field lengths, and
rename the field label for the Date Order Placed by Customer field.

Sep Action

1 Double-click the ORD ORNO ORN2 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max field, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

4 From the Form Format drop-down list box, select DD/MM/YY to
designate the format for the date on the printout.
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Sep

Action

Select the Print tab.

In the Label field, enter Order Date: to replace the existing field label.

In the Maximum number of charactersfield, enter 8 to allow the entire
date, including separators (/), to be displayed.

Click OK to exit the dialog.

Customizingthe  The ORD ORNO CDO07 element (Order Code) contains the code representing the type of
ORD ORNO CDOQ7  purchase order (e.g. new order, cancelled order) for this message. You want the more
dement meaningful description of the code to be printed on the printout, instead of the code itself.

Therefore, you will hide the Order Code field, but use the code from that element (ORD
ORNO CDQ07) to look up the code description in Code Values List 7 and print that
description in another field that you create. The description of the code will be displayed
inthe new field on the printout. You will rename the new field and change the element and
field lengths to accommodate the text from the description of the code.

How to copy the  The description of the EDI codein the ORD ORNO CDOQ7 element isimportant, even
ORD ORNO CDQ7  though you do not need to print the code itself. For example, the EDI code value “N” is
dement not descriptive enough for users reading a printout of the purchase order. The description
of code “N” (“New Order”) is meaningful, however.

Before you can print the description of the EDI code value, you must create anew element
in the ORNO segment to store and print the description. The new ORNO element isthe
element that will print the description of the Order Code. You will use the Copy and Paste
functions to copy EDI information in the form. Copied form components retain al the
information of the original form components.

Use this procedure to copy and paste the ORD ORNO CDO07 element.

Step

Action

1

Select the ORD ORNO CDO7 element.

Click Copy on the Main Toolbar.

Select the ORNO SCRF composite, which isthe last form component in
the ORNO segment. The ORNO SCRF composite is the form component
after which you want the copy of the ORD ORNO CDO07 element to be
pasted.

Click Paste on the Main Toolbar to paste the ORD ORNO CDOQ7 element.
Sterling Gentran: Server prompts you to specify whether you want the
contents of the Clipboard pasted as a child (subordinate) of the selected
composite, or at the same level as the composite.
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Sep Action

5 Click the Paste after selected item (at the same level) radio button to
paste the Clipboard contents after the ORNO SCRF composite. A new
element (ORD CDO7:2) is created. The ORD CD07:2 element is an exact
copy of the ORD ORNO CDOQ7 element.

6 Click OK to exit the dialog.

How to changethe  The system names the new element created from copying the ORD ORNO CDO07 element
ORD CDQ7:2 ORD CDO07:2. You will rename the new element to identify its purpose, which isto print
element and fidd the description of the code from the ORD ORNO CDO07 element.

properties  \ote

If asegment or element occurs more than oncein aform, it isidentified by its name <ID>.
The second and subsequent occurrences areidentified by <ID>:n, where*n” isthe number
of the occurrence in the form.

You will rename the element name and field label corresponding to the newly-created
ORD CDO07:2 element to reflect the contents of the field (the description of the Order
Code). You will also increase the field and element lengths to accommodate the longer
description.

Use this procedure to change the rename the element name and field label, and change the
field and element lengths, for the ORD CDQ7:2 element.

Sep Action

1 Double-click the ORD CDO07:2 element.

System Response
The Element Properties dialog is displayed.

2 In the Namefield, enter CDO7_DESC to give the name amore descriptive
identifier than its current name.

Important
Do not use spaces or hyphens (-) in the Name field. You can use the
underscore (_) to separate words.

3 Select the Validation tab.

4 In the Max field, enter 35 for the maximum number of characters allowed
for this element.

5 Select the Print tab.
6 In the Label field, enter Order Type: to replace the existing field label.
7 In the Maximum number of charactersfield, enter 35 to allow athirty-

five-character description to be displayed on the printout.

8 Click OK to save the new label and exit the dialog.
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How to hidethe  Now that you have created an exact copy of the ORD ORNO CDO7 element in order to
ORD ORNO CDQ7  retain al of the EDI data and formatting associated with that element, you can hide the

field and loadinga  Order Codefield.

code list table from
thestandard  Whenyou use code list tables, you load a code list table from the standard to tell the

system which code list table to use in looking up EDI code values. You can load the
specific code values you expect to receive in the EDI data, or you can load the entire code
list table. For thistutorial, you will load the entire code list table.

Use this procedure to hide the Order Code field and load the code list table from the

standard.
Sep Action

1 Double-click the ORD ORNO CDO07 element. You need to use acode list
table for this element.
System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 Clear the Includein print check box to turn the option off.

4 Click OK to exit the Display Properties dialog.

5 Select the Use Standard Rule tab.

6 Click Use Code from the drop-down list.
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(Contd)
Sep

Action

7

Click Edit to access the Edit Code List dialog.

Edit Code List [ x]
T able Details
Table D [CDO7 Desc |DRDER CODE
~ Allowed Codes Cancel |
Code Yalue Description

Mew...
Change...

Delete

i

Load...

The Table ID field contains “CDO07,” the name of the element for which
this code list table will be used. The Desc field contains “ORDER
CODE,” the description of the element for which this code list table will
be used.

Click L oad to access the Load Code List dialog. You will be prompted to
select an ODBC data source name. Select the appropriate DSN and click
OK to accessthe Load Code List dialog. The Codes In Standard list box
contains the entire code list table.

Click Add All to move all of the codes in the code list table to the Codes
Selected list box.

Note

Adding all the codesin thelist (by using Add All) creates a much larger
form than if you use only selected codes. However, it is necessary for your
users to have all the codes available from which to choose.

10

Click OK to load the code list table and exit the Load Code List dialog.

11

Click Closeto exit the Edit Code List dialog.
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(Contd)
Sep Action

12 From the Store Field drop-down list box, select CDO7_DESC ORDER

CODE to store the description in the ORD CD0O7_DESC element you
created.

The dialog now should look like this:
Element Properties E

MHame | Validationl Print I Extended Fule  Standard Rule | Conditionsl

Please select the standard rule to uze : ILIse Code j

Fleaze select the code list to uze :

|coo7 oRDER CoDE =] e |

™ Raise a compliance eror if the code is not found in the list

If you would like the description of the code to be stored in a figld, please
select that field below ;

\DER CODE

(1] I Cancel | Soply | Help

13 Click OK to exit the Element Properties dialog.
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(Contd)
Sep Action

14 Click Generate Layout on the Main Toolbar to refresh the display of the
print form.

The section of the print form that contains the fields in the ORD segment
now should look like this (you may need to scroll down the form to see

these fields:
[ :_I
Location:
|
|
| =
|
Order Date: l:l
Order Type: |
Latest Delivery Date I:I
ﬁ'
0

4] |
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Customizing the DIN Segment

Overview  The DIN segment (Delivery Instructions) is a conditional segment that contains details
about the delivery of the ordered items. For thistutorial, the only delivery instructions you
and your trading partner requireis the last date on which the items may be delivered.

How to customize  The DIN LDAT element (Latest Delivery Date) contains the last date on which the
the DIN LDAT ordered items may be delivered. You will change the screen format for the last delivery
dement dateto DD/MM/YY. Also, this element is defined by the standard to be asix-digit date. In
thistutorial, the last delivery date will be printed as an eight-digit date, so you will change
the element and field lengths to accommodate the longer date. In addition, you will add a
colon (:) to the field label to make the label consistent with the other field labels on the

same frame.

Use this procedure to change the screen format, change the field and element lengths, and
add acolon (;) to the field label for the Latest Delivery Date field.

Sep

Action

1

Double-click the DIN LDAT element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max field, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

From the Form Format drop-down list box, select DD/MM/YY to
designate the format for the date on the printout.

Select the Print tab.

Inthe Label field, enter “:” after the text in the field label (for consistency
in labelling the fields).

In the Maximum number of charactersfield, enter 8 to allow the entire
date, including separators (/), to be displayed.

Click OK to exit the dialog.
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(Contd)
Sep

Action

9

Click Generate Layout on the Main Toolbar to refresh the display of the
print form.

The section of the print form that contains the field in the DIN segment
now should look like this:

=
Location:
|
| |
|
|
Order MNumber: | |
Order Date: l:l
Oorder Type: |
Latest Delivery Date:l:l ‘j
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Customizing the OLD Group

Overview  The OLD group contains details about each lineitem in the purchase order. The fieldsin
the OLD group are displayed on a separate frame than the fields you have customized up
to now, because the OLD group has a maximum use of 999,999. The fields on the OLD
frame will be printed as many times as necessary (up to 999,999 occurrences) before the
fields on the next frame (OTR group) are printed.
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Customizing the OL D:2 Segment

Overview  The OLD:2 segment (Order Line Details) contains line item details for the purchase order.

How to customize  The OLD:2 SEQA element (First Level Sequence Number) contains the line number for
the OLD:2 SEQA each item on the purchase order. Your trading partner will send you the value “1” for the
dement first lineitem, and will increment each subsequent line item by one. You and your trading
partner have agreed that they will order no more than 99999 line items per purchase order.
Because each line item will be numbered sequentially, starting with one, you will need a
maximum length of only five digits for thisfield. Therefore, you will change the element
and field lengthsto five. Also, for brevity, you will rename the field label.

Use this procedure to change the field and element lengths and rename the field label for
the First Level Sequence Number field.

Step

Action

1

Double-click the OLD:2 SEQA element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

Inthe Max field, enter 5 to allow afive-digit number in this element.

Select the Print tab.

In the Label field, enter Lineto replace the existing field label.

Note

The label for the First Level Sequence Number field ultimately will form
the column heading “Line No.” To make the width of the column heading
as narrow as possible, you will place “Ling” on onelineand “No.” below.
The Label field does not enable you to enter alabel on more than oneline,
soyouwill enter “Line” inthe Label field, then add “No.” by adding static
text later in thistutorial.

In the Maximum number of charactersfield, enter 5to allow five numeric
digitsto be displayed on the printout.

Click OK to exit the diaog.
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How to customize  The OLD:2 SPRO SPR1 element (Supplier’s Code for the Traded Unit) contains the
theOLD:2 SPRO  supplier'sinternal reference identifying the ordered item. In this tutorial, MWT
SPR1 element Manufacturing Co. (the supplier) provides a catalogue to its trading partners (customers).
The catalogue lists al the items available for ordering, including the supplier’s code for
each item. Your trading partner will send you the supplier’s number corresponding to each
item ordered.

In thistutorial, the supplier’s codes do not exceed ten characters, so you will change the
field and element lengths to ten. In addition, for brevity, you will rename the field |abel.

Use this procedure to change the field and element |engths and rename the field label for
the Supplier’s Code for the Traded Unit field.

Sep Action

1 Double-click the OL D:2 SPRO SPR1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max field, enter 10 to allow aten-character string in this element.
4 Select the Print tab.

5 In the Labd field, enter Prod I D to replace the existing field label.

6 In the Maximum number of charactersfield, enter 10 to allow ten

characters to be displayed on the printout.

7 Click OK to exit the diaog.

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



How to customize  The OLD:2 CPRO CPR1 element (Customer’s Item Code) contains the customer’s
theOLD:2 CPRO internal reference identifying the ordered item. In thistutorial, your trading partner will
CPR1 eement send you the customer’s item code corresponding to each item ordered. However, you do
not need this code to be printed on the printout, so you will hide this element.

Use this procedure to hide the Customer’s Item Code field.

Sep Action

1 Double-click the OLD:2 CPRO CPR1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includein print check box to turn the option off.
4 Click OK to exit the diaog.

How to customize  The OLD:2 UNOR UNOO element (Consumer Unitsin Traded Unit) contains the
the OLD:2 UNOR consumer units information. The standard defines the OLD:2 UNOR UNOO element as a
UNOO element string data type. However, your trading partner will send you a number-type element in
NO format (formatted with an implicit decimal point and no decimal places). Therefore,
you will change the data type and the screen and EDI formats to reflect the data your
partner will send you.

Also, you and your partner have decided that none of the items you will trade contain a
number of units greater than ten digits. You will change the field and element lengthsto
reflect the smaller number of units. In addition, for brevity, you will rename thefield label.

Use this procedure to change the field and element lengths, the data type, and the screen
and EDI formats, as well asto rename the field label, for the Consumer Unitsin Traded

Unit field.
Sep Action

1 Double-click the OLD:2 UNOR UNOO element.
System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max field, enter 10 to alow aten-digit number in this element.

4 From the Data Type drop-down list box, select Number to alow a
number data type in this element. Sterling Gentran: Server prompts you
that changing the field's data type will invalidate its format.
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How to customize
theOLD:2 UNOR
CDO04 element

How to customize
theOLD:2 OQTY
OQTO element

(Contd)

Sep Action
5 Click Yesto proceed with modifying the properties of this element.
6 From the Form Format drop-down list box, select NO to allow a number

with an implied decimal point and no decimal places to be displayed on
the printout.

7 From the File Format drop-down list box, select NO to indicate that you
expect anumber with an implied decimal point and no decimal places.

8 Select the Print tab.

9 In the Label field, enter Cons. Unitsto replace the existing field label.

10 In the Maximum number of charactersfield, enter 10 to allow aten-digit

number to be displayed on the printout.

11 Click OK to exit the dialog.

The OLD:2 UNOR CD04 element (Measure Indicator) contains the abbreviation for the
ordering measure (e.g. kilograms, metres, litres) for the ordered item. For brevity, you will
rename the field label.

Use this procedure to rename the field label for the Measure Indicator field.

Sep Action

1 Double-click the OLD:2 UNOR CDO04 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label field, enter Unit to replace the existing field label.
4 Click OK to exit the dialog.

The OLD:2 OQTY OQTO element (Number of Traded Units Ordered) contains the total
number of units ordered (quantity) for each line item, in units defined in the OLD:2
UNOR CDO04 element. The standard defines the OLD:2 OQTY OQTO element as a string
data type. However, your trading partner will send you a number-type element in NO
format (formatted with an implicit decimal point and no decimal places). Therefore, you
will change the data type and the screen and EDI formats to reflect the data your partner
will send you.
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Also, you know that your trading partner will order no more than 999999 (a six-digit
number) of any one item, so you will change the maximum length to six for thisfield. You
will change the field and element lengths to reflect the smaller quantities. In addition, for
brevity, you will rename the field label.

Use this procedure to change the field and element Iengths, the data type, and the screen
and EDI formats, as well asto rename the field label, for the Number of Traded Units

Ordered field.
Sep Action
1 Double-click the OLD:2 OQTY OQTO0 element.

System Response
The Element Properties dialog is displayed.

1 Select the Validation tab.
2 In the Max field, enter 6 to allow a six-digit number in this element.
3 From the Data Type drop-down list box, select Number to allow a

number data type in this element. Sterling Gentran: Server prompts you
that changing the field's data type will invalidate its format.

4 Click Yesto proceed with modifying the properties of this element.

5 From the Form Format drop-down list box, select NO to allow a number
with an implied decimal point and no decimal places to be displayed on
the printout.

6 From the File Format drop-down list box, select NO to indicate that you
expect anumber with an implied decimal point and no decimal places.

7 Select the Print tab.

8 In the Labd field, enter Qty Ord to replace the existing field label.

9 In the Maximum number of charactersfield, enter 6 to allow a six-digit

number to be displayed on the printout.

10 Click OK to exit the diaog.

How to customize  The OLD:2 OUCT OUCO element (Cost Price) contains the price per unit ordered. This
theOLD:2 OUCT priceisthe net cost in pounds (e.g. after deducting line discounts, etc., but before the
OUCO0 dement application of VAT) for an item. Your trading partner will send you pricesin N4 format
(formatted with an implicit decimal point and four decimal places), but you want the price
to be displayed on the printout in R4 format (formatted with an explicit decimal point).
Therefore, you will change the screen format to reflect how you want the price to look on
the printout.

Also, you know that the items you sell to Pet Zone are not priced at more than £9999.99
each, so this field needs a maximum length of only ten (four places for the pounds; four
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places for the pence, if present; one place for the decimal point; and one place for aplusor
minus sign, if present). You will change the field and element lengths to reflect the prices
you expect. In addition, you will rename the field label Price Each.

Use this procedure to change the field and element lengths, change the screen format, and
rename the field label for the Cost Price field.

Sep

Action

1

Double-click the OLD:2 OUCT OUCO element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max field, enter 10 to allow ten numeric digitsin thisfield,
including a plus or minus sign and a decimal point.

From the Form Format drop-down list box, select R4 to allow a number
with an explicit decimal point and four decimal places to be displayed on
the printout.

Select the Print tab.

In the Label field, enter Price Each to replace the existing field label.

In the Maximum number of charactersfield, enter 10 to allow eight digits
on the printout, including a plus or minus sign and a decimal point.

Click OK to exit the dialog.
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How to customize  TheOLD:2 TDES TDEO element (Traded Unit Descr. Line 1) contains thefirst line of the
theOLD:2 TDES  description of the ordered item. The description will be self-explanatory in the context of
TDEO e ement the rest of the line item information, so you will remove the label from thisfield.

Use this procedure to remove the field label for the Traded Unit Descr. Line 1 field.

Sep Action

1 Double-click the OLD:2 TDES TDEO element.

System Response
The Element Properties dialog is displayed.
Harne |Validati0n| Print I Extended Hulel Standard Flulel Conditionsl

Please enter the name :
ITDED

Flease enter a short description :
TRADED LIMIT DESCR. LIME 1

0K I Cancel Al Help

2 Select the Print tab.
3 In the Label field, delete the existing field label.
4 Click OK to exit the dialog.
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How to customize  The OLD:2 TDES TDE1 element (Traded Unit Descr. Line 2) contains the second line of
theOLD:2 TDES  thedescription of the ordered item. The description will be self-explanatory in the context
TDE1 dement of the rest of the line item information, so you will remove the label from thisfield.

Use this procedure to remove the field label for the Traded Unit Descr. Line 2 field.

Sep Action

1 Double-click the OLD:2 TDES TDE1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the diaog.

5 Click Generate L ayout on the Main Toolbar to refresh the display of the
print form.

The OLD frame now should look like this;

-
E— i
Prod ID |

Cons. Units I:I

Unit |:|

|
|

~|
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How to customize  The OTR LORD element contains the Lines Ordered. You will rename the field label.
the OTR LORD
element Use this procedure to rename the field label for the Lines Ordered field.

Sep Action

1 Double-click the OTR L ORD element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 In the Label field, enter Number of Line Items: to replace the existing
field label.

4 Click OK to exit the diaog.

5 Click Generate Layout on the Main Toolbar to refresh the display of the
print form.

The OTR frame now should look like this:

| v

Murber of Line Items:

Now you are ready to format the fields and their labels to make the fields on the purchase
order more consistent and visually attractive.
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Format the Print Form

Overview

Introduction In the previous section of thistutorial, you customized the print form for aTRADACOMS
ANAO001 ORDERS release 9 purchase order that you will use to print the data you receive
from Pet Zone. After successfully customizing the fields and elements of the print form,
you are ready to format the layout of the form.

One form can consist of several frames. Each group (with a maximum use greater than
one) and repeating segment has a corresponding frame that contains all the groups,
segments, and elements at that level. When the formis printed, the frames are printed
consecutively, in the order in which they occur in the form. Each frame is not printed on a

separate page.

This section explains how to format the form, field by field.
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Resizing the Header Frame

Overview  When aprintout is produced based on the customized print form, the information is
arranged according to how the frames and the fields contained on them were arranged
when the form was compiled. You should eliminate unnecessary space as you arrange the
fields on each frame.

Note

When the form is generated, the upper |eft corner of each frameintheformisplaced inthe
upper left corner of the Layout Window.

Procedure  Usethis procedureto resize the header frame (containing fields from the ORDHDR group
and the CLO, ORD, and DIN segments).

Step

Action

1

Click the ORDHDR group to display the Order File Header (header)
frame in the Layout Window.

To display more of the form on your screen, click and drag the centre bar
between the EDI File Format Window and the Layout Window to the left
until the Layout Window iswide enough to display as much of theform as
you want to view.

Note

You should be able to view the entire width of the frame. If the right side
of the header frame (and the vertical scroll bar for the frame) are not
visiblein the Layout Window, then move the centre bar between the EDI
File Format Window and the Layout Window farther to the left so the
entire frameis displayed in the Layout Window. Another way to view
more of the frame isto use the horizontal scroll bar at the bottom of the
Forms main window to bring the right side of the header frame into view.

To resize the header frame, click and drag the right side of the frame
approximately to the 20 cm mark on the horizontal ruler (aform with a
width of 20 cm can be printed on an A4 sheet of paper).

Note
Use the horizontal ruler at the top of the frame to help you resize the
frame.
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AddingaTitletothe Form

Overview  You want the form to have atitle designating the standard agency (TRADACOMS), the
version (ANAO0OL), the type of message (purchase order), the release (9), and the trading
partner (Pet Zone) for which this form is used. You will add atitle to the print form by
adding static text.

Procedure  Usethis procedure to add and position thetitle for the form.

Step

Action

1

Click Add Text on the Main Toolbar.

System Response

A text box is added to the current frame, displayed in the upper left corner
of the frame. If the template is larger than the frame (there is a scroll bar
on the right side of the frame), the static text is displayed in the upper left
corner of the part of the template that is displayed, not at the top of the
template.

Select the new text field and enter TRADACOM S ANAOOL ORDERS
Release 9. The Text Propertiesdialog isdisplayed asyou aretyping. Click
OK to add the text.

Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

Select the new text field and enter Pet Zone. The Text Propertiesdialogis
displayed as you are typing. Click OK to add the text.

System Response
The static text you added is displayed in the upper left corner of the frame.
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Centring the Text

Overview This section describes how to center text on aform.

Procedure  Usethis procedure to centre the static text at the top of the purchase order form.

Sep Action
1 Click and drag the first line of static text (TRADACOMS ANAOO1
ORDERS Release 9) so that the text is centred on the first line of the
frame.
2 Click and drag the second line of static text (Pet Zone) so that thetext is

centred on the second line of the frame.

The header frame now should look like this:

TRADLCONES ARADD] ORDERS Felease 3 =

Pet Zone

ClumEamar |
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Arranging the Header Fields

Overview

How toresizethe
header fields

By default, each field and its associated label are displayed on their own line. However, it
is common for purchase orders and forms to arrange some fields in columns of
information. Thefirst fields you rearrange will be the header fields, which are the fields
associated with the ORDHDR group and the CLO, ORD, and DIN segments.

You prevented some of the field labels from being printed (by removing the field label in
the Label field of the Display Properties dialog). For these fields, the fields will be
displayed on your print form, but their associated labels will not.

Note

If you forget which unlabelled field contains what data, you can click the field. Its
associated element will be highlighted in the EDI File Format Window, providing you
with a description of the field.

When you customized the element properties in the previous section of this chapter, you
changed the display length (on the Display Properties dialog) for some of the fields on the
header frame. The fields that are displayed in the Layout Window currently reflect the
default display lengths for the fields. To reflect the new sizes of the fields on the Layout
Window, you must select the fields for which you changed the display lengths, then resize
thefields.

Note

If afield and its corresponding field label move together, the Lock Labelsto Fields option
isturned on. Click the Lock Labels button on the Main Toolbar to turn off the Lock Labels
option.

Use this procedure to resize the fields on the header frame.

Sep Action
1 Select the L atest Delivery Date and Order Datefields.
2 Select Sizeto Length from the Display menu.

System Response

The selected fields will be resized to the lengths specified in the
Maximum number of charactersfield of the Display Properties dialog for
each field.

Note
If you accidentally format aform component in away you did not intend,
select Undo from the Display menu to undo your last formatting action.
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How to move and Use this procedure to move and align the fields and field |abels on the header frame.

align the header
fieldsand field
labels

Note

If afield isnot in the part of the frame that currently is displayed, use the scroll bar to
scroll down the frame until you locate the hidden field(s).

Sep

Action

1

Select each field individually and drag it closer to itsrespective field label.
(Do not move fields that are not labelled.)

Select the Order Number label and field and drag them to the upper left
corner on the frame (below the heading).

Note

To select more than onefield or field label, click and drag the mouse
diagonally across all the fields and field labels you want to select. When
you rel ease the mouse button, all the fields and field labels compl etely
included within the space formed by dragging the mouse will have
handles, indicating that they were selected.

Select the Order Date label and field and drag them to the right of the
Order Number label and field (at approximately 12.5 cm on the horizontal
ruler).

Select the Order Type label and field and drag them below the Order
Number label and field.

Select the Latest Delivery Datefield and drag it below the Order Date
label and field.

Select the Customer label and field and drag them below the Order Type
label and field.

Select the following fields and drag them bel ow the Customer field:
» Customer'sAddressLinel

» Customer's AddressLine 2

» Customer’'sAddressLine3

» Customer's AddressLine4

» Customer’s Post Code

Select the L ocation label and field and drag them below the Customer’s
Post Code field.
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(Contd)
Sep Action

9 Select the following fields and drag them below the Location field:
» Customer'sAddressLinel

» Customer’'s AddressLine?2

» Customer's AddressLine3

» Customer's AddressLine4

» Customer’s Post Code

10 Select the following field labels:
»  Order Number

» Order Type
» Customer
» Location

11 Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected field
labels are aligned.

12 Select the Order Date and L atest Delivery Date field labels.

Note
To select more than one item on a frame, click the first item, then press
CTRL and click the second item.

13 Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected field
labels are aligned.

14 Select the Order Type and Order Number fields (in that order).

15 Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the Order Type and
Order Number fields are aligned.

16 Select the Order Date and L atest Delivery Date fields (in that order).

17 Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the Latest Delivery
Date and Order Date fields are aligned.

18 Select all the Customer and L ocation fields (Customer’s AddressLine 1,
Customer’s Address Line 2, Customer’s Address Line 3, Customer’s
Address Line 4, and Customer’s Post Code).

19 Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected fields are
aigned.
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(Contd)
Sep

Action

20

Click the Lock L abels button on the Main Toolbar to turn on the Lock
Labelsfunction. When you select afield, its corresponding field label will
be selected also.

21

Select the Order Number and Order Datefields. (Their field labels will
be selected, too, because you have the Lock Labels function turned on.)

22

Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu. The tops of the selected labels and fields
are aligned.

23

Select the Order Type and L atest Delivery Datefields. (Their field
labels will be selected, too.)

24

Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu. The tops of the selected labels and fields
are aligned.

25

Select the Customer field. (Itsfield label will be selected, too.)

26

Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu. The tops of the Customer label and field
are aligned.

27

Select the L ocation label and field. (Itsfield label will be selected, too.)

28

Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu. The tops of the Location label and field
are aligned.

29

To resize the frame, click and drag the bottom of the frame to just below
the Customer’s Post Code field for the L ocation address.
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(Contd)
Sep Action

30 Click the Lock L abels button on the Main Toolbar to turn off the Lock
Labels function.

The header frame now should look like this;

|*

Fer Iome

drder Musber: Order Dare:
Order Type: | | LaLest Delivesy Dake:

Cuskbomes |

Lacat tag: |

1] : | Llﬂ
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Arranging theLineltem (OLD) Fields

Overview  Thefieldsthat contain information about each line item for the purchase order are
contained on a separate frame. To access this frame, select the OLD group.

You prevented some of the field labels from being displayed, so you will see al of the
fieldsin thelayout of your print form, but not all of the associated labels. In case you have
forgotten which unlabelled field contains what data, you can click the field. The name of
the element will be highlighted in the EDI File Format Window.

Before you arrange the line item fields and their frame, first you will resize the frame to
give it the same width as the other frames. You will then move and resize the fields and
field labels, aswell as add static text to the form.

How toresizethe  Usethis procedure to resize the line item (OLD) frame.
lineitem (OLD)

frame Note

When the form is generated, the upper left corner of each frameintheformisplaced inthe
upper left corner of the Layout Window.

Sep Action

1 Click the OL D group to display the line item (OLD) framein the Layout
Window.

2 Click and drag the right side of the frame to the 20 cm mark on the
horizontal ruler (aform with awidth of 20 cm can be printed on an A4
sheet of paper).

Note
Usetheruler at the top of the frame to help you resize the frame.
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How toresizethe  Usethis procedure to resize the line item fields.

lineitem fields

Step

Action

1

Select the following fields:

» Line

» ProdID

» Cons. Units
» QtyOrd

» PriceEach

Note
To select more than one field on aframe, click thefirst field, then press
CTRL and click the second field.

Select Size to Length from the Display menu. All selected fields will be
resized to the lengths specified in the Maximum number of characters
field of the Element Properties dialog for each field.

How to complete  You can add column headings (using static text) to the frame to change the way the field
theline no. column labels are displayed in the form. Currently, each field label in the form consists of oneline

heading of text.

In this tutorial, you want to label the Linefield “Line No.” You do not want the label to
extend beyond the margins of the field that it 1abels, so you will place “Line’ on one line
on the frame and “No.” on the line below.

Use this procedure to add and position static text.

Step

Action

1

Select all the fields and field |abels on the frame.

Note
To select more than onefield or field label, click and drag the mouse
diagonally across all the fields and field labels you want to select.

Click and drag them to the bottom portion of the frame. You will be
arranging the fields at the top of the frame, so moving the fields and field
labels out of the way initially will give you room to work with at the top of
the frame.

Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame. If the templateislarger
than the frame (there is a scroll bar on the right side of the frame), the
static text is displayed in the upper |eft corner of the part of the template
that is displayed, not at the top of the template.
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Sep Action

4 In the new text field, enter No. (note the full stop included in the text).

Note

Thisfield already has alabel named “Line”. To complete the
identification of thisfield, you will add static text with the name “No.”
After you add the static text for thisfield, you will move “No.” below
“Line” to create a column heading for the fields containing the line item
number.

The text you added is displayed in the upper left corner of the frame.

5 Select the static text you added (“No.”) and drag it to the bottom of the
frame. Moving the static text out of the way will give you more room at
the top of the frame.

Addinglines  Inthisprint form, rectangular boxes are used to designate fields. The boxes make it easy
separating column to distinguish fields from field labels and static text. In the printed report, there will not be
headingsand fields  rectangular boxes surrounding the datain the fields. The printed field data and the field
labels tend to ook the same on the printout (same typeface, same size text, no boldface or
italic type). You can make the field labels and static text stand out from the fields
containing the actual data by adding lines separating the labels from the fields. You will
add static text to the form to add the separating lines.

You will add the following lines of static text (hyphens) to the form:

Number of

Satic Text Hyphens Placement on Form
------- Seven Below the No. static text
............. Thirteen Below the Prod ID field label
-------- Eight Below the Qty Ord field label
-------- Eight Below the Unit field label
............. Thirteen Below the Cons. Unitsfield label
............. Thirteen Below the Price Each field label

When you finish adding the static text and moving each line of static text to its proper
location, the lineitem (OLD) frame should look like this:

Na. Prod L1 Jdty Ord nit Caowa. Unlka Price Emch

]

You will add all of the static text, then move each static text to its proper location.
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Procedure  Usethis procedure to add and position separating lines (------ ) in the form.

Step

Action

Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame. If the templateis larger
than the frame (there is a scroll bar on the right side of the frame), the
static text is displayed in the upper |eft corner of the part of the template
that is displayed, not at the top of the template.

Select the new text field and enter ------- (seven hyphens). This series of
hyphens will form a separating line between the words Line No. and the
field below. The Text Properties dialog is displayed as you are typing.
Click OK to add the text.

Click Add Text onthe Main Toolbar to add text to the current framein the
upper left corner.

Select the new text field and enter ------------- (thirteen hyphens). This
series of hyphenswill form a separating line between the words Prod 1D
and the field below. The Text Properties dialog is displayed as you are
typing. Click OK to add the text.

Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

Select the new text field and enter -------- (eight hyphens). This series of
hyphens will form a separating line between the words Qty Ord and the
field below. The Text Properties dialog is displayed as you are typing.
Click OK to add the text.

Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

Select the new text field and enter -------- (eight hyphens). This series of
hyphens will form a separating line between the word Unit and the field
below. The Text Properties dialog is displayed as you are typing. Click
OK to add the text.

Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

10

Select the new text field and enter ------------- (thirteen hyphens). This
series of hyphenswill form a separating line between the words Cons.
Units and the field below. The Text Properties dialog is displayed as you
aretyping. Click OK to add the text.

11

Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.
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Moving theline
item fields, labels,
and separating
lines

How to arrange
theLine No.
column

How to arrange
theProd ID
column

(Contd)
Sep

Action

12

Select the new text field and enter ----------- (thirteen hyphens). Thisseries
of hyphens will form a separating line between the words Price Each and

the field below. The Text Properties dialog is displayed as you are typing.
Click OK to add the text.

The separating lines (static text) you added are displayed in the upper left
corner of the frame.

13

Select al the static text you added and drag it to the bottom of the frame.
Moving the static text out of the way will give you more room at the top of
the frame.

Note
To select more than onefield or field label, click and drag the mouse
diagonally across all the fields and field labels you want to select.

Theline item (OLD) frame now contains al of the fields, labels, and separating lines that
will be arranged on the form to create columns of information. Now you are ready to move
the fields, labels, and separating lines to their proper locations on the frame.

Use this procedure to arrange the Line No. column on the lineitem (OLD) frame.

Sep Action
1 Select the Linefield label and drag it to the upper left corner on the frame.
2 Select the No. static text and drag it below the Line field label.
3 Select the first separating line you added (seven hyphens) and drag it
below the No. static text.
4 Select the Linefield and drag it below the separating line you just moved.

Use this procedure to arrange the Prod 1D column on the line item (OLD) frame.

Sep Action
1 Select the Prod I D field label and drag it to the right of the No. static text.
2 Select the second separating line you added (thirteen hyphens) and drag it
below the Prod ID field label.
3 Selecetdthe Prod ID field and drag it below the separating line you just
moved.
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How to arrange
the Qty Ord
column

How to arrange
the unit column

How to arrange
the cons. units
column

Forms Integration TRADACOMS Tutorial Guide

Use this procedure to arrange the Qty Ord column on the line item (OLD) frame.

Sep Action
1 Select the Qty Ord field label and drag it to the right of the Prod ID field
label.
2 Select the third separating line you added (eight hyphens) and drag it
below the Qty Ord field label.
3 Select the Qty Ord field and drag it below the separating line you just

moved.

Use this procedure to arrange the Unit column on the line item (OLD) frame.

Sep Action
1 Select the Unit field label and drag it to the right of the Qty Ord field
label.
2 Select the fourth separating line you added (eight hyphens) and drag it
below the Unit field label.
3 Select the Unit field and drag it below the separating line you just moved.

Use this procedure to arrange the Cons. Units column on the lineitem (OLD) frame.

Sep Action
1 Select the Cons. Unitsfield label and drag it to the right of the Unit field
label.
2 Select the fifth separating line you added (thirteen hyphens) and drag it
below the Cons. Unitsfield label.
3 Select the Cons. Unitsfield and drag it below the separating line you just

moved.
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How to arrange
the price each
column

How to movethe
description fields

How toresizethe
lineitem (OLD)
frame

Use this procedure to arrange the Price Each column on the line item (OLD) frame.

Sep Action
1 Select the Price Each field label and drag it to the right of the Cons. Units
field label.
2 Select the sixth separating line you added (thirteen hyphens) and drag it
below the Price Each field |abel.
3 Select the Price Each field and drag it below the separating line you just
moved.

The description fields (Traded Unit Descr. Line 1 and Traded Unit Descr. Line 2) will not
be placed in acolumn. Rather, these fieldswill be placed below the rest of the fields onthe
lineitem (OLD) frame.

Use this procedure to move the description fields.

Sep Action
1 Select the Traded Unit Descr. Line 1 and Traded Unit Descr. Line 2
fields.
Note
To select more than one field or field label, click and drag the mouse
diagonally across al the fields and field labels you want to select.
2 Drag them below the row of fields near the top of the frame.

You should resize the line item (OL D) frame to eliminate unnecessary space resulting
from arranging the fields on the frame.

To resize the frame, click and drag the bottom of the frame to just below the description

fields.

Thelineitem (OLD) frame now should look like this:

Frpd ID oty ord Tnlt Cona. Talta

Feloe Each
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How to align rows

One of the remaining tasks in formatting the line item frame isto align the fields, field

labels, and static text. First, you will align the itemsin rows to give the form a consistent
appearance. Then, you will align the itemsin columns later in this tutorial.

Use this procedure to align the fields, field labels, and static text by row (horizontally).

Sep

Action

1

Select the following field labels and static text:

» No.

» ProdID
» QtyOrd
» Unit

» Cons. Units
» PriceEach
Note

To select agroup of items, click and drag the mouse diagonally across all
the items you want to select.

Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu. The tops of all selected field labels and
static text are aligned in arow.

Select al the separating lines between column headings and fields.

Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu. The tops of all selected static text are
aligned in arow.

Select the following fields:

» LineNo.
» ProdID

» QtyOrd
» Unit

» Cons. Units
» PriceEach

Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu. The tops of all selected fields are aligned
inarow.

Select al the separating lines between column headings and fields.

Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu. The tops of all selected static text are
aligned in arow.
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(Contd)
Sep

Action

9

» Select thefollowing fields:

» LineNo.
» ProdID

» QtyOrd
» Unit

» Cons. Units
» PriceEach

10

Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu. The tops of all selected fields are aligned
inarow.

How to align Now, you will align thefields, field labels, and static text in columnsto help give the form
columns  aconsistent appearance.

Use this procedure to align the fields, field labels, and static text in columns.

Step

Action

1

Select the Line No. column heading, its separating line, and the Line No.
field.

Note
To select agroup of items, click and drag the mouse diagonally across all
the items you want to select.

Select Align Controls from the Display menu, then select Left from the
Align Controls cascading menu. All selected items are left-aligned in a
column.

Select the Prod | D column heading, its separating line, the Prod 1D field,
and both description fields (Traded Unit Descr. Line 1 and Traded Unit
Descr. Line 2).

Note
To select more than one item on aframe, click the first item, then press
CTRL and click the second item.

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. All selected items are left-aligned in a
column.

Select the Qty Ord column heading, its separating line, and the Qty Ord
field.
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(Contd)
Sep

Action

6

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. All selected items are left-aligned in a
column.

Select the Unit column heading, its separating line, and the Unit field.

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. All selected items are left-aligned in a
column.

Select the Cons. Units column heading, its separating line, and the Cons.
Unitsfield.

10

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. All selected items are left-aligned in a
column.

11

Select the Price Each column heading, its separating line, and the Price
Each field.

12

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. All selected items are left-aligned in a
column.

Thelineitem (OLD) frame now should look like this:

Llne

Wo. Peod ID QER Crd Uuikt Cona. Units Frice Fach
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Creatingtheline  You have completed formatting the lineitem (OLD) frame so that the lineitem
item frame without information will be displayed in columns and rows. If you were to register the trandation
column headings object now with Sterling Gentran:Server and run EDI data through the translation object,
then you would see that the column headings would be repeated for every line item.

The column headings need to be printed on the printout only once, so you will copy and
paste the OLD group to create asecond OLD group (named OL D:3). The formatting in the
OLD group will beretained in the OLD:3 group. You will change the maximum use of the
first OLD group to one (so that the column headings are printed only once). Then, you will
remove the column headings in the OLD:3 group from the area that will be printed,
leaving only the fields for printing the information on the printout.

In addition, you will change the maximum use of the OLD:3 group to 999,998. Your
partner can send you up to 999,999 line items, so the total maximum use of both OLD
groups does not need to exceed 999,999. The maximum use of the OLD group will be
changed to one, and the maximum use of the OLD:3 group will be changed to 999,998.

How to copy and Use this procedure to copy and paste the OLD group.

pastethe OLD
group Sep Action
1 Select the OL D group.
2 Click Copy on the Main Toolbar.
3 Select Paste on the Main Toolbar to paste the OLD group after the

existing OLD group.

System Response

Sterling Gentran: Server prompts you to specify whether you want the
contents of the clipboard pasted as a child (subordinate) of the selected
group, or at the same level as the group.

Gentran Forms Integration E
The caontents of the clipboard can be pazted az follows:

9 Faszte Optiong Cancel |

" Paste as a child of selected item

+ Paste after selectad item [at the same lewelf

4 Click the Paste after selected item (at the same level) radio button to
paste the Clipboard contents after the original OLD group.

5 Click OK to exit the dialog. The pasted group is named OLD:3.

Sterling Gentran:Server — May 2011 Forms Integration TRADACOMS Tutorial Guide



How to changethe  Use this procedure to change the maximum use of the OLD group.
maximum use of

the OLD group Sep Action
1 Click the OL D group with the right mouse button to access the shortcut
menu.
2 Select Properties from the shortcut menu.

System Response
The Group Properties dialog is displayed.

3 Inthe Max Usage field, enter 1 to indicate that this group can be used only
once in each purchase order.

4 Click OK to exit the Group Properties dialog.

How to changethe  Usethis procedure to change the maximum use of the OLD:3 group.
maximum use of

the OLD:3 group Sep Action
1 Click the OL D: 3 group with the right mouse button to access the shortcut
menu.
2 Select Properties from the shortcut menu.

System Response
The Group Properties dialog is displayed.
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3 In the Max Usage field, enter 999998 to indicate that this group can be

used up to 999,998 times in each purchase order.

4 Click OK to exit the Group Properties dialog.
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How to movethe  Usethis procedure to move the column headings on the second line item frame (OLD:3)
OLD:3column  below the print area, so the headings will not be printed.
headings below the

print area Sep Action
1 Click Generate L ayout on the Main Toolbar to refresh the display of the
print form.
2 Select the OL D:3 group. Its corresponding frame is displayed in the
Layout Window.
3 Select al of the column headings and separating lines on the frame, and

drag them below the bottom of the frame so they are not displayed. These
items still will be included in the print form, but they will not be printed
on the printout.

Note
To select more than one field label or static text, click and drag the mouse
diagonally across all the items you want to select.

4 Select al of the fields on the frame, and drag them to the top of the frame.

5 To resize the frame, click and drag the bottom of the frame to just below
the description fields (Traded Unit Descr. Line 1 and Traded Unit Descr.
Line2).

The second line item (OLD:3) frame now should look like this:

O
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Arranging the Order Trailer (OTR) Field

Overview  The Number of Line Itemsfield (OTR group) for the purchase order is contained on a
separate frame than the rest of the purchase order information because this field contains
summary information that you want to be printed at the bottom of the form.

You will resize the Order Trailer (OTR) frame to give it the same width as the header and

line item frames.

How to movethe  Usethis procedure to move the Number of Line Itemsfield on the Order Trailer (OTR)
order trailer  frame.

(OTR) field
Sep Action
1 Select the Number of Line Itemsfield and drag it to the right of itsfield
label.
2 Select the Number of Line Itemslabel and field.
Note

To select more than one field label or static text, click and drag the mouse
diagonally across al the items you want to select.

3 Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu. The tops of the Number of Line Items
label and field are aligned.

4 To resize the Order Trailer (OTR) frame, click and drag the bottom of the
frame to just below the Number of Line Items label and field.

5 Select Save from the File menu to save the form.

The Order Trailer (OTR) frame now should look like this:

Huber of Line [tewms: I:l

You have completed your Purchase Order form and you are ready to compile the form.
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Finalize the Form

Overview

Introduction Now that you have created and customized the print form, you are ready to compile the
form to generate the translation object (*.TPL) that Sterling Gentran:Server uses before
you print the report and test the compiled translation object.
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Compiling the Form

Overview  The Compile function compiles the form. The form that you create using Sterling
Gentran: Server is a source form. When that source form is compiled, the result isa
compiled translation object.

This tranglation object must be registered with the Sterling Gentran: Server system before
you can useit. You will use the Compile function after the form is completed and saved.

Procedure  Usethis procedure to compile the form.

Sep Action
1 Select Compile from the File menu to display the Run-Time Trandlation
Object Name dialog.
2 Click Saveto accept the trandation object name (pettordp.tpl) in the File
name field.

This name for the compiled translation object (.TPL file) isthe same
filename as the source form (.STP file). Preserving the same filename
(with different file extensions) ensures that the relationship between the
source form and the compiled translation object remains evident.

CAUTION

BE VERY CAREFUL NOT TO OVERLAY THE SOURCE
FORM WITH THE COMPILED TRANSLATION OBJECT.
USE THE .TPL FILE EXTENSION TO DISTINGUISH THE
COMPILED TRANSLATION OBJECT.

3 The system will compile the form and generate an error report. The error
report is displayed in the Compile Errors dial og.

4 Click OK to exit the Compile Errors dialog. The date on which you
compiled the form is loaded automatically into the Compiled on field on
the Trandlation Object Details dialog.

Note

If the Compile Errors dialog contains errors, you must fix the problem(s)
by redoing the appropriate section of the tutorial. Recompile the form
after you correct the error(s) and save the form.

5 Select Save from the File menu to save the form.
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Printing the Report

Overview  The Sterling Gentran: Server report enables you to validate and review the translation
object, and make modifications as needed. If you review the report and determine that the
tranglation object isincorrect, you should reiterate the form creation process as many
times as necessary (make the modifications, save the form, recompile the form, and print
the report again).

Procedure  Usethis procedure to print the Sterling Gentran: Server report.

Step

Action

1

Select Print from the File menu to access the Print Options dial og.

Click OK to accept the defaults on thisdialog (all options marked), so the
report includes al sections and only the activated form components.

System Response
The Print dialog is displayed.

Do you need to change setup options (to select a specific printer, paper
orientation, or size and source of paper) ?

» If yes, click Properties. Set the appropriate options. Click OK to
begin the print process.

» If no, click OK to begin the print process.
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Testing the Trangation Object

Overview  Before you can use the TRADACOMS ORDERS Pet Zone print translation object, you
must test the tranglation object to verify that there are no errorsinit. To test the trandation
object, you must have afile containing test data. For thistutorial, you will use the
PETTSTT2INT test file.

Procedure  Usethis procedure to test the print translation object you just created.

Step

Action

1

Register the PETTORDP.TPL translation object with Sterling
Gentran:Server.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on registering a translation object.

Import the PETZONEA4.PAR partner relationship into Sterling
Gentran:Server.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on importing a partner.

The default path for the partner is:
C:\GENSRVNT\TUTORIAL\PETZONE4.PAR

Verify (in Partner Editor) that the ORDERS Pet Zone print translation
object is selected for the Inbound Relationship.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on selecting inbound translation objects.

Use the Process File option in Sterling Gentran: Server to process the data
file (PETTSTT2.INT) through the translation object. The datafileis
located in the TUTORIAL subfolder under the folder where Sterling
Gentran:Server isinstalled.

The default path for the datafileis:
CAGENSRVNT\TUTORIAL\PETTSTT2INT

After the message istrandated, it islocated in the in Documentsin
Sterling Gentran: Server. Print the message to ensure that the message was
tranglated correctly and that the printout looks the way you want it to look.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on printing messages.
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Overview

| ntroduction

Inthischapter  Thischapter includes the following topics associated with creating a screen entry form:
» Formanalysis
» Creating, saving, and setting up a new form
» Customizing the form, including the groups, segments, and elements
» Formatting the form, including fields and field labels
» Finaizing theform.
Note

Press F1 from any area of the system to access the online Help for that function. The
online Help system contains field definitions and other detailed information.

Purpose of this  Thistutorial explains how to customize and format a form beforeit is compiled into a
tutorial tranglation object. The form that you create is a sour ce form. When that source formis
compiled, the result is a compiled translation object. You must register the translation
object with Sterling Gentran:Server to be able to use the translation object (to enter EDI
datain messages of that type).

Formcriteria  Sterling Gentran: Server generates a basic form based on the following criteriayou
specify:
» Typeof form (e.g. screen entry or print)
» Standard agency (e.g. TRADACOMS, EDIFACT)
» Standard version (e.g. ANAOOL, 92.1)
» Messagetype (e.g. ORDERS, INVOIC)
» Release (message version) (e.g. 9)

Mandatory  All mandatory groups, segments, composites, and elements for the standard, version, and
components  message you specify are available for use (activated) when Sterling Gentran: Server
creates aform. Only these mandatory form components (groups, segments, composites,
and elements) are activated automatically. You must activate additional form components
that you want to be displayed in the screen entry form, and then customize and format the
form so that it is appropriate and useful for your company’s needs.
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Beforeyou begin  Before you begin to customize a screen entry form, you should be familiar with the
following elements of form design:

» EDI standards (how EDI standards work and how the information your users need is
tranglated to and from the standards)

» Your users (the individuals who will be using the screen entry formsto enter EDI
data)

» Your trading partners (the organisations receiving the EDI data that your users enter
in the screen entry form)

You can create adifferent screen entry form for each combination of message, trading
partner, and standard version. Thereis no limit to the number of screen entry formsyou
can create, and the number of screen entry forms you create is not affected by the number
of print forms you create.

Recommendation

We recommend that you mock up alayout of the screen entry form the way you ultimately
want it to look. Asyou are designing the layout, you should take into consideration the
people who will be using the translation object. Make sure that the form makes sense to
the people who will be using it. By analyzing your company’s needs before you actualy
create the screen entry form, you will reduce the amount of time spent later on redesigning
or reformatting the form.
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Phases of Form Design

Overview  Thistableliststhe phases of form design.

Phase Description
1 Anayzethe EDI file.
2 Design and create the form.
3 Modify form components.
4 Customize the EDI data.
5 Format the form.
6 Finalize the trand ation object.
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Getting Sarted

Overview

Screen entry form
scenario

Thistutorial is meant to be completed in its entirety. We strongly recommend that you
complete each task sequentially. The purpose of completing each task in this tutorial in
sequential order, asif it were your own scenario, is hot only to teach you how to perform
the individual tasks, but also to teach you alogical approach and methods that should be
used when you create your own form.

This section guides you in completing the stepsin the first phase of form design. In this
section, you will create anew screen entry form based on a scenario we have defined for
you. This section includes the basics of creating the form, such as defining the scenario
and analyzing the purpose of the form, creating and saving the form, and setting up the
form. Later in this chapter, you can find techniques for customizing the segments,
elements, and groups in the form, as well as for formatting the organization and
appearance of the form.

For this tutorial, you will create a screen entry form for the INVOIC message (invoice),
using the TRADACOMS ANAOQOL release 9 standard. The steps involved in creating this
form are broken down into manageabl e pieces so that you can learn the tasks and
procedures involved in creating a screen entry form. Then, you can apply the knowledge
gained from using this tutorial to create your screen entry forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures awide
variety of pet supplies for pet stores. One of your trading partners, Pet Zone (a large pet
supply retailer), orders products from your company. Your company then invoices Pet
Zone for those products. You will create aform that your data entry users will use to enter
EDI datafor the invoice that you will send to Pet Zone. From discussions with Pet Zone,
you know the requirementsfor the invoices that they receive from you. In thistutorial, you
will invoice one order per message only. You will not use settlement discounts.
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Analyzethe EDI File

Basic Tasks

Introduction  To analyzethe EDI file, first you must determine what data you need to send your trading
partner and what data your trading partner expectsto receive. It isimportant to analyze the
datain thisway so that the invoice will contain all the necessary information, and so that
your company can bill your partner correctly for the order you shipped to them. You and
your partner must agree on which standard, version, message, and release you will be
using. Inthistutorial, you areusingaTRADACOMS ANAQOL INVOIC release 9 invoice.
It isimportant to know the information your partner expects you to send in the invoice,
and what datawill be contained in each element used.

It isvery helpful to review the EDI standard that you will use before analyzing the EDI
file. We recommend that you obtain an EDI standard manual for the standard and version
that you will use. Standard manuals are available from EDI standard agencies.

After discussing with your partner what you will send, determining which segments and
elements your partner requires, and reviewing the EDI standard, you can list the items that
you will need to use (activate). When Sterling Gentran: Server generates the EDI file
format, the system includes all the groups, segments, composites, and elements that are
defined by the standard agency for the version of the message you selected. The system
activates all the groups, segments, composites, and elements that are defined as mandatory
(must be present) by the standard. The system does not enable you to deactivate
mandatory groups, segments, composites, and elements.

Form analysis  Thefirst step in creating aform is the analysis of the form requirements. If the analysis
you perform is complete, you will have all the information you need to create the formin
an efficient and logical manner. If you omit this critical step and proceed directly to
creating the form, it islikely that creating the form will be a much longer and arduous
task, and the form may not work the way you need it to, due to oversights and omissions.

Creating a screen entry form for the TRADACOMS INVOIC message requires severa
steps. Some steps are performed at the message level (such as activating form
components), and others are iterative steps that are performed for each group, segment, or
element in the form. In this analysis phase, you must determine what EDI data you will
send Pet Zone, as well as what information Pet Zone requires to process the invoice. The
fields on the form must account for all information that you expect to send to Pet Zone.
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Mandatory  Thistable lists the groups, segments, composites, and elements that have been defined as
components  mandatory by the standards committee for a TRADACOMS ANAOOL INVOIC release 9
invoice, and are activated automatically when you create a new form.

Group | Group | Segment | Composite | Element Description
CLO Customer’s Location
CLOC
IRF Invoice References
INVN Invoice Number

IVDT Date of Invoice

TXDT Tax-Point Date

ODD

ILD

STL VAT Rate Invoice Sub Trailer

SEQA:7 | First Level Sequence Number

CD12:2 | VAT Rate Category Code

VATP.2 | VAT Rate Percentage

NRIL Number of Item Lines

LVLA Lines Sub-Total (Excluding
VAT)

EVLA Extended Sub-Total Amount
(Excluding VAT)

ASDA Extended Sub-Total Amount
(After Settlement Discount
Has Been Applied)

VATA VAT Amount Payable

APSI Payable Sub-Total Amount
Including Settlement
Discount
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(Contd)
Group | Group | Segment | Composite | Element Description

TLR Invoice Trailer

NSTL Number of Total Segments

LVLT Lines Total Amount
(Excluding VAT)

EVLT Total Extended Amount Ex
Settlement Discount

ASDT Total Amount Exc VAT Inc
Sett

TVAT Total VAT Amount Payable

TPSI Total Payable Inc Settlement

Required  When trans ating data, the system does not process groups, segments, composites, and
components  €lementsthat are not activated. Therefore, you must make available (activate) the groups,
segments, composites, and elementsthat are not defined as mandatory by the standard, but
that you have determined that you need to usein the form.

For thistutorial, the form components that are required (need to be activated) and are not
mandatory for the standard are the following:

Note

When you activate aconditional group, segment, or composite, the mandatory subordinate
segments, composites, and elements are activated automatically. A conditional group,
segment, or compositeis used only if thereis EDI data available for an element contained

init.
Constant, Code Value,
Data or Format to Be
Element Description Type | Length Assigned
Customer’s Location (CLO Segment) (Already Activated)

CLOCLOCCLOO | Customer’'sANA Location | String | 13 Format =9

Code
CLOCLOCCLO1 | Customer’'sOwn Location | String | 17

Code
CLO CNAM Customer’s Name String | 40

CLO CADD CADO | Customer'sAddressLinel | String | 35

CLO CADD CAD1 | Customer’'sAddressLine2 | String | 35
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Constant, Code Value,

Data or Format to Be
Element Description Type | Length Assigned
CLO CADD CAD?2 | Customer'sAddressLine3 | String | 35
CLO CADD CAD3 | Customer’'sAddressLine4 | String | 35
CLO CADD CAD4 | Customer’s Post Code String | 8
Settlement Terms (PY T Segment)
PYT PAYT Terms of Payment String | 40
Data Narrative (DNA Segment)
DNA GNAR General Narrative Line 1 String | 40
GNAO
DNA GNAR General Narrative Line 2 String | 40
GNA1
DNA GNAR Genera NarrativeLine 3 String | 40
GNA2
DNA GNAR General Narrative Line 4 String | 40
GNA3

Order and Delivery Terms (ODD Group) (Already Activated)

Order and Delivery Terms (ODD:2 Segment)

ODD:2 ORNO Customer’s Order Number | String | 17

ORNO

ODD:2 ORNO Date Order Placed by Dt/Tm | 6 Screen Format =
ORN2 Customer DD/MM/YY
ODD:2 DELN Delivery Note Number String | 17

DELO

ODD:2 DELN Date of Despatch by Dt/Tm | 6 Screen Format =
DEL1 Supplier DD/MM/YY

Invoice Line Details (ILD Group in ODD Group) (Already Activated)

Invoice Line Details (ILD:2 Segment)

ILD:2 SPRO SPRO | EAN-13 Code for the String | 13
Traded Unit

ILD:2 SPRO SPR1 | Supplier’s Code for the String | 30
Traded Unit

ILD:2 CPRO CPR1 | Customer’s Item Code String | 30
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Constant, Code Value,
Data or Format to Be
Element Description Type | Length Assigned
ILD:2QTYI QTYO | Number of Order Units String | 15 Format = NO (Number
Invoice data type)
ILD:2QTYI Measure Indicator String | 6 Any valid code
CD04:2
ILD:2 TDESTDEO | Traded Unit Descr. Linel | String | 40

Segment analysis

For each segment activated (either mandatory or optional), you must ask the following

questions:

»  Will the segment have a maximum use greater than one?
» What composites and elements need to be activated for the segment?

This table describes the segment components used in thistutorial.

Component

Description

Group

Contains related segments and/or groups that repeat in sequence
until either the group data ends or the maximum number of times
that the loop is allowed to repeat is exhausted.

Repeating segment

Consists of elementsthat repeat (in sequence) until the segment
data ends or the maximum number of times the segment is
allowed to repeat is exhausted.

Composite

Contains two or more component data elements or subelements.
Composites are defined by the EDI standards that use them
(EDIFACT, TRADACOMS, and certain ANSI X12 standards).

Maximum use

Refers to the number of times that a segment can be used within
the structure in which the segment is defined. For example, if a
segment can be used only once within agroup, but the group can
be used multiple times, the segment still has a maximum use of
one within each occurrence of the group. The standard defines
the maximum number of times a segment can be used, but you
must determine how many times a segment will be used, based
on what you will be sending your trading partner.

Elements

Each segment contains elements. Some elements are mandatory
and others are optional to the standard but necessary for your
needs. You must define all the elements that you will be sending
Pet Zone for each segment.
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Customisation
tasks

Sterling Gentran: Server generates aform based on the groups, segments, composites, and
elements you activate. At this point, the form is compliant with the standard and it

contains all the necessary components based on the data you will send Pet Zone. However,
you need to customize the form components to produce aform that is easy to use to enter

datain alogical manner.

Thistable lists the required customisation tasks described in this tutorial.

Form Component

Description

Customisation Task

INVOICfile Invoice Details Use an extended rule to calculate the VAT
summary for thefieldsinthe STL and TLR
segments.

CLOCLOCCLOO | Customer'sANA | Your userswill enter the ANA code for the

element Location Code customer’s location to which the invoiced
items are to be shipped as a string data type
accepting numeric characters only.
Therefore, you will designate the
appropriate string format for this element.
Also, you will change the field label to
“Location ANA Code.”

CLOCLOCCLO1 | Customer'sOwn | Your userswill enter astring no longer than

element Location Code ten charactersin this element, so you will
change the maximum length for this
element to ten. Also, you will change the
field label to “Location Own Code.”

CLO CNAM Customer’s Your userswill enter astring no longer than

element Name thirty-five charactersin thiselement, so you
will change the maximum length for this
element to thirty-five. Also, you will
shorten the field label to “Name.”

CLO CADD CADO | Customer’s You will shorten the field label for this

element AddressLine 1 element to “AddressLine 1.”

CLO CADD CAD1 | Customer’s You will shorten the field label for this

element AddressLine 2 element to “AddressLine 2.”

CLO CADD CAD2 | Customer’s You will shorten the field label for this

element AddressLine 3 element to “AddressLine 3.”

CLO CADD CAD3 | Customer's You will shorten the field label for this

element AddressLine4 element to “Address Line 4.”

CLO CADD CAD4
element

Customer’s Post
Code

You will shorten the field label for this
element to “Post Code.”
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Form Component Description Customisation Task
|RF segment Invoice You and your trading partner will use this
References segment only once, so you will change the

maximum use of this segment to one.

IRF INVN element

Invoice Number

You will shorten the field label for this
element to “Invoice No.” In addition, you
will set up the document name (which
enables you to differentiate between
messages in the document browsersin
Sterling Gentran: Server) for this element.

IRFIVDT element

Date of Invoice

Your users will enter the invoice date in
DD/MM/YY format (not YYMMDD
format, the default format defined by the
standard). Therefore, you will change the
screen format accordingly. You will change
the maximum length for this field and
element to eight (to accommodate the
longer date format). In addition, you will
change thefield label to “Invoice Date.”

IRF TXDT element

Tax-Point Date

Your users will enter the tax-point datein
DD/MM/YY format (not YYMMDD
format, the default format defined by the
standard). Therefore, you will change the
screen format accordingly. You will change
the maximum length for thisfield and
element to eight (to accommodate the
longer date format).

PYT segment

Settlement Terms

You and your trading partner will use this
segment only once, so you will change the
maximum use of this segment to one.

PYT SEQA element | First Level This element isrequired in the invoice, but
Sequence is not meaningful for your purposes. You
Number will prevent this field from being displayed
in the screen entry translation object. Also,
you will define a constant value for this
field, asthisfield will dways have the same
value (because each invoice corresponds to
only one purchase order).
PYT PAYT element | Terms of You will shorten the field label for this
Payment element to “Payment Terms.”
DNA segment Data Narrative You and your trading partner will use this

segment only once, so you will change the
maximum use of this segment to one.

Forms Integration TRADACOMS Tutorial Guide
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Form Component Description Customisation Task
DNA SEQA:2 First Level This element isrequired in the invoice, but
element Sequence is not meaningful for your purposes. You
Number will prevent thisfield from being displayed
in the screen entry translation object. Also,
you will define a constant value for this
field, asthisfield will dways have the same
value (because each invoice corresponds to
only one purchase order).
DNA GNAR GNAO | General Narrative | You will shorten the field label for this
element Linel element to “Invoice Notes.”
DNA GNAR GNA1 | Genera Narrative | The datain this element will be self-
element Line2 explanatory, so you will remove the label
from thisfield.
DNA GNAR GNA2 | General Narrative | The datain this element will be self-
element Line3 explanatory, so you will remove the label
from thisfield.
DNA GNAR GNA3 | Genera Narrative | The datain this element will be self-
element Line4d explanatory, so you will remove the |abel
from thisfield.
ODD group Order and You and your trading partner will usethis
Delivery Terms group only once, so you will change the
maximum use of thisgroup to one. You will
promote this group so that the fieldsin this
group are placed on the main Invoice
Details frame.
ODD:2 SEQA First Level This element isrequired in the invoice, but
element Sequence is not meaningful for your purposes. You
Number will prevent thisfield from being displayed
in the screen entry translation object. Also,
you will define a constant value for this
field, asthisfield will dways have the same
value (because each invoice corresponds to
only one purchase order).
ODD:2 ORNO Customer’sOrder | You will change the field label for this
ORNO element Number element to “ Customer’s PO. No.”
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Form Component

Description

Customisation Task

ODD:2 ORNO
ORNZ2 element

Date Order
Placed by
Customer

Your users will enter the purchase order
datein DD/MM/YY format (not
YYMMDD format, the default format
defined by the standard). Therefore, you
will change the screen format accordingly.
You will change the maximum length for
thisfield and element to eight (to
accommodate the longer date format). In
addition, you will shorten the field label to
“PO. Date.”

ODD:2 DELN
DELO e ement

Delivery Note
Number

You will add Help text to thisfield.

ODD:2 DELN
DEL1 element

Date of Despatch
by Supplier

Your users will enter the delivery datein
DD/MM/YY format (not YYMMDD
format, the default format defined by the
standard). Therefore, you will change the
screen format accordingly. You will change
the maximum length for this field and
element to eight (to accommodate the
longer date format). In addition, you will
shorten the field label to “Delivery Date.”

ILD groupinthe
ODD group

Invoice Line
Details

You will add the more descriptivetitle
“Line Items” to the group description to
label the fields contained on the ILD:2
frame. In addition, you will use an extended
rule to calculate the extended line cost for
the line items, and to convert the VAT rate
percentage from astring (itsdatatypein the
partner database) to anumber (the datatype
required in the VAT Rate Percentage
element).

ILD:2 SEQA
element

First Level
Sequence

Number

This element isrequired in the invoice, but
is not meaningful for your purposes. You
will prevent thisfield from being displayed
in the screen entry tranglation object. Also,
you will define a constant value for this
field, asthisfield will dways have the same
value (because each invoice corresponds to
only one purchase order)

Forms Integration TRADACOMS Tutorial Guide
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Form Component Description Customisation Task
ILD:2 SEQB 2nd Level You will use the Loop Count standard rule
element Sequence No. to count the number of thisiteration of the

group in thisfield (to provide acount of the
number of lineitemsin theinvoice). You
will instruct the system to display the value
from thisfield in the first column in the
Line Items list box on the Invoice Details
frame. Also, the line item number will be
no longer than five digits, so you will
change the maximum length for this
element to five. In addition, you will
shorten the field label to “I1tem No.” and
make the field display-only (as the users
will not need to enter avauein thisfield).

ILD:2 SPRO SPRO

EAN-13 Codefor

You will shorten the field |abel for this

element the Traded Unit element to “EAN Code.”

ILD:2 SPRO SPR1 | Supplier’'sCode | You will instruct the system to display the

element for the Traded value from thisfield in the second column
Unit in the Line Itemsist box on the Invoice

Details frame. Also, you will change the
field label to “Supplier’s Product Code.”

ILD:2 CPRO CPR1
element

Customer’s Item
Code

You will change the field label for this
element to “ Customer’s Product Code.”

ILD:2QTYI QTYO
element

Number of Order
Units Invoice

Your users will enter the quantity asa
number with NO format (formatted with an
implicit decimal point and no decimal
places). Therefore, you will change the data
type from String to Number and the screen
and EDI formats to NO formats. You will
instruct the system to display the value
from thisfield in the third column in the
Line Items list box on the Invoice Details
frame. Also, the quantity will be no longer
than five digits, so you will change the
maximum length for thiselement to five. In
addition, you will shorten the field label to
“Quantity.”

ILD:2QTYI
CDO04:2 element

Measure
Indicator

Your users can enter any of the measure
indicator codes that the standard designates
asvalid codes. You will 1oad the entire code
list for this element, which will create a
drop-down list box containing valid codes
from which users can select. Also, you will
changethefield label to “Unit of Measure.”
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Form Component

Description

Customisation Task

element

ILD:2AUCT AUCO

Cost Price
(Excluding VAT)

Your users will enter the unit pricein R4
format (formatted with an explicit decimal
point and up to four decimal places).
Therefore, you will change the screen
format to R4. You will instruct the system
to display the value from thisfield in the
fourth column in the Line Items list box on
the Invoice Details frame. Also, you will
change thefield label to “Unit Price (Ex.
VAT).”

ILD:2 LEXC
element

Extended Line
Cost (Excluding
VAT)

The extended line cost will be formatted as
an R4 number (formatted with an explicit
decimal point and up to four decimal
places). Therefore, you will change the
screen format to R4. In addition, you will
prevent thisfield from being displayed in
the screen entry translation object, as users
will not need to enter or view avaueinthis
field.

ILD:2 CD12
element

VAT Rate
Category Code

You will use a Select standard rule so that
all of the available codes from the VAT rate
category code table (VATCODES table)
will be availablein adrop-down list box for
your screen entry translation object users.
Also, you will shorten the field label to
“VAT Code.”

ILD:2 VATP
element

VAT Rate
Percentage

You will create atemporary storage field
for the VAT rate (with a string data type, to
accommodate the VAT rate from the partner
database). The extended rule you used on
the ILD group will convert the string datain
the temporary storage field to a number,
then place the number in the ILD:2 VATP
element (which hasanumber datatype) and
delete the value from the temporary field.
You will prevent the ILD:2 VATP field
from being displayed on the screen entry
translation object.

element

ILD:2 TDES TDEO

Traded Unit
Descr. Line 1

You will shorten the field label for this
element to “ Description.”

STL segment

VAT Ratelnvoice
Sub Trailer

You will add the more descriptive title
“VAT Summary” to the group description to
label the fields contained on the STL frame.

Forms Integration TRADACOMS Tutorial Guide
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Form Component Description Customisation Task
STL SEQA:7 First Level This element isrequired in the invoice, but
element Sequence screen entry translation object userswill not
Number need to enter avaluein thisfield (thisfield

will be assigned avalue in an extended rule
used on the INVOIC file). You will prevent
thisfield from being displayed in the screen
entry translation object.

STL CD12:2 VAT Rate You will instruct the system to display the

element Category Code value from thisfield in the first columnin
the VAT Summary list box on the Invoice
Details frame. Also, you will shorten the
field label to “VAT Code” and make the
field display-only (as users will not need to
enter avalue in thisfield).

STL VATP:2 VAT Rate The VAT rate will be displayed in the

element Percentage screen entry trand ation object in R3 format

(formatted with an explicit decimal point
and up to three decimal places). Therefore,
you will change the screen format to R3.
You will instruct the system to display the
value from thisfield in the second column
inthe VAT Summary list box on the Invoice
Details frame. Also, you will shorten the
field label to “VAT rate” and make the field
display-only (as userswill not need to enter
avauein thisfield).

STL NRIL element

Number of Item
Lines

Thisfield will be assigned avaluein an
extended rule (used on the INVOIC file).
You will change the field label to “Number
of Line Items’ and make the field display-
only (as userswill not need to enter avalue
in thisfield).

STL LVLA element

Lines Sub-Total
(Excluding VAT)

The lines subtotal will be displayed in the
screen entry translation object in R2 format
(formatted with an explicit decimal point
and up to two decimal places). Therefore,
you will change the screen format to R2.
You will instruct the system to display the
value from thisfield in the third column in
the VAT Summary list box on the Invoice
Details frame. Also, you will make this
field display-only (as users will not need to
enter avalue in thisfield) and make minor
changesto thefield |abel.
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Form Component Description Customisation Task
STL EVLA element | Extended Sub- This element isrequired in the invoice, but
Total Amount is not meaningful for your purposes. You
(Excluding VAT) | will prevent thisfield from being displayed
in the screen entry translation object (this
field will be assigned avaluein the
extended rule used on the INVOIC file).
STL ASDA element | Extended Sub- This element isrequired in the invoice, but

Total Amount
(After Settlement

is not meaningful for your purposes. You
will prevent thisfield from being displayed

Discount Has in the screen entry tranglation object (this
Been Applied) field will be assigned avaluein the
extended rule used on the INVOIC file).
STL VATA element | VAT Amount The VAT amount payable will be displayed
Payable in the screen entry translation object in R2
format (formatted with an explicit decimal
point and up to two decimal places).
Therefore, you will change the screen
format to R2. Also, you will makethisfield
display-only (as userswill not need to enter
avauein thisfield).
STL APSI element | Payable Sub- The payable subtotal will be displayed in
Total Amount the screen entry trandlation object in R3
Including format (formatted with an explicit decimal
Settlement point and up to three decimal places).
Discount Therefore, you will change the screen
format to R3. Also, you will makethisfield
display-only (as userswill not need to enter
avauein thisfield) and shorten the field
label to “Payable Subtotal (Inc. Sett.
Disc.).”
TLR NSTL element | Number of Total | Thiselement isrequired in theinvoice, but
Segments is not meaningful for your purposes. You
will prevent thisfield from being displayed
in the screen entry tranglation object (this
field will be assigned avalue in the
extended rule used on the INVOIC file).
TLRLVLT element | Lines Total The invoice amount (excluding VAT) will
Amount be displayed in the screen entry translation
(Excluding VAT) | object in R2 format (formatted with an

explicit decimal point and up to two
decimal places). Therefore, you will change
the screen format to R2. Also, you will
make this field display-only (as users will
not need to enter avaluein thisfield).
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Form Component

Description

Customisation Task

TLR EVLT element

Total Extended
Amount Ex
Settlement
Discount

The invoice amount (excluding settlement
discount) will be displayed in the screen
entry translation object in R2 format
(formatted with an explicit decimal point
and up to two decimal places). Therefore,
you will change the screen format to R2.
Also, you will make thisfield display-only
(asuserswill not need to enter avaluein
thisfield).

TLR ASDT element

Total Amount
Exc VAT Inc Sett

The invoice amount (excluding VAT,
including settlement discount) will be
displayed in the screen entry trandlation
object in R2 format (formatted with an
explicit decimal point and up to two
decimal places). Therefore, you will change
the screen format to R2. Also, you will
make this field display-only (as users will
not need to enter avaluein thisfield).

TLR TVAT element

Total VAT
Amount Payable

The VAT total will be displayed in the
screen entry trandlation object in R2 format
(formatted with an explicit decimal point
and up to two decimal places). Therefore,
you will change the screen format to R2.
Also, you will make this field display-only
(as users will not need to enter avaluein
thisfield).

TLR TPSI element

Total Payable Inc
Settlement

The total invoice amount will be displayed
in the screen entry translation object in R2
format (formatted with an explicit decimal
point and up to two decimal places).
Therefore, you will change the screen
format to R2. Also, you will makethisfield
display-only (as userswill not need to enter
avauein thisfield).
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Design and Create the Form

Verifying the Global EDI Date Formats

Introduction

Procedure

Sterling Gentran: Server enables you to customize the global EDI date formats (for all
forms). You can specify the default EDI format of dates for both six-character dates and
eight-character dates. When you customize the global EDI date formats, the settings are
valid for all forms created in the current session of Sterling Gentran: Server. However, you
can override the default date formats for an individual element on the Element Properties
dialog for that element.

You must verify that you are using the correct global date formats the first time you use
Sterling Gentran: Server. Typically, you will verify the global EDI date formats one time
only. You can change the default date formats if they do not match the formats you intend
to use.

Use this procedure to verify the global EDI date formats.

Sep Action

1 Select Preferences from the Options menu to display the Preferences
dialog. The Preferences dialog is a property sheet that enables you to set
global defaults for Sterling Gentran:Server.

2 Verify that the Standard Formats tab displays the default date formats that
are used when elements are read from the standards database.

3 Verify that the Six-character dates drop-down list box contains
YYMMDD to define the format of the six-character EDI datesin your
forms.

4 Verify that the Eight character dates drop-down list box contains
YYYYMMDD to define the format of the eight-character EDI datesin
your forms.,

5 Click OK to accept the default date formats for 6- and 8-character date
fields and exit the Preferences dialog.

Note

To change the order in which the date formats appear in the Six-character
dates and Eight character dates drop-down list boxes or to add a new date
format to the lists, select Date Formats from the Options menu.
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Defining the Type of Form

Overview  Thefirst task in creating a new form isto define the type of form and EDI standard,
version, transaction (message), and release. In thistutorial, you are creating a screen entry
form so that your data entry users can enter EDI datain an invoice tranglation object in
Sterling Gentran:Server. Instead of defining the INV OIC message to the system yourself,
you want Sterling Gentran:Server to use the standards database on your system to build
the invoice according to the TRADACOMS standard.

Procedure  Usethis procedure to create the new screen entry form.

Important

After you create anew form, it isimportant to define the details of the form and saveit.
The Save function writes (saves) the currently-selected form to disk.

Step

Action

1

Select New from the File menu to display the New Form Wizard.

From the Trandl ation Object Function drop-down list box, accept the
default value Screen entry to indicate that the translation object you are
creating is a screen entry translation object.

From the Data Source drop-down list box, select the ODBC data source
that you wish to use.

From the Agency drop-down list box, select [A] Tradacoms, which isthe
EDI standard you will use for thistransation object.

From the Version drop-down list box, select [ANAQO1], which isthe
version of the standard you will use for this translation object. The
versions that are available depend on which standard you selected.

From the Transaction drop-down list box, select [INVOIC] INVOICE
DETAILS, which isthe transaction set (message) you will use for this
tranglation object. The messages that are available depend on which
standard and version you selected.

From the Release drop-down list box, select 9, which isthe message
version you will use for this translation object. The message versions that
are available depend on which message (transaction) you selected.
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Step

Action

8

Click OK to create the EDI file (it may take afew seconds to create the
file). The form is displayed as follows:
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Select Save from the File menu.

System Response
The Trandlation Object Details dialog is displayed.

Note

If you have performed any function that invalidates the current format of
the transl ation object, the Save function is not available (dimmed) until
you regenerate the layout (click Generate Layout on the Main Toolbar).

10

In the Author field, enter your name. Thisfield usually contains the name
of the person who created the form.

11

In the Description field, enter Screen TRADACOMSINVOIC Pet
Zone. Thisfield is used to provide a brief explanation of the compiled
translation object that will enable you to differentiate it from similar
tranglation objects in Sterling Gentran: Server. For example, “ Screen
TRADACOMS INVOIC Pet Zone” is the description of a screen entry
translation object for a TRADACOMS ANAOOL invoice (INVOIC) for
partner Pet Zone.

12

Verify that Screen entry is selected from the Translation Object Function
drop-down list box.

13

Inthe Major version field, enter 1 to designate the version number for this
translation object.
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Sep

Action

14

In the Minor version field, accept the default value O that designates the
release number for this translation object.

Note

When you make amajor change to this form, increase the version to the
next higher sequential number (e.g. 2.0, 3.0). If you make a minor change
to the form, increase the rel ease to the next higher sequential number (e.g.

2.1,2.2).

15

The Input and Output fields (Agency, Version, Transaction, Release, and F
Group) contain information only if the Input and/or Output sides of the
form are of EDI format. For thistutorial, do not change the information in

these fields.

Note

The system alows you to change the information in the Input and Output
fields, but modifying this information does not alter the content of the
form. An example of when you might want to ater these fieldsis when
you want the form to reflect a standard version that is not loaded on your
system. You can change the version on this dialog, and then physically
ater the form to be compliant with that version.

16

Click OK to save the trandation object details and access the Save As

dialog.

Save As

I _ 4 Formz

Save in:

= & g [BE

pet_810s.stp
pet_850p.stp
peteinve.stp

pettordp.stp
Print TRADACOMS ORDERS Pet Zone.stp

File name: |pettinvs{stp

Save I

Sawe as ype: IForms [*.5tp]

j Cancel |
Help |

17

Verify that the Save in drop-down list box reflects the drive\folder where
Sterling Gentran: Server isinstalled. The default is GENSRVNT\Forms. If
the selected driveis not the correct one, select the appropriate drive.

Sterling Gentran:Server — May 2011

Forms Integration TRADACOMS Tutorial Guide



(Contd)
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18 In the File name field, enter pettinvs.stp to replace the default file name.
You allocate afilenameto aform when you save the form for the first time
or use the Save As function to save a copy of the form under a different
name. The name of the form must be one to eight unique characters that
define the form in a meaningful way. For example, “PETTINVS’ isthe
name of a screen entry form for a TRADACOMS invoice message
(INVOIC) for partner Pet Zone.

The default file extension for formsis .STP. Using this extension
distinguishes source form files from other types of files, such as compiled
translation objects. The naming conventionsin

the Sterling Gentran: Server Forms I ntegration subsystem are as follows:

» Thesourceform (form created in Sterling Gentran:Server) should be
named using the file extension .STP (e.g. PETTINVS.STP).

» Thecompiled translation object (trand ation object that isthe result of
compiling the source form) should be named using the same filename
that was allocated to the source form, but with the file extension . TPL
(e.g. PETTINVS.TPL).

Recommendation

We recommend that you use these naming conventions to distinguish
source forms and compiled translation objects from other types of files.
We also recommend that you use the same filename (different file
extension) for a source form and the trangl ation object that was compiled
fromiit.

19 Click Save to save the form.

Recommendation
We recommend that you save the form as often as possible, to mitigate the possible loss of
additions or modificationsin the event of a hardware or system error.
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Activating Groups, Segments, Composites, and Elements

Overview  When Sterling Gentran: Server generates the form, the system includes all the groups,
segments, composites, and elements that are defined by the standard agency
(TRADACOMYS) for the version (ANA0O1), message (INVOIC), and release (9) you
selected. The system activates all the groups, segments, composites, and elementsthat are
defined as mandatory (must be present) by the standard. The system does not enable you
to deactivate the mandatory groups, segments, and elements.

Example  Inthe example below, the INVOIC group, CLO segment, and CLO CLOC composite are
mandatory for the invoice. You do not need to activate these components. The CLO
CLOC CLOOQ, CLO CLOC CLO1, and CLO CLOC CLO2 elements are not mandatory, so
they are dimmed on the form. To view the segments, composites, and elementsin agroup,
segment, or composite on your form, double-click the form component in the EDI File
Format Window (left side of the Forms main window). To activate an inactive form
component, click Activate on the Main Toolbar, then click the form component. The
component is no longer dimmed.

=5t | MYOIC - b - 1 INVOICE DETAILS
CICLO - M - 1 CUSTOMER'S LOCATION
£ CLOC -M -
o
@
o
-
=

When tranglating data, the system does not process groups, segments, composites, and
elements that are not activated. Therefore, you must activate the groups, segments,
composites, and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in the form.
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Groups, segments, Thistable lists the groups, segments, composites, and elements to be used in this tutorial.
composites, and

elementsused in Group Group Segment Composite Element
thistutorial
CLO CLOC CLOO
(already (already
activated) activated) CLO1
CNAM
CADD CADO
CAD1
CAD2
CAD3
CAD4
PYT PAYT
DNA GNAR GNAO
GNAL1l
GNA2
GNA3
ODD ODD:2 ORNO ORNO
(already (mandatory for
activated) ODD:2) ORN2
DELN DELO
(mandatory for
ODD:2) DEL1
ILD ILD:2 SPRO SPRO
(aready (mandatory for
activated) ILD:2) SPR1
CPRO CPR1
QTYI QTYO
(mandatory for
ILD:2) CD04:2
TDES TDEO

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



Procedure  Usethis procedure to activate the required groups, segments, composites, and elements.

Step

Action

1

Double-click the groups, segments, and composites listed in the table
below to open them. Thistable lists al the segments, composites, and
elements that you need to activate. Opening all the necessary groups,
segments, and composites before you start to activate enables you to scroll
down the form and activate the segments, composites, and elements
sequentialy.

Note

When you activate a conditional group, segment, or composite, the
mandatory subordinate segments, composites, and elements are activated
automatically.

Click Activate on the Main Toolbar.

Click each inactive segment that you need to use. Clicking these segments
will activate the segments.

Note

If you accidentally click asegment that you did not mean to activate, click
the segment with the right mouse button to access the shortcut menu.
Select Deactivate from the shortcut menu.

Click each inactive composite that you need to use. Clicking these
composites will activate the composites.

Note

If you accidentally click a composite that you did not mean to activate,
click the composite with the right mouse button to access the shortcut
menu. Select Deactivate from the shortcut menu.

Click each inactive element that you need to use. Clicking these elements
will activate the elements. When you activate an el ement in a screen entry
form, either the tag “ Edit Box” or the tag “Drop Down” is displayed
before that element’s description. “Edit Box” indicates that the element is
formatted as afield. “Drop Down” indicates that the element is formatted
as adrop-down list box because you applied a standard rule that allows a
selection of multiple items.

Note

If you accidentally click an element that you did not mean to activate,
click the element with the right mouse button to access the shortcut menu.
Select Deactivate from the shortcut menu.

Click Activate on the Main Toolbar to turn activation mode off.
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Verifying EDI Delimitersand Adding Frame Help Text

Overview  You are using an EDI standard that contains composite elements, so you must verify that
Sterling Gentran: Server is specifying the correct delimiters. Delimiters are flags that you
define to the system as separating specific EDI components. Delimiters are necessary for
all variable field-length standards, because the data is compressed (and the leading zeroes
and trailing blanks are removed). The fields vary in length, so the system needs aflag to
determine where one element ends and another begins. For example, an element delimiter
marks the beginning of a new element.

Important

Although verifying EDI delimitersin Sterling Gentran: Server is mandatory only if you are
using a standard with composite elements or subelements, we recommend that you
perform this task regardless of which standard you use.

In addition, you will add frame Help text so screen entry translation object users can
access online Help for the Invoice Details frame.

EDI delimiters  Thistableliststhe valid EDI delimiters.

table
TRADACOMS TRADACOMS
Field Default Char acter Default Hex Value
Tag Delimiter = (equal sign) Ox3D
Segment Delimiter " (apostrophe) ox27
Element Delimiter + (plus sign) 0x2B
Sub Element Delimiter : (colon) O0x3A
Decimal Separator . (full stop) Ox2E
Release Character ? (question mark) Ox3F
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Procedure  Usethis procedure to verify EDI delimiters and add frame Help text.

Step

Action

Right-click the Invoice file icon and select Properties from the shortcut
menu to display the File Format Properties dialog.

Select the Display tab.

In the Frame Help Text list box, enter the following text (press Enter at
the end of each line of text below):

Thisframe containsinformation pertaining
to the entireinvoice message (INVOIC).
For online Help on an individual field on
thisframe, select thefield and pressF1.

Note

Pressing Enter creates line breaks for the online Help that the screen entry
translation object usersin Sterling Gentran: Server view when they press
F1. If you do not create line breaks, the online Help will be displayed on
one line of text in the online Help pop-up window (the text will not wrap
to the next ling), and text that extends beyond the width of the user’s
monitor will not be displayed.

When you generate the form (display the fieldsin the Layout Window),
thereis one framein the Layout Window (right side of Forms main
window) for every group and repeating segment in the EDI File Format
Window (left side of Forms main window). Entering frame Help text for
the group or segment corresponding to each frame enables screen entry
translation object users to access context-sensitive Help text for the frame.

Select the Delimiter s tab to access the Delimiters dial og.

Verify that the correct delimiters are being used for the TRADACOMS
standard. If the delimiters differ from the default values listed in the
previoustable, you can enter either the character or the hexadecimal value
in the correct field.

Note
If you use the default hex value, the value must begin with “0x” (the
number zero and the letter “x”).

The Stream segments check box on the Delimiters dialog currently is not
marked. For thistutorial, do not mark this check box, so the transl ator will
continue to insert a carriage return after every segment. If the Stream
segments check box is marked, then a carriage return is not used after
every segment, and the segments are “ streamed.”

Click OK to save the delimiters and exit the Delimiters dialog.
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Modify Form Components

Changing the Maximum Use of Segments and Groups

Introduction Changing the maximum use of asegment or group changes the maximum number of times
the segment or group can be used. A segment or group with a maximum use greater than
one repeats (loops), and is placed on a separate frame than the segment or group to which
it is subordinate. A segment or group with a maximum use of one does not repeat, and its
fields are displayed on the same frame as the group to which it is subordinate.

In thistutorial, you will change the maximum use of the groups and segments before you
generate the form (display the fieldsin the Layout Window). By customizing the group
and segment propertiesfirst, all fields are placed on their appropriate frames the first time
you generate the form. If you change the maximum use of the groups and segments after
you generate the form, the fields will be placed on several more frames than will be
present ultimately in the form. Therefore, changing the group and segment properties
before you first generate the form enables the fields to be placed on as few frames as
necessary.
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Changing the Maximum Use of the |RF Segment

Overview  TheIRF segment contains the Invoice References for the invoice. In this tutorial, the IRF
segment will be used for the invoice number, invoice date, and tax-point date. The
standard allows the |RF segment to be used up to 999,999 times in one invoice. In this
tutorial, you will use the IRF segment only once per invoice. You will change the
maximum use of the IRF segment to one, which will place the associated fields on the
main Invoice Details frame with the majority of the invoice fields.

Procedure  Usethis procedure to change the maximum use of the |RF segment.

Sep Action
1 Click the IRF segment with the right mouse button to access the shortcut
menu.
2 Select Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.
EDI Segment Properties
Narme ISpeciaII Kep Fieldl Displayl Loopingl

Pleaze enter the name: :
IIF!F

Flzase enter a short description :
IMWOICE REFEREMCES

0k I Cancel e[ Help

3 Select the L ooping tab.

4 In the Max Usage field, enter 1 to designate that this segment can be used
only once per invoice.

5 Click OK to exit the EDI Segment Properties dialog.
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Changing the Maximum Use of the PYT Segment

Overview  ThePYT segment contains the Settlement Terms for the invoice. In thistutorial, the PYT
segment will be used for the describing the terms of payment. The standard allows the
PY T segment to be used up to 999,999 timesin oneinvoice. In this tutorial, you will use
the PYT segment only once per invoice. You will change the maximum use of the PY T
segment to one, which will place the associated fields on the main Invoice Details frame
with the majority of the invoice fields.

Procedure  Usethis procedure to change the maximum use of the PY T segment.

Sep Action
1 Right-click the PYT segment to access the shortcut menu.
2 Select Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

3 Select the L ooping tab.

4 In the Max Usage field, enter 1 to designate that this segment can be used
only once per invoice.

5 Click OK to exit the EDI Segment Properties dial og.
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Changing the Maximum Use of the DNA Segment

Overview  The DNA segment contains the Data Narrative for the invoice. In this tutorial, the DNA
segment will be used for narrative (descriptive text) describing information that cannot be
sent in a coded form. The standard allows the DNA segment to be used up to 999,999
timesin oneinvoice. In thistutorial, you will use the DNA segment only once per invoice.
You will change the maximum use of the DNA segment to one, which will place the
associated fields on the main Invoice Details frame with the majority of the invoice fields.

Procedure  Usethis procedure to change the maximum use of the DNA segment.

Sep Action
1 Click the DNA segment with the right mouse button to access the shortcut
menu.
2 Select Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

3 Select the L ooping tab.

4 In the Max Usage field, enter 1 to designate that this segment can be used
only once per invoice.

5 Click OK to exit the Segment Properties dialog.
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Changing the Maximum Use of the ODD Group

Overview  The ODD group contains the Order and Delivery Terms information for the invoice. In
this tutorial, the ODD group will be used for information about the customer’s order
number, the date the order was placed, and the delivery number and date. The standard
allowsthe ODD group to be used up to 999,999 times per invoice (because you are
addressing only one order with thisinvoice). In this tutorial, you will use the ODD group
only once per invoice. You will change the maximum use of the ODD group to one, which
will place the associated fields on the main Invoice Details frame with the majority of the
invoice fields.

Procedure  Usethis procedure to change the maximum use of the ODD group.

Sep Action

1 Click the ODD group with the right mouse button and select Properties
from the shortcut menu.

System Response
The Group Properties dialog is displayed.

2 Select the L ooping tab.

3 Inthe Max Usage field, enter 1 to designate that this group can be used
only once per invoice.

4 Select the Display tab.

5 Click the Promote group to parent frame check box to promote this
group. Thefieldsin this group will be displayed on the same frame as the
fieldsin the parent group (INVOIC).

Note

Although this group has a maximum use of one, if you do not mark the
Promote group to parent frame check box, then the fieldsin this group will
not be displayed on the same framein the Layout Window asthefieldsin
the parent group.

6 Click OK to exit the Group Properties dialog.
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Generating the Form

Overview  Generating aform is different from compiling aform. When you compile aform, the
source form istrandated into a compiled translation object. When you generate aform,
the fields of the form are displayed on aframe in the Layout Window (right side of the
Forms main window), based on the groups, segments, and elements that are activated.

Note

You can, and should, regenerate (or refresh) the form several times as you customize and
format the form to ensure that you are viewing the most recent changes to the Layout
Window.

Procedure  Usethisprocedure to generate the print form based on the groups, segments, and elements

you activated.
Sep Action
1 Select the INVOIC fileicon. Selecting the INVOIC file icon before you

generate the layout enables you to view the beginning of the invoice
layout in the Layout Window after the layout is generated. However,
selecting the INVOIC fileicon is not arequired prerequisite to generating
the layout.
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3-37

(Contd)
Step

Action

2

Click Generate L ayout on the Main Toolbar.

System Response
The layout of the screen entry form will be displayed in the Layout

Window.
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Note

You should regenerate the form periodically as you customize the screen
entry form to ensure that the most recent changes to the frame are
reflected in the Layout Window.
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After generating  After you generate the form, thereis one field on the right side of your screen (Layout
theform  Window) for every activated element on the left side of your screen (EDI File Format
Window). You can click either thefield or its corresponding element to select it. To access
the Element Properties dialog for afield or element, either double-click the element, or
use the right mouse button to click the field or element, and then select Properties from the
shortcut menu.

Note

When you first generate the form, each field in the Layout Window is labelled with the
same name as its corresponding element in the EDI File Format Window. Asyou
customize the form, however, you will change some of the labels and remove others, so all
the fields will not be labelled the same as their corresponding elements. Even though you
will change or remove some field labels, each field still corresponds to one element.

When the screen entry form is generated, the fields associated with each non-repeating
segment or group are displayed on aframein the Layout Window. If asegment or group is
defined as repeating, then alist box is displayed on the parent frame, and the fields for that
repeating segment or group are displayed on a separate frame.

All framesin ascreen entry form are titled. The default title for each frameisits message,
group, or segment name, but you can change the default titles to better identify the
information that will be entered.
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Customize the EDI Data

Overview

I ntroduction You can customize the form, including the properties of each type of form component
(group, segment, and element).

Customizing the formis an iterative process. Thistutorial guides you through al the steps
involved in customizing the form, component by component. When you create forms, you
usually will activate the form components you need to use, customize and format the form
components, then compile the form and test the translation object (and print areport, if
necessary). As you substantially customize the form, you usually will compile and print
the form several timesto view your changes before the form truly isfinalized.

This section explains how to customize the form components for each sequential
component in thistutorial.

How to set up the  We recommend that you set up a Document Name for each form. The document name
document name  makes the identification of adocument created by the form easier in Sterling

Gentran: Server. Setting up the document name enables you to differentiate between
documentsin the document browsersin Sterling Gentran: Server. If you set up the
document name in the Forms Integration subsystem, the Name field of the document
browsers that contain this message in Sterling Gentran: Server will contain the data from
that element. You can choose any element as the document name, but we strongly
recommend that you select an element that occurs only once in the message and has a data
type of string. For aTRADACOMS ANAOO1 INVOIC release 9 invoice, the document
name usually is the Invoice Number.

Use this procedure to set up the document name.

Sep Action

1 Double-click the IRF INVN element.

System Response
The Element Properties dialog is displayed.

Recommendation

In this tutorial, we recommend that you select this element becauseitisa
non-recurring and mandatory element, and it will help identify this
message meaningfully in Sterling Gentran: Server.

2 Select the Use Sandard Rule tab.

3 Select the Update option from the drop-down list.
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(Contd)
Sep Action

4 From the Table/Group drop-down list box, select Document record to
indicate that you are updating the document record in Sterling
Gentran:Server.

5 From the Column/Field drop-down list box, select Document Name to
indicate that you are updating the Name field (in the Sterling

Gentran: Server document browsers that contain this message) with the
contents of the IRF INVN element.

The dialog now should look like this:

Element Properties

Mame | \-"alidationl Displa_l,.ll Help I Extended Fule  Standard Rule |C0nditi0ns|

Flease select the standard rule to uze : IUpdate j

Pleaze zelect the table [or group] to update :
I Document record j

Flease select the column [or field) to update ;

Clocument Name

oK I Cancel | Al Help

6 Click OK to set up the document name.
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Customizing the CLO Segment

Overview

Customizing the
CLOCLOCCLOO
element

How to createa
syntax token

The CLO segment (Customer’s Location) contains details about the specific customer
location pertaining to thisinvoice. In this tutorial, the CLO segment contains details
relating to the specific Pet Zone store you are invoicing.

The CLO CLOC CLOO0 element (Customer’s ANA Location Code) contains the code
assigned by the Article Numbering Association for the customer’s location. In this
tutorial, your userswill enter the customer’s ANA location code (which they will obtain
from the purchase order for the invoiced items).

Your trading partner, Pet Zone, uses a string of numbers for the ANA location code, so
you will create a syntax token that allows only numbersin the screen and EDI formats of
the data. Syntax tokens enable you to designate a“token” that defines ranges of characters
and/or numbers that are allowed to be used for a string-type element. The characters
defined in the syntax token are used while compliance checking each element to ensure
that the datain the element falls within the range of allowed characters.

In addition to creating a syntax token to be used for the screen and EDI formats of the
data, you will rename the field label to make it shorter and add Help text to the field.

Use this procedure to create a syntax token.

Sep Action
1 Select Syntax Tokens from the Edit menu to display the Syntax Tokens
dialog.
2 The Token column contains the value designated as the syntax token for

each existing syntax token. The Token contains arange of characters that,
when applied to an element, dictate the way that element must be
formatted. If the element is not formatted as specified, the system will
generate a compliance error.

The Allowed character ranges column contains the range(s) of characters
that are permitted for each existing syntax token. Each range consists of a
pair of charactersthat define the start and end characters.

3 Click New to access the Edit Syntax Token dialog.

4 In the Token field, enter 9 to designate the unique one-character
alphanumeric value that the system will recognize as containing the
allowed range of characters you designate.

The Character Ranges list box contains the character range or ranges that
you defined for thistoken. You can define more than one character range
for each token.
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Sep Action

5 Click New to access the Edit Character Range dialog, which enables you
to create a character range.

Note
Sterling Gentran: Server usesthe ANSI character set when determining the
start-end range.

6 In the Start character field, enter O, which is the character that begins the
alowed token range.

7 In the End character field, enter 9, which is the character that terminates
the allowed token range.

8 Click OK to exit the Edit Character Range dialog.

9 Click OK to save the syntax token and exit the Edit Syntax Token dialog.

10 Click Close to exit the Syntax Tokens dialog.

How to changethe  Usethis procedure to change the screen and EDI formats for the data, rename the field
CLOCLOCCLOO label, and add Help text to the Customer’s ANA Location Code field.

element and field

properties Step Action

1 Double-click the CLO CLOC CL OO0 e ement.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Form Format field, enter 9, which is the name of the syntax token
you just created for allowing usersto enter data with only the characters
0-9in this element.

4 In the File Format field, enter 9, which isthe name of the syntax token you
just created for allowing the EDI datato consist of only the characters 0-9
in this element.

5 Select the Display tab.

6 In the Label field, enter Location ANA Code to replace the existing field
label.

7 Select the Help tab.
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Action

8 In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the EAN location number identifying this customer’s
location. You must enter a numeric valuein thisfield.

9 Click OK to exit the dialog.
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How to customize  The CLO CLOC CLO1 element (Customer’s Own Location Code) contains the code
theCLO CLOC assigned by the customer for the location to which the invoiced items are to be delivered.
CLO1 dement In thistutorial, your users will enter the customer’s own location code (which you have
obtained from Pet Zone).

Inthistutorial, you know that Pet Zone's own location code will not exceed ten characters,
so you will change the field and element lengths to ten. In addition, you will rename the
field label and add Help text to thefield.

Use this procedure to change the field and element lengths, rename the field label, and add
Help text to the Customer’s Own Location Code field.

Step

Action

1

Double-click the CLO CLOC CLO1 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

Inthe Max field, enter 10 to allow aten-character string in this element.

Select the Display tab.

In the Label field, enter L ocation Own Code to replace the existing field
label.

In the Display Length field, enter 10 to allow ten characters to be entered
inthisfield.

Select the Help tab.

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the customer’s own location number identifying the
location to which theinvoiced items areto be delivered.
The customer’slocation number may not exceed 10
alphanumeric characters.

Click OK to exit the diaog.
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How to customize  The CLO CNAM element (Customer’s Name) contains the customer’s registered legal

the CLO CNAM name.
element

In thistutorial, you want the Customer’s Name field to be the same length as the address

fieldsthat follow (inthe CLO CADD composite), so you will change the field and element
lengths for the Customer’s Namefield to thirty-five. In addition, you will renamethefield
label and add Help text to the field.

Use this procedure to change the field and element lengths, rename the field label, and add
Help text to the Customer’s Name field.

Sep

Action

1

Double-click the CLO CNAM element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max field, enter 35 to allow athirty-five-character string in this
element.

Select the Display tab.

In the Labdl field, enter Name to replace the existing field label.

In the Display Length field, enter 35 to allow thirty-five characters to be
entered in thisfield.

Select the Help tab.

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the customer’s name. The name may not exceed 35
alphanumeric characters.

Click OK to exit the dialog.

How to customize  The CLO CADD CADO element (Customer’s Address Line 1) containsthefirst line of the
the CLO CADD customer’s address. You will rename the field label to shorten it and add Help text to this

CADOeement  field.
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Use this procedure to rename the field label and add Help text to the Customer’s Address

Line1 field.
Sep Action
1 Double-click the CLO CADD CADO € ement.

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label field, enter Address Line 1 to replace the existing field label.
4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end

of each line of text below):

Enter thefirst line of the customer’s address. Thisaddressline
may not exceed 35 alphanumeric characters.

6 Click OK to exit the dialog.
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How to customize  The CLO CADD CAD1 element (Customer’s Address Line 2) contains the second line of
theCLO CADD  thecustomer’s address. You will rename the field label to shorten it and add Help text to
CAD1element  thisfield.

Use this procedure to rename the field label and add Help text to the Customer’s Address

Line 2 field.
Sep Action

1 Double-click the CLO CADD CAD1 element.
System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label field, enter Address Line 2 to replace the existing field label.

4 In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):
Enter the second line of the customer’s address. This
addressline may not exceed 35 alphanumeric characters.

5 Click OK to exit the dialog.

How to customize  The CLO CADD CAD2 element (Customer’s Address Line 3) contains the third line of
theCLO CADD  thecustomer’s address. You will rename the field label to shorten it and add Help text to

CAD2element  thisfield.

Use this procedure to rename the field label and add Help text to the Customer’s Address

Line 3 field.
Sep Action
1 Double-click the CLO CADD CAD?2 element.

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 Inthe Label field, enter AddressLine 3 to replace the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter thethird line of the customer’s address. This address
line may not exceed 35 alphanumeric characters.
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Sep Action

6 Click OK to exit the dialog.

How to customize  The CLO CADD CADS3 eement (Customer’s Address Line 4) contains the fourth line of
theCLO CADD  thecustomer’s address. You will rename the field label to shorten it and add Help text to

CAD3eement thisfield.

Use this procedure to rename the field label and add Help text to the Customer’s Address

Line4field.
Sep Action
1 Double-click the CLO CADD CAD3 element.
System Response
The Element Properties dialog is displayed.
2 Select the Display tab.
3 Inthe Label field, enter AddressLine 4 to replace the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter thefourth line of the customer’s address. This address
line may not exceed 35 alphanumeric characters.

6 Click OK to exit the diaog.
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How to customize  The CLO CADD CAD4 element (Customer’s Post Code) contains the post code of the
theCLO CADD  customer’s address. You will rename the field label to shorten it and add Help text to this

CAD4 element  field.

Use this procedure to rename the field label and add Help text to the Customer’s Post

Codefield.

Sep

Action

1

Double-click the CLO CADD CAD4 element.

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label field, enter Post Code to replace the existing field label.

Select the Help tab.

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the post code of the customer’s address. The post
code may not exceed 8 alphanumeric characters.

Click OK to exit the dialog.

Click Generate L ayout on the Main Toolbar to refresh the display of the
screen entry form.
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Customizing the IRF Segment

Overview  The|RF segment (Invoice References) contains details about the invoice, such asthe
invoice number, invoice date, and tax-point date. This segment, and all the elements
contained in it, must be present in the invoice. You already changed the maximum use for
this segment, so that this segment will be used only once in an invoice.

How to customize  TheIRF INVN eement (Invoice Number) contains the number assigned by the supplier
the IRF INVN for thisinvoice (in this tutorial, you are the supplier). You will rename the field label to
dement shorten it and add Help text to thisfield. (You already set up this element as the document

name.)

Use this procedure to rename the field l1abel and add Help text to the Invoice Number field.

Step

Action

1

Double-click the IRF INVN element.

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Labd field, enter Invoice No. to replace the existing field label.

Select the Help tab.

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the invoice number. Theinvoice number may not
exceed 17 alphanumeric characters.

Click OK to exit the dialog.
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How to customize  ThelRFIVDT element (Date of Invoice) contains the invoice date. You will change the
theIRF IVDT screen format for the invoice date to DD/MM/Y'Y. Also, this element is defined by the
eement standard to be a six-digit date. In thistutorial, your users will enter the invoice date as an
eight-digit date, so you will change the element and field lengths to accommodate the
longer date. In addition, you will rename the field label and add Help text to thisfield.

Use this procedure to change the screen format, change the field and element lengths,
rename the field label, and add Help text to the Date of Invoice field.

Sep

Action

1

Double-click the IRF IVDT element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max field, enter 8 to allow the entire date, including separators
(/), to be contained in this element

From the Form Format drop-down list box, select DD/MM/YY toindicate
that this field on the tranglation object will accept a date entered in the
format DD/MM/Y'Y.

Select the Display tab.

In the Label field, enter I nvoice Date to replace the existing field |abel.

In the Display Length field, enter 8 to allow the entire date to be
displayed, including separators (/).

Select the Help tab.

In the Help Text list box, enter the following text:

Enter theinvoice date. Use theformat DD/MM/YY.

10

Click OK to exit the dialog.
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How to customize  ThelRF TXDT element (Tax-Point Date) contains the date on which the VAT is applied.
theIRF TXDT The tax-point date often is the same as the invoice date. You will change the screen format
eement for the tax-point date to DD/MM/Y'Y. Also, this element is defined by the standard to be a
six-digit date. In thistutorial, your users will enter the invoice date as an eight-digit date,
so you will change the element and field lengths to accommodate the longer date. In
addition, you will add Help text to thisfield.

Use this procedure to change the screen format, change the field and element lengths, and
add Help text to the Date of Invoicefield.

Sep

Action

1

Double-click the IRF TXDT element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max field, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

From the Form Format drop-down list box, select DD/MM/YY toindicate
that this field on the tranglation object will accept a date entered in the
format DD/MM/Y'Y.

Select the Display tab.

In the Display Length field, enter 8 to allow the entire date to be
displayed, including separators (/).

Select the Help tab.

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the tax-point date. Thetax-point dateisthe date the
VAT was applied. Usethe format DD/MM/YY.

Click OK to exit the dialog.
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Sep Action

10 Click Generate Layout on the Main Toolbar to refresh the display of the
screen entry form.

The Invoice Details frame now should look like this;

Lacation AN Code ] =
Location Own Code I:I

Mame | |

Address Line 1

Address Line 2

Address Line 3

Address Line 4

Post Code I:I
Inwoice Date I:I

Taw-point D ate g::E
Firzt Level Sequence Mumber l:l

Terms Of Papment |

Firzt Level Sequence Mumber l:l
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Customizing the PYT Segment

Overview  ThePYT segment (Settlement Terms) specifies the settlement terms that apply to the
invoice. You already changed the maximum use of the PY T segment to one.

How to customize  The PYT SEQA element (First Level Sequence Number) contains the sequence number
the PYT SEQA for the PYT segment. According to the standard, this number starts at one and increases
dement for each occurrence of the PY T segment. You already changed the maximum use of the

PY T segment to one (indicating that you will usethe PY T segment only once per invoice).

You will define a constant value for thisfield, designating that the constant “ONE” (which

hasavalue of “1") isawaysthe valuein the PYT SEQA element. Then, you will prevent

this field from being displayed in the screen entry form, since users will not need to enter

avauein thisfield.

Use this procedure to define a constant and hide the First Level Sequence Number field.

Sep Action

1 Double-click the PYT SEQA element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.

3 Click the Use Constant option from the drop-down list.

4 Click Edit to access the Map Constants dial og.

5 Click New to access the Edit Constant dial og.

6 Inthe D field, enter ONE to identify the constant.

7 From the Type drop-down list box, select I nteger to indicate that the

literal constant will be formatted as an integer (number) data type (not
containing decimal places).

8 In the Value field, enter 1 to indicate that the First Level Sequence
Number field must contain the value 1. This value is the actual value of
the literal constant.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dial og.
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Sep

Action

11

In the Constants drop-down list box, select 1 to identify the constant that
will be used for this element.

The dialog now should look like this:
Element Properties

Mame I ‘v‘alidatiu:unl Displayl Help | Extended Rule  Standard Rule I Eonditiunsl

Pleaze zelect the standard rule o use : ILIse Constant j

Pleasze zelect a constant to store ik this field :

2

IF thiz constant is a qualifier for another field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute thiz standard e, To
take advantage of this feature. simply zelect the field to be qualified :

=

12

Select the Display tab.

13

Click the Hidden radio button to prevent the field from being displayed in
the trangl ation object.

14

Click OK to exit the dialog.

How to customize  ThePYT PAYT element (Terms of Payment) contains the description of the settlement
thePYT PAYT  terms. You will rename the field label and add Help text to thisfield.

element

Use this procedure to rename the field label and add Help text to the Terms of Payment

field.

Step

Action

Double-click the PYT PAYT element.

System Response
The Element Properties dialog is displayed.

Select the Display tab.
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(Contd)

Sep Action
3 In the Label field, enter Payment Terms to replace the existing field
label.
4 Select the Help tab.
5 In the Help Text list box, enter the following text (press Enter at the end

of each line of text below):

Enter the payment terms. The payment terms may not exceed
40 alphanumeric characters.

6 Click OK to exit the dialog.

7 Click Generate Layout on the Main Toolbar to refresh the display of the
screen entry form.

The Invoice Details frame now should look like this:

Invoice Detailz

Lacation AN& Code ] =
Location Dwn Code I:I

Mame | |

Address Line 1

Address Line 3

| |
Address Line 2 | |
| |
Address Line 4 | |

Post Code I:I
Irvvnice Mo, I:I
Irvvnice Date I:I

T ax-point [ ate I:I

Payrnent Terrms |

First Level Sequence Number I:I

al I
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Customizing the DNA Segment

Overview  The DNA segment (Data Narrative) contains narrative (descriptive text) pertaining to the
invoice. The standard allows this segment to be used up to 999,999 timesin an invoice.
Your users will use this segment only once per segment, so you already changed the
maximum use to one.

How to customize  The DNA SEQA:2 element (First Level Sequence Number) contains the sequence number
the DNA SEQA:2  for the DNA segment. According to the standard, this number starts at one and increases
dement for each occurrence of the DNA segment. You already changed the maximum use of the
DNA segment to one (indicating that you will use the DNA segment only once per
invoice). You will use the constant “ONE” (which hasavaue of “1"), sothat “1” is
awaysthe value in the DNA SEQA:2 element. Then, you will prevent thisfield from
being displayed in the screen entry form, since users will not need to enter avalue in this

field.
Sep Action

1 Double-click the DNA SEQA:2 element.
System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.

3 Select the Use Constant option from the drop-down list.

4 In the Constants drop-down list box, select 1 to identify the constant that
will be used for this element.

5 Select the Display tab.

6 Click the Hidden radio button to prevent the field from being displayed in
the trandlation object.

7 Click OK to exit the dialog.
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How to customize  The DNA GNAR GNAO element (General Narrative Line 1) contains descriptive text
the DNA GNAR pertaining to the invoice. Users can enter up to four lines (each with up to forty characters)
GNAO e ement of descriptive text. For thistutorial, you will rename the field label Invoice Notes and add
Help text to thisfield.

Use this procedure to rename the field label and add Help text to the General Narrative

Line 1 field.
Sep Action

1 Double-click the DNA GNAR GNAO element.
System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label field, enter I nvoice Notes to replace the existing field 1abel.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):
Enter thefirst line of the invoice notes. The invoice notes
consist of descriptivetext that pertainsto the entireinvoice.
Thisline of invoice notes may not exceed 40 alphanumeric
characters.

6 Click OK to exit the dialog.

How to customize  The DNA GNAR GNA1 element (General Narrative Line 2) contains the second line of
the DNA GNAR descriptive text pertaining to the invoice. Users can enter up to four lines (each with up to
GNA1 dement forty characters) of descriptive text. For thistutorial, only thefirst line of descriptive text
(General Narrative Line 1) will be labelled. Therefore, you will remove the field label for
the General Narrative Line 2 field and add Help text to thisfield.

Use this procedure to remove the field label and add Help text to the General Narrative

Line 2 field.
Sep Action
1 Double-click the DNA GNAR GNA1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 Inthe Label field, delete the existing field |abel.
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Sep

Action

Select the Help tab.

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the second line of theinvoice notes. Theinvoice
notes consist of descriptive text that pertainsto the entire
invoice. Thisline of invoice notes may not exceed 40
alphanumeric characters.

Click OK to exit the diaog.

How to customize  The DNA GNAR GNAZ2 element (General Narrative Line 3) contains the third line of
the DNA GNAR descriptive text pertaining to the invoice. Users can enter up to four lines (each with up to
GNA2 element forty characters) of descriptive text. For thistutorial, only the first line of descriptive text
(Genera Narrative Line 1) will be labelled. Therefore, you will remove the field label for
the General Narrative Line 3 field and add Help text to thisfield.

Use this procedure to remove the field label and add Help text to the General Narrative

Line 3 field.

Sep

Action

1

Double-click the DNA GNAR GNA2 element.

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label field, delete the existing field label.

Select the Help tab.

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter thethird line of the invoice notes. Theinvoice
notes consist of descriptive text that pertainsto the entire
invoice. Thisline of invoice notes may not exceed 40
alphanumeric characters.

Click OK to exit the dialog.
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How to customize  The DNA GNAR GNA3 element (General Narrative Line 4) contains the fourth line of
the DNA GNAR descriptive text pertaining to the invoice. Users can enter up to four lines (each with up to
GNA3 dlement forty characters) of descriptive text. For thistutorial, only the first line of descriptive text
(Genera Narrative Line 1) will be labelled. Therefore, you will remove the field label for
the General Narrative Line 4 field and add Help text to thisfield.

Use this procedure to remove the field label and add Help text to the General Narrative

Line 4 field.
Sep Action
1 Double-click the DNA GNAR GNA3 element.

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label field, delete the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end

of each line of text below):

Enter thefourth line of the invoice notes. The invoice
notes consist of descriptive text that pertainsto the entire
invoice. Thisline of invoice notes may not exceed 40
alphanumeric characters.

6 Click OK to exit the dialog.

7 Click Generate L ayout on the Main Toolbar to refresh the display of the
screen entry form.
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Customizing the ODD Group

Overview  The ODD group contains the Order and Delivery Terms information for the invoice. In
this tutorial, the ODD group will be used for information about the customer’s order
number, the date the order was placed, and the delivery number and date. The standard
allowsthe ODD group to be used up to 999,999 times per invoice. In thistutorial, you will
use the ODD group only once per invoice. You already changed the maximum use of the
ODD group to one, which placed the associated fields on the main Invoice Details frame
with the majority of the invoice fields.

How to customize  TheODD:2 SEQA element (First Level Sequence Number) contains the sequence number
the ODD:2 SEQA for the ODD:2 segment. According to the standard, this number starts at one and increases
dement for each occurrence of the ODD:2 segment. The ODD:2 segment has a maximum use of
only one, so the value in the ODD:2 SEQA element will awaysbe“1”. You will use the
constant “ONE” (which hasavaue of “1"), so that “1” is aways the value in the ODD:2
SEQA:2 element. Then, you will prevent this field from being displayed in the screen
entry form, since users will not need to enter avaluein thisfield.

Sep Action

1 Double-click the ODD:2 SEQA element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.

3 Select the Use Constant option from the drop-down list.
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Sep Action

4 From the Constants drop-down list box, select 1 to identify the constant
that will be used for this element.

The dialog now should look like this:

Element Properties [ x|

Name | Walidation | Display | Help | Extended Rule  Standard Ruls |Conditions|

Pleaze select the standard ule to uze IUse Constant j
Pleaze zelect a constant to store in thiz fisld :

Edt. |

IF this constant iz a qualifier for anather field, Gentran can automatically uze the
existence of data in that field to determine whether to execute thiz standard rle. To
take advantage of thiz feature, simply zelect the field to be qualified :

QK I Cancel | Al | Help |

5 Select the Display tab.

6 Click the Hidden radio button to prevent the field from being displayed in
the trand ation object.

7 Click OK to exit the diaog.
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How to customize  The ODD:2 ORNO ORNO element (Customer’s Order Number) contains the number
the ODD:2 ORNO assigned by the customer to identify the order. You will rename the field label and add
ORNO e ement Help text to thisfield.

Use this procedure to change the field label for the Customer’s Order Number field.

Sep Action

1 Double-click the ODD:2 ORNO ORNO element.

System Response
The Element Properties dialog is displayed.
Element Properties E

Narne I‘v"alidationl Displa_l,.ll Help I Extended Hulel Standard Hulel Conditionsl

Fleaze enter the name :
IDHND

Fleasze enter a short description :
CUSTOMER'S ORDER MUMEBER

Ok I Cancel Spply Help
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Sep

Action

2

Click Display to access the Display Properties dialog.

Element Properties

MHame I Walidation Display | Help I Extended Flulel Standard Hulel Conditionsl

Hawe zhaould this field be uzed on the form :

O Il

" the field should be displayed but not editable
€ the field should nat appear on the form

Please enter the label for this field :

IEustomer's Order Mumber

Pleaze enter the marimum number of characters to be displayed ; I'I T

Please enter the initial value of this field :

K I Cancel | Al | Help |

In the Label field, enter Customer’s P.O. No. to replace the existing field
label.

Select the Help tab.

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the customer’s purchase order number. The purchase
order number may not exceed 17 alphanumeric characters.

Click OK to exit the dialog.
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How to customize  The ODD:2 ORNO ORN2 element (Date Order Placed by Customer) contains the date on
theODD:2 ORNQO  which the customer placed the purchase order. You will change the screen format for the
ORN2 element purchase order date to DD/MM/Y'Y. Also, this element is defined by the standard to be a
six-digit date. In thistutorial, the purchase order date will be printed as an eight-digit date,
so you will change the element and field lengths to accommodate the longer date. For
brevity, you will change the field label to PO. Date.

Use this procedure to change the screen format, change the element and field lengths, and
rename the field label for the Date Order Placed by Customer field.

Sep

Action

1

Double-click the ODD:2 ORNO ORNZ2 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max field, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

From the Form Format drop-down list box, select DD/MM/YY toindicate
that this field on the tranglation object will accept a date entered in the
format DD/MM/Y'Y.

Select the Display tab.

In the Label field, enter P.O. Date to replace the existing field label.

In the Display Length field, enter 8 to allow the entire date, including
separators (/), to be displayed.

Select the Help tab.

In the Help Text list box, enter the following text:

Enter the purchase order date. Usethe format DD/MM/YY.

10

Click OK to exit the diaog.
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How to customize  The ODD:2 DELN DELO element (Delivery Note Number) contains the number
the ODD:2 DELN corresponding to the delivery note. The only customizing you will perform for thisfieldis
DELO element adding Help text.

Use this procedure to add Help text to the Delivery Note Number field.

Sep Action

1 Double-click the ODD:2 DELN DEL 0 element.

System Response
The Element Properties dialog is displayed.

2 Select the Help tab.

3 In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the number corresponding to the delivery note. The
delivery note number may not exceed 17 alphanumeric
characters.

4 Click OK to exit the diaog.

How to customize  The ODD:2 DELN DEL 1 element (Date of Despatch by Supplier) contains the date on
theODD:2 DELN which the order was delivered. You will change the screen format for the delivery date to
DEL 1 element DD/MM/YY. Also, this element is defined by the standard to be a six-digit date. In this
tutorial, the delivery date will be printed as an eight-digit date, so you will change the
element and field lengths to accommodate the longer date. For brevity, you will change
the field label to PO. Date.

Use this procedure to change the screen format, change the element and field lengths, and
rename the field label for the Date of Despatch by Supplier field.

Sep Action

1 Double-click the ODD:2 DELN DEL 1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max field, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

4 From the Screen Format drop-down list box, select DD/MM/YY to
indicate that this field on the trandation object will accept a date entered
in the format DD/MM/Y'Y.

5 Select the Display tab.
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Sep Action

6 In the Labd field, enter Delivery Date to replace the existing field label.

7 In the Display Length field, enter 8 to allow the entire date, including
separators (/), to be displayed.

8 Select the Help tab.

9 In the Help Text list box, enter the following text:

Enter the déelivery date. Use the format DD/MM/YY.

10 Click OK to exit the dialog.
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Customizingthe LD Group

Overview  ThelLD group (Invoice Line Details) contains the line item detail for each item invoiced.
The standard allows the ILD group to be used up to 999,999 times per invoice.

The fields associated with the ILD group are arranged on the I1d frame, which is separate
from the Invoice Details frame that you have been working with thus far in this tutorial.
Your userswill completethefields on the Ild frame for each item in theinvoice. Thelist of
al lineitemsin the invoice will be displayed in alist box on the Invoice Details frame. In
that list box, the invoiced items will be displayed line by line, forming columns of

information.

Procedure  Usethisprocedureto renamethe LD frameand list box, provide adescription for the ILD
group, and add Help text to the line items list box.

Step

Action

1

Click the IL D group with the right mouse button to access the shortcut
menu.

Select Properties from the shortcut menu.

System Response
The Group Properties dialog is displayed.
Group Properties

MName | Displa_l,JI Loopingl Laoop Extended Flulesl

Please enter the name :
IILD

Please enter a short description :

(1] 4 I Cancel | Aopl | Help |

In the Desc field, enter Line [tems to describe the group.

Select the Display tab.

In the Frame Caption field, enter Line [tems to rename the frame.
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Sep

Action

6

In the List Caption field, enter Line Itemsto rename the list box that is
displayed on the Invoice Details frame (listing the line items entered on
the Line Items frame).

In the Frame Help Text list box, enter the following text (press Enter at
the end of each line of text below):

Thisframe containslineitem detail
information. For online Help on an
individual field on thisframe, select the
field and pressF1.

In the Listbox Help Text list box, enter the following text (press Enter at
the end of each line of text below):

Thislist box containsthelineitem detail for
theinvoice. Thedatain thislist box is
entered or changed on theLine ltems
frame. To enter anew lineitem, click the
list box and click New. To modify an
existing lineitem, click that item and click
Open.

Click OK to exit the Group Properties dialog.
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Customizing the ILD:2 Segment

Overview  ThelLD:2 segment (Invoice Line Details) contains the line item detail for each item
invoiced. For some of the elementsin the ILD:2 segment, you only need to add Help text
and rename the field labels so they more accurately reflect your company’s needs. With
other elements, you will change the maximum lengths for some of the fields, use
accumulators to calculate the number of lineitems, or define a constant value.

The ILD:2 group is subordinate to the Invoice Details frame, so Sterling Gentran: Server
creates a separate frame (the Line Items frame) to contain the group data (the line item
details). The system also creates alist box (the Line Items list box) on the Invoice Details
frameto allow the user to accessthe itemsin the list box. Each set of dataisdisplayed asa
row in the list box. After you customize the line item fields, the Line Items list box will
contain these four columns of data: Item, Product, Qty, and Price.
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How to customize  ThellLD:2 SEQA element (First Level Sequence Number) contains the sequence number
thelLD:2 SEQA for the ODD group (the parent group in which the ILD:2 SEQA element resides).
dement  According to the standard, this number starts at one and increases for each occurrence of
the ODD group. The ODD group has a maximum use of only one, so the value in the
ILD:2 SEQA element will alwaysbe“1”. You will use the constant “ONE” (which hasa
valueof “1"), sothat “1” isalwaysthevalueinthe ILD:2 SEQA:2 element. Then, you will
prevent thisfield from being displayed in the screen entry form, since users will not need
to enter avaluein thisfield.

Use this procedure to use a constant and hide the First Level Sequence Number field.

Step

Action

1

Double-click the ILD:2 SEQA element.

System Response
The Element Properties dialog is displayed.

Element Properties
Extended Rule | Standard Rule I Conditions |
Narne | Validation I Digplay I Summary List I Help

Pleaze enter the name :
ISEE!!-\

Flease enter a thart description |
FIRST LEVEL SEQUEMCE MWUMBER

ok I Cancel | Aoply Help

Select the Use Sandard Rule tab.

Select the Use Constant option.

From the Constants drop-down list box, select 1 to identify the constant
that will be used for this element.

Select the Display tab.

Click the Hidden radio button to prevent the field from being displayed in
the translation object.

Click OK to exit the dialog.
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Customizingthe  ThelLD:2 SEQB element (Second Level Sequence No.) contains the second-level
ILD:2SEQB  sequence number for the ILD:2 segment in the ILD group (the subordinate group in which
eement the ILD:2 SEQB element resides). According to the standard, this number starts at one and

increases for each occurrence of the ILD group. You will use the Loop Count function to
obtain the value of the current loop count, and then you will make this field display-only
(since the users will not need to enter avalue in thisfield). Also, since the valuein this
field reflects the sequential number for each lineitem, you will renamethefield label Item
No.

You will create alist box definition for this element to include the item number in the list
box. Also, you know that your users will enter no more than 99,999 line items per invoice.
Each line item will be numbered sequentially, starting with one, so you need a maximum
length of only five digits for thisfield. You will change the field and element lengths for
thisfield to five.

Use this procedure to rename the field label, change the field and element lengths, add
Help text, and create the list box definition for the Second Level Sequence No. field.

Sep Action

1 Double-click the ILD:2 SEQB element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max field, enter 5 to allow afive-digit number in this element.
4 Select the Use Standard Rule tab.

5 Select the L oop Count option from the drop-down list.

6 In the Groups drop-down list box, select IL D to identify the loop for

which you want to obtain the current value of the loop count. The ILD
group is a nested group (the ODD group is the parent group of the ILD

group).

7 Select the Display tab.

8 In the Display section, click the Display radio button to make thisfield
display-only.

9 In the Label field, enter I1tem No. to replace the existing field label

10 In the Display Length field, enter 5 to allow five numeric digitsto be

displayed in the field.

11 Select the Summary List tab.
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Sep

Action

12

Select the Display thisfield in summary list check box to turn this
option on. Thevaluein the Item No. field will be displayed in acolumnin
the Line Items ist box.

13

In the Column Width field, enter 8 to set the width of this column in the
Line Items list box.

Note

The column width should be wider than the actual content of the column.
The extra space that is not used for the content of the column will provide
white space separating the columns. If the width for each columnisthe
exact width of the data, then there will not be space separating the
columns of data.

14

From the Sequence drop-down list box, select 1 to indicate that thisfield
will be thefirst columnin the list box.

15

Click OK to exit the diaog.

How to customize  ThelLD:2 SPRO SPRO element (EAN-13 Code for the Traded Unit) contains the number
thelLD:2 SPRO of the thirteen-digit European Article Number allocated to the unit of trade (the invoiced
SPRO element item). In thistutorial, you will rename the field label to shorten it and add Help text to this

field.

Use this procedure to rename the field label and add Help text to the EAN-13 Code for the
Traded Unit field.

Sep

Action

1

Double-click the ILD:2 SPRO SPRO element.

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label field, enter EAN Code to replace the existing field label.

Select the Help tab.

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the EAN codefor theinvoiced item. The EAN code
must be exactly 13 alphanumeric characterslong.

Click OK to exit the dialog.
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How to customize  ThelLD:2 SPRO SPR1 element (Supplier’s Code for the Traded Unit) contains the
thelLD:2 SPRO  supplier'sinternal reference identifying the invoiced item (in thistutorial, your company
SPR1 element isthe supplier). You will rename the field label and add Help text to thisfield.

Also, you will create alist box definition for this element to include the supplier’s product
codeinthe Line Itemslist box on the Invoice Details frame.

Use this procedure to rename the field label, add Help text, and create the list box
definition for the Supplier’s Code for the Traded Unit field.

Sep

Action

1

Double-click the ILD:2 SPRO SPR1 element.

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label field, enter Supplier’s Product Code to replace the existing
field label.

Select the Summary List tab.

Click the Display thisfield in summary list check box to turn this option
on. Thevaluein the Supplier’s Product Code field will be displayed in a
column in the Line Items list box.

In the Column Width field, enter 33 to set the width of this column in the
Line Items list box.

Note

The column width should be wider than the actual content of the column.
The extra space that is not used for the content of the column will provide
white space separating the columns. If the width for each columnisthe
exact width of the data, then there will not be space separating the
columns of data.

From the Sequence drop-down list box, select 2 to indicate that thisfield
will be the second column in the list box.

Select the Help tab.

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the supplier’s product code for theinvoiced item. The
product code may not exceed 30 alphanumeric characters.

10

Click OK to exit the dialog.
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How to customize  ThelLD:2 CPRO CPR1 element (Customer’s Item Code) contains the customer’sinternal
thelLD:2 CPRO reference identifying the invoiced item. Your users can obtain this information from the
CPR1 dement customer’s purchase order. In this tutorial, you will rename the field label and add Help
text to thisfield.

Use this procedure to rename the field label and add Help text to the Customer’s Item

Codefield.
Sep Action

1 Double-click the ILD:2 CPRO CPR1 element.
System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 Inthe Label field, enter Customer’s Product Codeto replace the existing
field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):
Enter the customer’s product code for theinvoiced item. The
code may not exceed 30 alphanumeric characters.

6 Click OK to exit the dialog.

How to customize  ThelLD:2QTYI QTYO0 element (Number of Order Units Invoiced) contains the quantity
thelLD:2QTYI  of invoiced itemsfor thislineitem. You will create alist box definition for this element to
QTYO0 element include the quantity invoiced in the list box on the Invoice Details frame. For brevity, you
will rename the field label. Also, the standard defines thisfield as a string data type, and
allows up to fifteen alphanumeric charactersin this element. However, your users will
enter number-type datain NO format (formatted with an implicit decimal point and no
decimal places). Therefore, you will change the data type and the screen and EDI formats
to reflect the data your users will enter.

In addition, your users will enter quantities no greater than five digits (e.g. 99,999). You
will change the field and element lengths to reflect the smaller datalength. Then, you will
add Help text to thisfield.
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Use this procedure to change the data type and screen and EDI formats, rename the field
label, change the field and element lengths, add Help text, and create thelist box definition
for the Number of Order Units Invoiced field.

Sep

Action

1

Double-click the ILD:2 QTYI QTYO0 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max field, enter 5 to allow afive-digit number in this element.

From the Data Type drop-down list box, select Number to alow a
number data type in this element. Sterling Gentran: Server prompts you
that changing the field's data type will invalidate its format.

Click Yesto proceed with modifying the properties of this element.

From the Form Format drop-down list box, select NO to indicate that this
field will accept a number with an implied decimal point and no decimal
places.

From the File Format drop-down list box, select NO to format the EDI
datawith an implied decimal point and no decimal places.

Select the Display tab.

In the Label field, enter Quantity to replace the existing field label.

10

In the Display Length field, enter 5 to allow five numeric digits to be
displayed in the field.

11

Select the Summary List tab.

12

Click the Display thisfield in summary list check box to turn this option
on. The value in the Quantity field will be displayed in a column in the
Line Items list box on the Invoice Details frame.

13

In the Column Width field, enter 8 to set the width of this column in the
Line Items list box.

Note

The column width should be wider than the actual content of the column.
The extra space that is not used for the content of the column will provide
white space separating the columns. If the width for each columnisthe
exact width of the data, then there will not be space separating the
columns of data.

14

From the Sequence drop-down list box, select 3 to indicate that thisfield
will be the third column in the list box.
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Sep

Action

15

In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Enter the quantity of thisinvoiced item. The quantity may not
exceed 5 digits.

16

Click OK to exit the dialog.

How to customize  ThelLD:2 QTYI CDO04:2 element (Measure Indicator) contains the abbreviation for the
thelLD:2QTYI measure of theinvoiced item (e.g. kilometres, metres, litres). You want all the available
CDO04: 2 dement codes from Code Values List 4 to be available to your screen entry users, so you will load
the entire code list. Loading the code list in this element causes a drop-down list box to be
displayed on the Invoice Details frame (instead of afield). Userswill select an appropriate
code from the list box, instead of entered avalue in the field.

After you specify the code list table to use for the drop-down list box for the Measure
Indicator field, you will rename the field label and add Help text to the field.

Use this procedure to load Code Values List 4 from the standard, rename the field label,
and add Help text to the Measure Indicator field.

Step

Action

1

Double-click the ILD:2 QTYI CD04:2 element.

System Response
The Element Properties dialog is displayed.

Select the Sandard Rule tab.

Select the Use Code option.

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



(Contd)
Sep

Action

4

Click Edit to access the Edit Code List dialog.

Edit Code List
r— Table Detail

TablelD [CDO4 Desc |MEASURE INDICATOR i
—&llowed Codes Cancel
Code Value Description

Mew
Change...
Delete

Laoad

Flel

The Table ID field contains CD04, the name of the el ement for which this
code list table will be used. The Desc field contains “Measure Indicator”,
the description of the element for which this code list table will be used.

Click L oad to accessthe Load Code List dialog. You will be prompted to
select an ODBC data source name. Select the appropriate DSN and click
OK to accessthe Load Code List dialog. The Codes In Standard list box
contains the entire code list.

Load Code List
~ Select Code Source
Standard [&/4NA001/5 =] st [coos =]
Cancel |

~ Select Codes

Codes Ih Standard Codes Selected
1 1..5INGLE EDNSLiiI

100 100 SIMGLE CONS; Add - |
1000 1000 SINGLE COME

Chd CEMTIMETRE

Ch2 SOHUARE CEMTIME Add Al - |

CM3  CUBIC CENTIMETF

CUFT  CURIT FOOT )

CUIM_ CLEIC INCH _l;l ﬂl
»

4

KN 2

Click Add All to move all of the codes in the code list table to the Codes
Selected list box.

Note

Adding all the codesin thelist (by using Add All) creates a much larger
form than if you use only selected codes. However, it is necessary for your
usersto have al the codes available from which to choose.
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(Contd)

Sep Action
7 Click OK to load the code list table and exit the Load Code List dialog.
8 Click Close to exit the Edit Code List dialog.
9 Click the Raise a compliance error check box to specify that, for

compliance reasons, the element must contain one of the codes from Code
Vaues List 4 (nothing elseisvalid for that element).

10 Select the Display tab.

11 In the Label field, enter Unit of M easur e to replace the existing field
label.

12 Select the Help tab.

13 In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Select the unit of measure for thisinvoiced item from the
drop-down list box.

14 Click OK to exit the dialog.

How to customize  ThelLD:2 AUCT AUCO element (Cost Price (Excluding VAT)) contains the price per unit
thelLD:2 AUCT invoiced. This price isthe cost in pounds before line discounts and VAT have been
AUCO e ement applied. The EDI datawill be formatted in N4 format (formatted with an implicit decimal
point and four decimal places), but your users will enter the price in the translation object
in R4 format (formatted with an explicit decimal point). Therefore, you will change the
screen format to reflect how you want the price to be entered in the translation object.

You will create alist box definition for this element to include the unit pricein the list box
on the Invoice Details frame. Also, you will rename the field label and add Help text to
thisfield.

Use this procedure to change the screen format, rename the field label, add Help text, and
create the list box definition for the Cost Price (Excluding VAT) field.

Sep Action

1 Double-click thelLD:2 AUCT AUCO e ement.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.
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Action

3 From the Form Format drop-down list box, select R4 to indicate that this
field will accept a number with an explicit decimal point and up to four
decimal places.

4 Select the Display tab.

5 Inthe Label field, enter Unit Price (Ex. VAT) to replace the existing field
label.

6 Select the Summary List tab.

7 Click the Display thisfield in summary list check box to turn this option

on. Thevalue in the Unit Price (Ex. VAT) field will be displayedin a
column in the Line Items list box on the Invoice Details frame.

8 In the Column Width field, enter 14 to set the width of this column in the
Line Items list box.

Note

You do not need to make the column width for thisfield wider than the
actual content of the column. The datafrom thisfield will form the last
column in the list box, and you do not need to leave white space between
the last column and the side of the list box.

9 From the Sequence drop-down list box, select 4 to indicate that thisfield
will be the third column in the list box.

10 Select the Help tab.

11 In the Help Text list box, enter the following text:

Enter the unit pricefor thisinvoiced item.

12 Click OK to exit the diaog.

Sterling Gentran:Server — May 2011 Forms Integration TRADACOMS Tutorial Guide



How to customize
thelLD:2LEXC
element

The ILD:2 LEXC element (Extended Line Cost (Excluding VAT)) contains the price per
unit invoiced, after any line discounts have been applied. This price isthe net cost in
pounds (e.g. after deducting line discounts, etc., but before the application of VAT). The
EDI datawill be formatted in N4 format (formatted with an implicit decimal point and
four decimal places), but your users will enter the price in the translation object in R4
format (formatted with an explicit decimal point). Therefore, you will change the screen
format to reflect how you want the price to be formatted in the translation object.

Also, you will prevent thisfield from being displayed in the trandlation object. The
extended line cost will be cal culated automatically when users click STORE on the Line
Items frame when they use thistranslation object in Sterling Gentran: Server. You can hide
thisfield because users will not need to enter the value in the field.

Use this procedure to change the screen format for the Extended Line Cost (Excluding
VAT) field, and prevent thisfield from being displayed.

Sep Action

1 Double-click the ILD:2 LEXC element.

System Response
The Element Properties dialog is displayed.

Element Properties
Extended Rule I Standard Rula I Conditions I
Name | Walidation I Dizplay I Summary List | Help

Pleaze enter the name :

||_E><|:

Please enter a short description :
EXTEMDED LIME COST [EXCLUDIMG

QK. I Cancel ppli Help

2 Select the Validation tab.

3 From the Form Format drop-down list box, select R4 to indicate that this
field will accept a number with an explicit decimal point and up to four
decimal places.

4 Select the Display tab.
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(Contd)
Sep

Action

5

Click the Hidden radio button to prevent this field from being displayed
in the translation object.

Click OK to exit the dialog.

How to calculate  You want to automate the calculation that results in the extended price for each lineitem,
the extended price  so that the screen entry users who use your invoice translation object do not have to
perform this calculation manually. A simple way to perform this calculation isto use an
extended rule to define the operation in the ILD group. You define extended rule with the
Sterling Gentran: Server proprietary programming language, which givesyou accessto the
entire Sterling Gentran: Server internal storage area.

Use this procedure to define an extended rule to calculate the extended price.

Step

Action

1

Click the IL D group (in the ODD group) with the right mouse button to
access the shortcut menu.

Select Extended Rules from the shortcut menu.

System Response
The Loop Level Extended Rules dialog is displayed.

Click the On Store radio button to indicate that you want the rule to be
executed when you store a group.

In the Editor list box, enter the following extended rule:
#LEXC =#QTYO0 * #AUCQ;

This extended rule means that the value of the ILD:2 LEXC field is equal
to the product of the valuesinthe ILD:2 QTYI QTYOand ILD:2 AUCT
AUCO fields. In other words, the quantity invoiced for one line item,
multiplied by the price (excluding VAT) for each unit invoiced, equals the
extended price (excluding VAT).

Click Compile to compile the extended rule and verify that this rule does
not cause errors or warnings.

If you receive any errors or warnings when you compile the rule, verify
that you entered the rule exactly asit iswritten in step 4 above. After you
make any change to the extended rule to correct it, click Compile again.
Repeat this process until there are no errors generated.

Click OK to add the extended rule to the form and exit the Loop Level
Extended Rules dialog.
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How to customize  ThellLD:2 CD12 element (VAT Rate Category Code) contains the code from Codes
thelLD:2CD12 VauesList 12to designate the VAT rate category for thisinvoiced item (e.g. standard rate,
eement exemption from VAT, higher rate, etc.). You will use a Select standard rule on the VAT
Rate Category Code field, but first you need to create atemporary VATP element.

Sterling Gentran: Server enables you to use selected information from the Sterling
Gentran: Server partner database in your forms viaa Select standard rule. You can map
information from your trading partner’s profile in the Partner Editor to a selected element
in the form. The information that you can use in the form includes any fieldsin atable
(location, lookup, or cross-reference) or data from the partner record.

For thisform, you need to map the appropriate VAT rate based on the codein the ILD:2
CD12 element from alookup table, to look up data that you will map (viaa standard rule)
to the temporary VATP_TEMP field that you create. When you use tables, you must
decide whether to create a code tablein Sterling Gentran: Server that can be used only with
thisform, or to add the table to either the partner relationship or theinternal system partner
in Partner Editor. In thistutorial, you will set up the table you use under the internal
system partner (Internal System User) so the table can be used globally.

In thistutorial, you need to extract information from alookup table and insert it into the
form. A lookup table is used when you want to supplement data beforeit is sent to your
partner.

Reference
See the IBM Serling Gentran: Server® for Microsoft Windows User Guide for more
information on lookup tables.

Note
You do not need to create this lookup table (INVATCO.LKP). It isincluded with the
tutorial data that is provided when you install Sterling Gentran:Server.

After you use the Select function, all the available codes from the selected table will be
available in adrop-down list box (instead of afield) on the Invoice Details frame. Users
will select an appropriate code from the drop-down list box, instead of entered avaluein
thefield.

In addition to using the Select function, you will rename the field label and add Help text
to thefield.
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Howtocreatea  Usethis procedureto create atemporary VATP element.

temporary VATP
element Sep Action
1 Select the ILD:2 VATP element.
2 Click Copy on the Main Toolbar.
3 Select the ILD:2 SCRF composite, which is the last form component in

the ILD:2 segment. The ILD:2 SCRF composite is the composite after
which you want the ILD:2 VATP element to be pasted.

4 Click Paste on the Main Toolbar to paste the ILD:2 VATP element.

System Response

Sterling Gentran: Server prompts you to specify whether you want the
contents of the Clipboard pasted as a child (subordinate) of the selected
composite, or at the same level as the composite.

5 Click the Paste after selected item (at the same level) radio button to
paste the Clipboard contents after the ILD:2 SCRF composite. A new
element (ILD:2 VATP:2) iscreated. The ILD:2 VATP:2 lement isan

exact copy of the ILD:2 VATP element.

6 Click OK to exit the dialog.

Note
You should rename the ILD:2 VATP:2 element to give it amore
descriptive name.

7 Double-click the ILD:2 VATP:2 element.

System Response
The Element Properties dialog is displayed.

8 In the Name field, enter VATP_TEMP to replace the existing field label.

9 Click OK to exit the Element Properties dialog. The ILD:2 VATP:2
element isrenamed ILD:2 VATP_TEMP.

How to changethe  Usethis procedure to use the Select function, rename the field label, and add Help text to
ILD:2CD12  the VAT Rate Category Code field.

element and field

properties

Sep Action

1 Double-click theILD:2 CD12 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
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(Contd)
Sep

Action

3

Select the Select option.

4

In the Table drop-down list box, select Division lookup. You are using the
Division lookup because the VAT codes do not vary on a partner-by-
partner basis, so you can use the Internal System User partner and map
from any field on the Lookup Entry dialog (in Partner Editor in Sterling
Gentran:Server). You will be able to set up the lookup only once,
regardless of the number of partners with which you will use this
translation object.

In the Sub Table field, enter VAT CODES, which is the name of the table
name for the Internal System User partner that you will import.

In the Map From list box, select Text 1, which isthefield on the Lookup
Entry dialog in Partner Editor from which the contents will be mapped.

In the Map To list box, select VATP_TEM P, which is the temporary
VATP element you just created. The system will map the value from
Partner Editor to the VATP_TEMP element.

The dialog now should look like this:

Element Properties E
MHame I Walidation | Dizsplay | Summary List I Help
Extended Rule Standard Rule | Conditions
Please zelact the standard rule bo uze ISeIect j

Pleaze choose the table and key [or group] to uze when zelecting data

I Drivizion lookup j
Please enter the name of the sub-table to uze [if appropriate] :

|VATCDDES

[™ Raize a compliance ermar if matching data iz nat found

“Y'ou can map the data that waz selected. Click on data in the left ligt then click the
fields in the right list that you would like it to be mapped to. Repeat ta map maore data.

ATv0MNUMBER OF ORDER UNITS;'
CD04:2 MEASURE INDICATOR
AUCOCOST PRICE [EXCLUDING

[tenn

Teut 2 LEXC EXTEMDED LIME COST [EXC
Text 3 CO12WAT RATE CATEGORY CODI
Text 4 WATP VAT RATE PERCENTAGE

TDEO TRADED LIMIT DESCR. LIM
iaTE TEMP VAT HATE FERLEN Tid

0k I Cancel | Lpply | Help |

Select the Display tab.

In the Labd field, enter VAT Code to replace the existing field label.

10

Select the Help tab.
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Sep Action

11 In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):

Select the VAT code for thisinvoiced item from the
drop-down list box.

12 Click OK to exit the dialog.

How to customize  ThelLD:2 VATP element (VAT Rate Percentage) contains the percentage rate for the VAT
thelLD:2 VATP category code. Screen entry translation object users will not need to enter avalue in this
dement field because Sterling Gentran: Server will 1ook up the percentage in the VATCODES table
in Partner Editor and place the result in the ILD:2 VATP element automatically. You will
prevent the ILD:2 VATP element from being displayed on the translation object.

Use this procedure to hide the VAT Rate Percentage field.

Sep Action

1 Double-click the ILD:2 VATP element.

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 Click the Hidden radio button to prevent the field from being displayed in
the trand ation object.

4 Click OK to exit the dialog.

How to customize  ThelLD:2 VATP_TEMP element (VAT Rate Percentage) is the temporary element you
thelLD:2 created to map the VAT rate percentage in the VATCODES division lookup table. To map
VATP TEMP  fromthe partner database to the VATP_TEMP field, the target field (VATP_TEMP) needs
dement  tobeastring-type element. You will usethe ILD:2 VATP_TEMP element to convert the

VAT rate percentage (a string) into areal number (the datatype required in the ILD:2
VATP field). For compliance reasons, you cannot change the datatypein the ILD:2 VATP
element; therefore, you created the ILD:2 VATP_TEMP element, whose data type you
may change.

The system will be able to ook up the VAT rate percentage (a string data type) in the
VATCODES table, and map the string to the ILD:2 VATP_TEMP element. Later, you will
add an extended rule to the ILD group to convert the string in the ILD:2 VATP_TEMP
element to a number in the ILD:2 VATP element, then remove all datafrom the ILD:2
VATP_TEMP element (so that element is empty). After having executed these functions,
the system will have converted a string data type to areal number, maintaining the
integrity of the data and the compliance of the invoice.
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Use this procedure to hide the VAT Rate Percentage field and change the data type for this

field to string.

Step

Action

1

Double-click the ILD:2 VATP_TEMP element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

Click the Mandatory check box to make this element conditional.

In the Min field, enter O for the minimum number of digits allowed for
this element.

From the Data Type drop-down list box, select Sring to allow astring
datatypein this element. Sterling Gentran:Server prompts you that
changing the field’'s data type will invalidate its format.

Click Yesto proceed with modifying the properties of this element.

Select the Display tab.

Click the Hidden radio button to prevent the field from being displayed in
the translation object.

Click OK to exit the dialog.

How to convert You created the ILD:2 VATP_TEMP element as atemporary element for converting
stringsintoreal strings into numbers. Thefirst step in converting stringsinto elements, in thistutorial, was
numbers tocreatethelLD:2 VATP_TEMP element so that the system will use that element to look

up the VAT rate percentage (a string data type) in the VATCODES table, then map the
string to the ILD:2 VATP_TEMP element. The next step isto use an extended rule in the
ILD group to convert the string inthe ILD:2 VATP_TEMP element into areal number that
can be used in the ILD:2 VATP element, and then delete any data | eft in the temporary
element (ILD:2 VATP_TEMP).

Use this procedure to define an extended rule to convert strings into numbers.

Sep

Action

1

Click the IL D group (in the ODD group) with the right mouse button to
access the shortcut menu.

Select Extended Rules from the shortcut menu.

System Response
The Loop Level Extended Rules dialog is displayed.
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Action

Click the On Store radio button to indicate that you want the rule to be
executed when you store a group. (The extended rule you added to
calculate an extended priceis displayed in the Editor list box of the Loop
Level Extended Rules dialog.) When the screen entry usersclick Storeon
the Line Items frame in Sterling Gentran: Server, all On Store extended
rulesin the Loop Level Extended Rules dialog will be executed.

On the next two linesin the Editor list box, enter the following extended
rule:

#VATP = ATON#VATP_TEMP);
empty(#VATP_TEMP);

The ATON function tells the system to convert the string datain the
ILD:2 VATP_TEMP element into areal number.

The calculation you entered on the first line places the number datain the
ILD:2 VATP element.

The empty function setsthe value of the ILD:2 VATP_TEMPfield to null.

Click Compile to compile the extended rule and verify that this rule does
Not cause errors or warnings.

If you receive any errors or warnings when you compile the rule, verify
that you entered the rule exactly asit is written in step 4 above. After you
make any change to the extended rule to correct it, click COMPI LE again.
Repeat this process until there are no errors generated.

Click OK to add the extended rule to the form and exit the Loop Level
Extended Rules dialog.
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How to customize  ThellLD:2 TDES TDEO element (Traded Unit Descr. Line 1) contains the description of
thelLD:2 TDES theinvoiced item. You will rename the field label to shorten it and add Help text to this
TDEOelement  element.

Use this procedure to rename the field label and add Help text to the Traded Unit Descr.

Line1field.
Sep Action

1 Double-click theILD:2 TDES TDEO element.
System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label field, enter Description to replace the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end
of each line of text below):
Enter the description of theinvoiced item. The description
may not exceed 40 alphanumeric characters.

6 Click OK to exit the dialog.
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How to customize
the STL segment

(Contd)

Sep Action

7 Click Generate Layout on the Main Toolbar to refresh the display of the
screen entry form.

The Line Items frame now should look like this;
[ ]
[ 1]

Supplier's Product Code |

Item Mo,

E&M Code

Customer's Product Eocle

[uanitity

Irit of Measure I vl
Uit Price [Ex. WAT) I:I

L ]

WaT Code a

Traded Unit Descr. Ling 1 |

The STL segment (VAT Rate Invoice Sub Trailer) contains the invoice amounts relating to
the VAT rate. All monetary valuesin this segment arein pounds. You will use an extended
rule to perform the calculations that will be displayed in the fields in the STL segment.
Screen entry trandation object users will be able to view the values in these fields (in the
VAT Summary frame), but will not be able to change the values.

Reference
See Producing the VAT Summary and the Invoice Trailer on page 3 - 105 for detailson
how to add the extended rule.

Thefields associated with the STL segment are arranged on the St frame. Your users will
complete the fields on the STL frame for each VAT rate calculation. Thelist of all VAT
ratesin the invoice will be displayed in alist box on the Invoice Details frame. In that list
box, the VAT rates will be displayed for each line item, forming columns of information.
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Use this procedure to rename the STL frame and list box, provide a description for the
STL segment, and add Help text to thelist box.

Step

Action

1

Click the STL segment with the right mouse button to access the shortcut
menu.

Select Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

Select the Display tab.

In the Frame Caption field, enter VAT Summary to rename the frame.

Inthe List Caption field, enter VAT Summary to rename the list box that
isdisplayed on the Invoice Details frame (listing the VAT rates entered on
the VAT Summary frame).

In the Frame Help Text list box, enter the following text (press Enter at
the end of each line of text below):

Thisframe contains VAT summary
information. All the fieldson thisframeare
display-only. You may view the valuesin
these fields, but you cannot change any of
the values. All calculationswill be updated
when you click the Recalculate button on
the Invoice Details frame.

In the Listbox Help Text list box, enter the following text (press Enter at
the end of each line of text below):

Thislist box contains VAT summary
information. To view details about a VAT
ratelisted in the VAT Summary list box,
click that VAT rate and click Open. You
will be ableto view the valuesin these
fields, but you will not be able to change
any of them. All calculationswill be
updated when you click the Recalculate
button on the Invoice Details frame.

Click OK to exit the EDI Segment Properties dialog.

How to customize  The STL SEQA.:7 element (First Level Sequence Number) contains the sequence number
the STL SEQA:7  for the STL segment. This element is mandatory, but your screen entry translation object

eement users will not need to enter avaluein thisfield (the value will be assigned in the extended

rule you add later in thistutorial in the INVOIC file). Therefore, you will prevent thisfield
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from being displayed in the screen entry translation object, since users will not need to
enter avaluein thisfield.

Use this procedure to hide the First Level Sequence Number field.

Sep Action

1 Double-click the STL SEQA:7 element.

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 Click the Hidden radio button to prevent thefield from being displayed in
the trand ation object.

4 Click OK to exit the dialog.
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How to customize  The STL CD12:2 element (VAT Rate Category Code) contains the VAT rate category as
the STL CD12:2 listedin Code Values List 12. You will create alist box definition for this element to
eement include the VAT rate category code in the VAT Summary list box on the Invoice Details
frame. You will make thisfield display-only, as the screen entry translation object users
who use this invoice translation object should be able to view, but not change, the valuein
thisfield. (The valuesin thisfield will be assigned in the extended rule you add later in
thistutorial inthe INVOIC file.) Also, you will rename the field label.

Use this procedure to rename the field label, make this field display-only, and create the
list box definition for the VAT Rate Category Code field.

Sep

Action

1

Double-click the STL CD12:2 element.

System Response
The Element Properties dialog is displayed.

Select the Display tab.

Click the Display radio button to make this field display-only. Users will
be ableto read the datain thisfield, but will not be able to enter or change
avauein thisfield.

Inthe Labd field, enter VAT Codeto replace the existing field label.

Select the Summary List tab.

Click the Display thisfield in summary list check box to turn this option
on. Thevaluein the VAT Code field will be displayed in a column in the
VAT Summary list box on the Invoice Details frame.

In the Column Width field, enter 4 to set the width of this column in the
VAT Summary list box.

Note

The column width should be wider than the actual content of the column.
The extra space that is not used for the content of the column will provide
white space separating the columns. If the width for each column isthe
exact width of the data, then there will not be space separating the
columns of data.

From the Sequence drop-down list box, select 1 to indicate that thisfield
will be thefirst columnin the list box.

Click OK to exit the dialog.
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How to customize  The STL VATP:2 element (VAT Rate Percentage) contains the percentage rate for the VAT
the STL VATP:2  category code (inthe STL CD12:2 element). The EDI datawill be formatted in N3 format
eement (formatted with an implicit decimal point and three decimal places), but you want the VAT
rate percentage to be displayed in the translation object in R3 format (formatted with an
explicit decimal point). Therefore, you will change the screen format to reflect how you
want the amount to be formatted in the transl ation object.

You will create alist box definition for this element to include the VAT rate percentage in
the VAT Summary list box on the Invoice Details frame. You will make thisfield display-
only, as the screen entry translation object users who use this invoice translation object
should be able to view, but not change, the value in this field. Also, you will rename the
field label.

Use this procedure to change the screen format, make the field display-only, rename the
field label, and create the list box definition for the VAT Rate Percentage field.

Sep Action

1 Double-click the STL VATP:2 element.

System Response
The Element Properties dialog is displayed.

2 From the Form Format drop-down list box, select R3 to indicate that this
field will display a number with an explicit decimal point and up to three
decimal places.

3 Select the Display tab.

4 Click the Displayed but not editable radio button to make thisfield
display-only. Users will be able to read the datain this field, but will not
be able to enter or change avaluein thisfield.

5 In the Labd field, enter VAT Rate to replace the existing field |abel.

6 Select the Summary List tab.

7 Click the Display thisfield in summary list check box to turn this option
on.

System Response
The value in the VAT Rate field will be displayed in acolumnin the VAT
Summary list box on the Invoice Details frame.

Sterling Gentran:Server — May 2011 Forms Integration TRADACOMS Tutorial Guide



How to customize
the STL NRIL
element

How to customize
theSTL LVLA
element

(Contd)
Sep Action

8 In the Column Width field, enter 9 to set the width of this column in the
VAT Summary list box.

Note

The column width should be wider than the actual content of the column.
The extra space that is not used for the content of the column will provide
white space separating the columns. If the width for each column is the
exact width of the data, then there will not be space separating the
columns of data.

9 From the Sequence drop-down list box, select 2 to indicate that thisfield
will be the second column in the list box.

10 Click OK to exit the dialog.

The STL NRIL element (Number of Item Lines) contains the number of ILD segments
with the VAT category code specified in the STL CD12:2 element. You will make this
field display-only, as the screen entry tranglation object users who use thisinvoice
tranglation object should be able to view, but not change, the value in thisfield. Also, you
will rename thefield label.

Use this procedure to make the field display-only and rename the field |abel for the
Number of Item Linesfield.

Sep Action

1 Double-click the STL NRIL element.

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 Click the Displayed but not editable radio button to make thisfield
display-only. Users will be able to read the datain thisfield, but will not
be able to enter or change avalue in thisfield.

4 In the Labdl field, enter Number of Line Itemsto replace the existing
field label.
5 Click OK to exit the diaog.

The STL LVLA element (Lines Sub-Total (Excluding VAT)) contains the subtotal for this
lineitem, before VAT has been applied. The valuein thisfield equals the total of the
extended line cost (in the ILD:2 LEXC element) for line items with this VAT category
code. The EDI datawill be formatted in N2 format (formatted with an implicit decimal
point and two decimal places), but you want the lines subtotal (excluding VAT) to be
displayed in the trand ation object in R2 format (formatted with an explicit decimal point).
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Therefore, you will change the screen format to reflect how you want the amount to be
formatted in the trand ation object.

You will create alist box definition for this element to include the lines subtotal
(excluding VAT) in the VAT Summary list box on the Invoice Details frame. You will
make this field display-only, as the screen entry trandlation object users who use this
invoice tranglation object should be able to view, but not change, the valuein thisfield.
Also, you will rename the field label.

Use this procedure to change the screen format, make the field display-only, rename the
field label, and create the list box definition for the Lines Sub-Total (Excluding VAT)

field:

Step

Action

1

Double-click the STL LVLA element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

From the Form Format drop-down list box, select R2 to indicate that this
field will display a number with an explicit decimal point and up to two
decimal places.

Select the Display tab.

Click the Displayed but not editable radio button to make thisfield
display-only. Users will be able to read the datain thisfield, but will not
be able to enter or change avauein thisfield.

In the Labdl field, enter Lines Subtotal (Excluding VAT) to replace the
existing field label. (Making these slight changes to the field label
maintains the consistency of labelling in thisform.)

Select the Summary List tab.

Click the Display thisfield in summary list check box to turn this option
on. Thevalueinthe Lines Subtotal (Excluding Vat) field will be displayed
in acolumn in the VAT Summary list box on the Invoice Details frame.

In the Column Width field, enter 12 to set the width of this column in the
VAT Summary list box.

Note

You do not need to make the column width for thisfield wider than the
actual content of the column. The data from thisfield will form the last
column in the list box, and you do not need to leave white space between
the last column and the side of the list box.

10

From the Sequence drop-down list box, select 3 to indicate that thisfield
will be the third column in the list box.
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(Contd)
Sep Action

11 Click OK to exit the dialog.

How to customize  The STL EVLA element (Extended Sub-Total Amount (Excluding VAT)) contains the
theSTL EVLA extended subtotal before the VAT has been applied. In thistutorial, the value in the STL
dement EVLA element equalsthe valuein the STL LVLA element (because we are not using

settlement discountsin this tutorial). For this reason, you do not need to display the STL
EVLA element (the STL LVLA element will be displayed). Therefore, you will prevent
thisfield from being displayed in the screen entry trandlation object, since users will not
need to enter or view avalue in thisfield (the value will be assigned in the extended rule
you add later in thistutoria in the INVOIC file).

Use this procedure to hide the Extended Sub-Total Amount (Excluding VAT) field.

Sep Action

1 Double-click the STL EVLA element.

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 Click the Hidden radio button to prevent the field from being displayed in
the translation object.

4 Click OK to exit the dialog.

How to customize  The STL ASDA eement (Extended Sub-Total Amount (After Settlement Discount Has
the STL ASDA Been Applied) contains the extended subtotal amount before VAT has been applied. In this
dement tutorial, the value in the STL ASDA element equals the value in the STL EVLA element
(whichisequal tothe STL LVLA element), because we are not using settlement discounts
in thistutorial. For this reason, you do not need to display the STL ASDA element (the
STL LVLA element will be displayed). Therefore, you will prevent this field from being
displayed in the screen entry translation object, since users will not need to enter or view a
valuein thisfield (the value will be assigned in the extended rule you add later in this
tutorial in the INVOIC file).

Use this procedure to hide the Extended Sub-Total Amount (After Settlement Discount
Has Been Applied) field.

Sep Action

1 Double-click the STL ASDA element.

System Response
The Element Properties dialog is displayed.
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Sep

Action

Select the Display tab.

Click the Hidden radio button to prevent the field from being displayed in
the trand ation object.

Click OK to exit the dialog.

How to customize  The STL VATA element (VAT Amount Payable) contains the VAT amount at the quoted
the STL VATA VAT rate. The EDI datawill be formatted in N2 format (formatted with an implicit
dement decimal point and two decimal places), but you want the VAT amount payable to be

displayed in the trand ation object in R2 format (formatted with an explicit decimal point).
Therefore, you will change the screen format to reflect how you want the amount to be
formatted in the trand ation object. In addition, you will make this field display-only, as
the screen entry translation object users who use this invoice translation object should be
able to view, but not change, the value in thisfield. Also, you will rename the field label.

Use this procedure to change the screen format, make the field display-only, and rename
the field label for the VAT Amount Payable field.

Sep

Action

1

Double-click the STL VATA element.

System Response
The Element Properties dialog is displayed.

From the Form Format drop-down list box, select R2 to indicate that this
field will display a number with an explicit decimal point and up to two
decimal places.

Select the Display tab.

Click the Display radio button to make this field display-only. Users will
be able to read the datain thisfield, but will not be able to enter or change
avaluein thisfield.

Inthe Label field, enter VAT Amount Payable (note that “VAT” contains
al capital letters) to replace the existing field label. Making these dight
changesto the field label maintains the consistency of labelling in this
form.

Click OK to exit the dialog.
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How to customize  The STL APSI element (Payable Sub-Total Amount Including Settlement Discount)
the STL APSI contains the amount after VAT has been applied. The vauein this element equals the sum
eement of thevaluesin the STL ASDA and STL VATA elements. The EDI datawill be formatted
in N2 format (formatted with an implicit decimal point and three decimal places), but you
want the VAT amount payable to be displayed in the translation object in R2 format
(formatted with an explicit decimal point). Therefore, you will change the screen format to
reflect how you want the amount to be formatted in the transl ation object. In addition, you
will make this field display-only, asthe screen entry trandation object users who use this
invoice translation object should be able to view, but not change, the valuein thisfield.
Also, you will rename the field label.

Use this procedure to change the screen format, make the field display-only, and rename
the field label for the Payable Sub-Total Amount Including Settlement Discount field.

Sep Action

1 Double-click the STL APSI element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 From the Form Format drop-down list box, select R2 to indicate that this
field will display a number with an explicit decimal point and up to two
decimal places.

4 Select the Display tab.

5 Click the Display radio button to make thisfield display-only. Users will
be able to read the datain thisfield, but will not be able to enter or change
avaueinthisfield.

6 In the Label field, enter Payable Subtotal (Inc. Sett. Disc.) to replace the
existing field label.

7 Click OK to exit the dialog.

8 Click Generate L ayout on the Main Toolbar to refresh the display of the

screen entry form.

Customizingthe  The TLR segment (Invoice Trailer) contains the total invoice amounts. All monetary
TLR segment  vauesin this segment are in pounds. You will use an extended rule to perform the
calculations that will be displayed in the fieldsin the TLR segment. Screen entry
tranglation object users will be able to view the values in these fields (on the Invoice
Details frame), but will not be able to change the values. See Producing the VAT Summary
and the Invoice Trailer on page 3 - 105 for details on how to add the appropriate extended
rule.
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Customizingthe  The TLR NSTL element (Number of Total Segments) contains the number of STL
TLR NSTL segmentsin the invoice. You do not need to display the this element, as the screen entry
eement translation object users will not need to enter or view avaluein thisfield.

Use this procedure to hide the Number of Total Segments field.

Sep

Action

1

Double-click the TLR NSTL element.

System Response
The Element Properties dialog is displayed.

Select the Display tab.

Click the Hidden radio button to prevent the field from being displayed in
the trand ation object.

Click OK to exit the diaog.

Customizingthe  The TLRLVLT element (Lines Total Amount (Excluding VAT)) contains the sum of the
TLR LVLT STL LVLA elementsin the preceding STL segments (before VAT is applied). The EDI
eement datawill be formatted in N2 format (formatted with an implicit decimal point and two
decimal places), but you want the total amount (excluding VAT) to be displayed in the
tranglation object in R2 format (formatted with an explicit decimal point). Therefore, you
will change the screen format to reflect how you want the amount to be formatted in the
trangation object. In addition, you will make this field display-only, as the screen entry
tranglation object users who use this invoice translation object should be able to view, but
not change, the value in this field. Also, you will rename the field label.

Use this procedure to change the screen format, make the field display-only, and rename
the field label for the Lines Total Amount (Excluding VAT) field.

Sep

Action

1

Double-click the TLR LVLT element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

From the Form Format drop-down list box, select R2 to indicate that this
field will display a number with an explicit decimal point and up to two
decimal places.

Select the Display tab.
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(Contd)
Sep

Action

5

Click the Display radio button to make thisfield display-only. Users will
be ableto read the datain thisfield, but will not be able to enter or change
avaueinthisfield.

In the Label field, enter I nvoice Amount (Excluding VAT) to replace the
existing field label.

Click OK to exit the diaog.

How to customize  The TLR EVLT element (Total Extended Amount Ex Settlement Discount) contains the
theTLR EVLT sum of the STL EVLA elementsin the preceding STL segments (before VAT is applied).
dement The EDI datawill be formatted in N2 format (formatted with an implicit decimal point

and two decimal places), but you want the total amount (excluding settlement discount
and VAT) to be displayed in the translation object in R2 format (formatted with an explicit
decimal point). Therefore, you will change the screen format to reflect how you want the
amount to be formatted in the translation object. In addition, you will make thisfield
display-only, as the screen entry translation object users who use this invoice translation
object should be ableto view, but not change, the valuein thisfield. Also, you will rename

the field label.

Use this procedure to change the screen format, make the field display-only, and rename
thefield label for the Total Extended Amount Ex Settlement Discount field.

Sep

Action

1

Double-click the TLR EVLT element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

From the Form Format drop-down list box, select R2 to indicate that this
field will display a number with an explicit decimal point and up to two
decimal places.

Select the Display tab.

Click the Display radio button to make thisfield display-only. Users will
be ableto read the datain thisfield, but will not be able to enter or change
avaueinthisfield.

In the Labdl field, enter I nvoice Amount (Ex. Settlement Disc.) to
replace the existing field label.

Click OK to exit the diaog.
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How to customize  The TLR ASDT element (Total Amount Exc VAT Inc Sett) contains the sum of the STL
theTLR ASDT ASDA elementsin the preceding STL segments (before VAT is applied). The EDI data
dement  Will beformatted in N2 format (formatted with an implicit decimal point and two decimal

places), but you want the total amount (excluding settlement discount and VAT) to be
displayed in the trand ation object in R2 format (formatted with an explicit decimal point).
Therefore, you will change the screen format to reflect how you want the amount to be
formatted in the trand ation object. In addition, you will make this field display-only, as
the screen entry translation object users who use this invoice translation object should be
able to view, but not change, the value in thisfield. Also, you will rename the field label.

Use this procedure to change the screen format, make the field display-only, and rename
the field label for the Total Amount Exc VAT Inc Sett field.

Sep

Action

1

Double-click the TLR ASDT element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

From the Screen Format drop-down list box, select R2 to indicate that this
field will display a number with an explicit decimal point and up to two
decimal places.

Select the Display tab.

Click the Display radio button to make thisfield display-only. Users will
be able to read the datain thisfield, but will not be able to enter or change
avaueinthisfield.

In the Label field, enter I nvoice Amount (Ex. VAT Inc. Sett.) to replace
the existing field label.

Click OK to exit the dialog.

Sterling Gentran:Server — May 2011

Forms Integration TRADACOMS Tutorial Guide



How to customize  The TLR TVAT element (Total VAT Amount Payable) contains the sum of the STL VATA
theTLR TVAT elementsin the preceding STL segments. The EDI datawill be formatted in N2 format
eement (formatted with an implicit decimal point and two decimal places), but you want the total

amount to be displayed in the trandation object in R2 format (formatted with an explicit
decimal point). Therefore, you will change the screen format to reflect how you want the
amount to be formatted in the translation object. In addition, you will make thisfield
display-only, as the screen entry translation object users who use this invoice translation
object should be ableto view, but not change, the valuein thisfield. Also, you will rename
thefield label.

Use this procedure to change the screen format, make the field display-only, and rename
the field label for the Total VAT Amount Payable field.

Sep Action

1 Double-click the TLR TVAT element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 From the Form Format drop-down list box, select R2 to indicate that this
field will display a number with an explicit decimal point and up to two
decimal places.

4 Select the Display tab.

5 Click the Display radio button to make thisfield display-only. Users will
be able to read the datain thisfield, but will not be able to enter or change
avaueinthisfield.

6 In the Label field, enter VAT Total to replace the existing field label.

7 Click OK to exit the dialog.

How to customize  TheTLR TPSI element (Total Payable Inc. Settlement) contains the sum of the STL APSI
the TLR TPSI elementsin the preceding STL segments. The EDI data will be formatted in N2 format
eement (formatted with an implicit decimal point and two decimal places), but you want the total
amount to be displayed in the trandation object in R2 format (formatted with an explicit
decimal point). Therefore, you will change the screen format to reflect how you want the
amount to be formatted in the translation object. In addition, you will make thisfield
display-only, as the screen entry translation object users who use this invoice translation
object should be ableto view, but not change, the valuein thisfield. Also, you will rename
thefield label.
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Use this procedure to change the screen format, make the field display-only, and rename
the field label for the Total Payable Inc. Settlement field.

Sep Action

1 Double-click the TLR TPSI element.

System Response
The Element Properties dialog is displayed.

2 From the Screen Format drop-down list box, select R2 to indicate that this
field will display a number with an explicit decimal point and up to two
decimal places.

3 Select the Display tab.

4 Click the Display radio button to make this field display-only. Users will
be ableto read the datain thisfield, but will not be able to enter or change
avaueinthisfield.

5 In the Labd field, enter Total Invoice Amount (Inc. Sett. Disc.) to
replace the existing field |abel.

6 Click OK to exit the dialog.

7 Click Generate Layout on the Main Toolbar to refresh the display of the

screen entry form.

The section of the Invoice Details frame that contains the fieldsin the
TLR segment now should look like this:

Invoice Details

Location AMA Code ] =
Location Own Code I:I

M arme | |

Addrezs Line 1

Addrezs Line 2

Address Line 3

Address Line 4

Post Code I:I
Irvvnice Mo, I:I
Irvvnice Date I:I

T ax-point [ ate I:I

Payrnent Terrms |

4l |
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Producing the VAT Summary and thelnvoice Trailer

Overview  Now that you have customized the individual elementsin the invoice, one last
customizing task remains: to produce the VAT summary and invoice trailer. The VAT
summary and invoice trailer calculations include calculating the totals for the invoice for
each of the different VAT rates and grouping the totals by VAT rate. To produce the VAT
summary calculations for the invoice, you will use an extended rule to define operations
with the Sterling Gentran:Server proprietary programming language.

There are two sections for extended rules: a declar ations section and a statements
section. The declarations section is used to declare the names and types of any variables
you will use. The statements section is where you define the operations that you want the
rule to execute. Within the statements section, you can leave blank lines to visually
separate portions of an extended rule. (Blank lines are used more often in complex
extended rules, rather than in simple one- or two-line extended rules.) Leaving ablank line
does not affect the execution of extended rules.

Asyou define the operations for the VAT summary cal culations, you will enter many lines
of rulesin the Loop Level Extended Rules dialog. This section describes each of the
individual operations that you will define, and explains what you should enter in order to
execute each operation.

Note

As an dternative to entered the extended rule yourself, you may copy the extended rule
from the example form provided with the tutorial datain the
C\GENSRVNT\TUTORIALS subfolder.

You will define the VAT summary and invoice trailer calculations on the INVOIC group
so that the calculations are run when the screen entry trandlation object usersin Sterling
Gentran: Server either calculates or saves the file. After Sterling Gentran: Server stores the
datain the fields, the system will run the cal culations and store them in the appropriate
VAT summary and invoice trailer fields. The extended rule will be used with the On Store
function so the system will perform the calculations last, after the group is stored.
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Procedure  Usethis procedure to access the Loop Level Extended Rules dialog to define the
operations for the VAT summary calculations.

Sep Action
1 Click the INVOI C EDI fileicon with the right mouse button to access the
shortcut menu.
2 Select Extended Rules from the shortcut menu.
System Response
The Loop Level Extended Rules dialog is displayed.
3 Click the On Store radio button to indicate that you want the rule to be

executed when you save or recal culate the screen entry translation object.
When the screen entry users save or recalculate the Invoice Details frame
in Sterling Gentran: Server, all On Store extended rulesin the Loop Level

Extended Rules dialog will be executed.

How to declarethe  Before you begin defining any operations in the statements section of the extended rule,
variables  you must first define the variables that you will use in the extended rule. Variables consist
of aname and a datatype, and they are used to store values.

For this extended rule, you will use these four variables (all of which have a data type of
integer).
i (temporary variable assigned any value you define in the extended rule)

j (another temporary variable assigned any value you define in the extended rule)

ildlimit (temporary variable that contains the number of ILD segments)

stllimit (temporary variable that contains the number of STL segments)

Use this procedure to declare the four integer variables listed above.

Sep Action

1 Onthefirst linein the Editor list box, enter the following declaration:
integer i,j.ildlimit,stllimit;

2 Press Enter twice to insert a blank line after the declarations section.
Note
It is not necessary to include a blank line after the declaration and
statement sections. However, doing so may improve readability of the
extended rule.

3 You are now ready to define the statements section of the extended rule.
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How to count the  The STL segment is a repeating segment, so thereis one STL segment for each VAT code
STL segmentsand used in theinvoice. You want Sterling Gentran:Server to count the STL segmentsused in
deletethem the invoice (the value from counting the STL segmentswill be placed in variable “i").

Next, you want the system to visit each STL segment and del ete the segment. The reason
you want the system to delete the STL segmentsiis that the system makes the assumption
that the form has been modified and, therefore, deletes the STL segmentsto reset the form
before performing any calculations relating to the STL segments. Finally, you want the
system toinitialize the value of the last STL segment to zero.

Use this procedure to define a statement that counts the STL segments and del etes them,
then initializes the value of the last STL to zero.

Sep Action
1 On the next line in the Editor list box, enter the following statement:
i=count($STL[*]);
whilei >0do
begin
delete($STL[i]);
i=i-1;
end
stilimit = 0;
2 Press Enter twice to insert a blank line after the statement.
Note
It is not necessary to include a blank line after this statement. However,
doing so may improve readability of the extended rule.

How to count the  ThelLD group is arepeating group, so thereis one ILD group for each lineitem in the
ILD groups invoice. You want Sterling Gentran:Server to count the ILD groups used in the invoice
(the value from counting the ILD groups will be placed in variable “ildlimit”).

Use this procedure to define a statement that counts the ILD groups.

Sep Action

1 On the next line in the Editor list box, enter the following statement:

ildlimit = count($IL D[1][*]);

2 Press Enter twice to insert ablank line after the statement.

Note
It is not necessary to include a blank line after this statement. However,
doing so may improve readability of the extended rule.
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Howtofind  Now that Sterling Gentran:Server has counted (and deleted) the STL segments and
compatible VAT counted the ILD groupsin the invoice, you want the system to determine which VAT code
codesin the STL isused for each line item (each instance of the ILD group). Next, you want to group the
segments  lineitems that use the same VAT code so you can determine the VAT rate percentage
(based on each VAT code) and then calculate the total VAT payable for each group of line
items.

If the system finds a VAT code that isthe samein both an ILD group and an STL segment
(compatible VAT codes), then you want the system to execute the following operations:

Add the extended line cost (ILD:2 LEXC element) into the lines subtotal (ILD:2
LVLA element) to add the line item from the ILD group to the compatible STL
segment

Increment a counter in the STL segment of how many of the existing ILD segments
are compatible with that STL segment

If the system does not find an STL segment with the same VAT code asthe ILD groupitis
visiting, then it executes the following operations:

Creates an STL segment with the VAT code of the current ILD group

Setsthe number of STL segments (STL SEQA:7 element) to be the number of the last
STL segment (the current segment, which was just created)

Setsthe VAT rate percentage of the STL segment (STL VATP:2 element) to equal the
VAT rate percentage of the ILD group (ILD:2 VATP element)

Setsthe VAT code of the STL segment (STL CD12:2 element) to equal the VAT code
of the ILD group (ILD:2 CD12 element)

Setsthe lines subtotal of the STL segment (STL LVLA element) to be the extended
line cost of the ILD group (ILD:2 LEXC element)

Sets the number of lineitemsto be“1” (STL NRIL element)

Sets the number of STL segments to be the number of the current STL segment
(which was just created)

Finally, you want the system to repeat the process described above (finding compatible
VAT codesin the STL segments and ILD segments) until it has no more ILD groups to
count (each line item has been assessed).
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Procedure  Usethis procedure to define a statement that groups line items with the same VAT code.

Sep Action
1 On the next linein the Editor list box, enter the following statement:
i=1;
while i <= ildlinit do
begin
=1
while j <= stllinmt do
begin
if $ILD{1][i].#CD12 = $STL[j].#CD12:2 then
begi n
$STL[j].#LVLA = $STL[j].#LVLA + $ILD[1][i].#LEXC,
$STL[j].#NRIL = $STL[j].#NRIL + 1;
br eak;
end
j =i+
end
if j >stllimt then
begin
$STL[j].#SEQA' 7 = |;
$STL[j].#VATP: 2 = $ILD[1][i].#VATP;
$STL[j].#CD12:2 = $ILD[ 1][i].#CD12;
$STL[j].#LVLA = $ILD[1][i].#LEXC
$STL[j].#NRIL = 1;

stllimt =stllimt + 1;
end
i =i +1;
end

2 Press Enter twice to insert ablank line after the statement.

Note
It is not necessary to include a blank line after this statement. However,
doing so may improve readability of the extended rule.

How to calculate  Up to this point, the extended rule you have defined instructs Sterling Gentran: Server to
the VAT amount calculate the totals for the invoice for each of the different VAT rates. Now you will define
and producingthe  arulethat calculates the total VAT amount and produces the invoice trailer.
invoicetrailer
First, the system will initialize the lines total amount (TLR LVLT element) and the total
VAT amount payable (TLR TVAT element) to zero. Next, the system will perform the
following calculations for every STL segment:

»  Set the VAT amount payable (STL VATA element) equal to the product of the lines
subtotal (STL LVLA element) and the VAT rate percentage (STL VATP:2 element),
divided by one hundred (to calculate the VAT payable).

» Set the extended subtotal amount (STL EVLA element) equal to the lines subtotal
(STL LVLA element), because you are not using settlement discountsin this tutorial.

»  Set the extended subtotal amount (STL ASDA element) equal to the lines subtotal
(STL LVLA element), because you are not using settlement discountsin this tutorial.

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



» Set the payable subtotal amount (STL APSI element) equal to the sum of the lines
subtotal (STL LVLA element) and the VAT amount payable (STL VATA element).

» Setthelinestotal amount (TLR LVLT element) equal to the sum of the lines total
amount (TLR LVLT element) and the extended subtotal amount (STL EVLA

element).

» Setthetota VAT amount payable (TLR TVAT element) equal to the sum of the total
VAT amount payable (TLR VATA element) and the VAT amount payable (STL VATA

element).

Finally, you want the system to repeat the cal cul ations described above until all STL
segments have been processed.

Procedure  Usethis procedure to define a statement that groups the invoice totals by VAT rate.

Step

Action

1

On the next line in the Editor list box, enter the following statement:

0,
0;

#LVLT
H#TVAT
=1
while j <
begin

$STL[j].

100. 0;

$STL[j].
$STL[j].
$STL[j].

#LVLT

#TVAT

j=i+L
end

stllimt do

H#VATA = ($STL[j].#LVLA * $STL[j].#VATP: 2) /
HEVLA = $STL[j].#LVLA

#ASDA = $STL[j]. #LVLA

#APSI = $STL[j].#LVLA + $STL[j].#VATA
HLVLT + $STL[j].#LVLA

#TVAT + $STL[]]. #VATA

Press Enter twice to insert one blank line after the statement.

Note

It is not necessary to include a blank line after this statement. However,
doing so may improve readability of the extended rule.
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Completing the
trailer calculations

Checking what you
entered

The final operation that Sterling Gentran: Server will execute when processing the
extended rule isto calculate the line value total and VAT. You want the system to perform
these calculations:

»  Set the number of total segments (TLR NSTL element) equal to the count of STL
segments.

» Setthetotal extended amount (TLR EVLT element) equal to the lines total amount
(TLR LVLT element).

» Setthetotal amount (TLR ASDT element) equal to thelinestotal amount (TLR LVLT
element).

» Setthetotal amount payable (TLR TPSI element) equal to the sum of the lines total
amount (TLR LVLT element) and the total VAT amount payable (TLR TVAT
element).

To calculate the line value total and VAT, on the next line in the Editor list box, enter the
following statement:

#NSTL = stllimt;
#EVLT = #LVLT,

#ASDT = #LVLT;

#TPSI = #LVLT + #TVAT,;

Now that you have entered the entire extended rule that will be processed for the INVOIC
group, your extended rule should look like this:

integer i,j,ildlimt,stllimt;

i =count ($STL[ *]);
while i > 0 do

begi n
del et e($STL[i]);
i=i-1;
end
stllimt = 0O;
ildlimt = count($ILD1][*]);
i=1;
while i <=ildlimt do
begin
j =1
while j <= stllimt do
begin
if $ILD1][i].#CD12 = $STL[j].#CD12:2 then
begin
$STL[j].#LVLA = $STL[j].#LVLA + SILD[1][i].#LEXC
$STL[j].#NRIL = $STL[j].#NRIL + 1;
br eak;
end
j=+L
end

if j >stllimt then
begi n
$STL[j]. #SEQA: 7
$STL[j]. #VATP: 2

i
SILD[1][i]. #VATP;
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$STL[j].#CD12:2 = $ILD[1][i].#CD12;
$STL[j].#LVLA = $ILD[1][i].#LEXC,
$STL[j].#NRIL = 1;
stllimt =stllimt + 1;
end
i=i+1;
end

#LVLT = #TVAT = O;

=1

while j <= stllimt do

begin
$STL[j]. #VATA
$STL[j]. #EVLA
$STL[j]. #ASDA

($STL[j].#LVLA * $STL[j].#VATP:2) / 100.0;
$STL[j]. #LVLA;
$STL[j]. #LVLA;

$STL[j ] . #APSI $STL[j].#LVLA + $STL[|]. #VATA
#LVLT = #LVLT + $STL[]]. #LVLA;
H#TVAT = #TVAT + $STL[|]. #VATA,
1= +L
end
#NSTL = stllimt;
#EVLT = #LVLT;
#ASDT = #LVLT;
#TPSI = #LVLT + #TVAT;

How to compilethe  Now that you have entered the extended rule to perform all the INVOIC group-level
extended rule  calculationsfor the invoice, you should compile the extended rule to verify that you have
entered the rule correctly.

Use this procedure to compile the extended rule.

Sep Action

1 Click Compile to compile the extended rule.

Note

If you receive any errors or warnings when you compile the rule, verify
that you entered the rule exactly asit iswritten in thistutorial. After you
make any changes to the extended rule to correct it, click Compile again.
Repeat this process until there are no errors generated.

2 Click OK to add the extended rule to the form and exit the Loop Level
Extended Rules dialog.
3 Click Save from the File menu to save the form.

Now that you have customized all of the elements used in thisinvoice, you are ready to
format the fields and label s to make the frames more consistent and visually attractive.
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Format the Screen Entry Form

Overview

Introduction In the previous section of this tutorial, you customized the screen entry form for a
TRADACOMS ANAQO1 INVOIC release 9 invoice that your users will use to enter data
to invoice Pet Zone for items that were shipped to them. After successfully customizing
the fields and elements of the screen entry form, you are ready to format the layout of the
form.

This section explains how to format the form, field by field.

How toresizethe  When aformis compiled into atrandation object, the fields are arranged according to
invoicedetails  how the frames and the fields contained in them were arranged when the form was
frame  compiled. You should eliminate unnecessary space as you arrange the fieldsin each frame.

Important

When you resize the frames of a screen entry form, you must resize based on the
resolution of the target monitor (e.g. the monitor on which the end user will view the
translation object). For example, if you size the frames of a screen entry form on a Super
V GA monitor, the compiled translation object may not fit in the display areaof aVGA
monitor.

Use this procedure to resize the Invoice Details frame.

Sep Action
1 Click the INVOIC fileicon to display the Invoice Details frame in the
Layout Window.
Note

When the form is generated, the upper left corner of each framein the
form is placed in the upper left corner of the Layout Window.

2 To display more of the form on your screen, click and drag the centre bar
between the EDI File Format Window and the Layout Window to the left
until the Layout Window iswide enough to display as much of theform as
you want to view.
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(Contd)
Sep Action

3 To resize the Invoice Details frame, click and drag the right side of the
frame approximately to the 14 cm mark on the horizontal ruler so that the
form is wide enough to format the fields according to the instructions in
thistutorial.

The Invoice Details frame now should look like this:

Invoice Details

Location 4M& Code ] =
Location Dwn Cade I:I

Mame | |

Addrezs Line 1

Addrezs Line 3

| |
Address Line 2 | |
| |
Address Line 4 | |

Pzt Code I:I
Irrvoice M. I:I
Irvoice Date I:I

T ax-point D ate I:I

Payrment Terms |

4] |
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Arranging the Fields on the I nvoice Details Frame

Overview  You will begin formatting the screen entry form by arranging the fields on the Invoice
Details frame. You will place the fields in the trand ation object in alogical order, then
align the fields to give the frame a consistent and orderly appearance. When you have
finished arranging the fields, your Invoice Details frame should look like the one in the
example below (only part of the frame is shown below).

Imvolce Detalls
Irttics by | | ImsicsDas [ ] f
Tarpoik Daa |:|
Cugtomer's .0, Mo | | F.0. Dater |:|
Diediveny Noke Wumber | | Dedivemiy Dok :|

CUSTOHKER DETAILS

e — L E—

Meme

Adde=Line 1

Address Line 3

| |
| |
Addres Line 2 | |
| |
Addrez= Line & | |

G —

Papmert Teima | |

Irrecice fohes | |

By default, each field and its associated |abel are displayed on their own line. However, it
is common for invoices to place two or morefields on aline.

You prevented some of the field labels from being displayed (by removing the field label
in the Label field of the Display Properties diaog). For these fields, the fields will be
displayed on your screen entry form, but their associated labels are not displayed.

Note

If you forget which unlabelled field contains what data, you can click the field. Its
associated element will be highlighted in the EDI File Format Window, providing you
with a description of the field.

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



How to resize, Use this procedure to resize, move, and align the fields on the Invoice Details frame of the
move, and align  screen entry form:

thefields Note

If afield and its corresponding field label move together, the Lock Labelsto Fields option
isturned on. Click the Lock Labels button on the Main Toolbar to turn off the Lock Labels

option.

Sep

Action

1

Click and drag the bottom of the frame to the bottom of the Forms
window, so that as many of the fields on the frame are displayed as
possible.

Select the following fields:

Note

To select more than one field, click thefirst field, then press CTRL and
click the second field. Repeat the process of pressing CTRL and clicking
the field for each subsequent field you want to select.

» Location Own Code

» Name

» InvoiceDate

» Tax-point Date

» PO.Date

» Ddivery Date

Note

If any of thesefieldsis not in the part of the Invoice Details frame that

currently is displayed, then use the scroll bar to scroll down the frame
until you locate the hidden field(s).

Select Sizeto Length from the Display menu. All selected fields will be
resized to the lengths specified in the Display Length field of the Display
Properties dialog for each field.

Note
If you accidentally format aform component in away you did not intend,
select Undo from the Display menu to undo your last formatting action.

Select each field in the form individually and drag it closer to its
respective label.
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(Contd)
Sep

Action

5

Select al of the items (fields, field labels, list boxes) on the frame and
drag them afew centimetres |lower on the frame. You will be arranging the
fields at the top of the frame, so moving the fields and field |abels out of
the way initialy will give you room to work with at the top of the frame.

Note

To select agroup of items, click and drag the mouse diagonally across al
the fields/labels you want to select. When you rel ease the mouse button,
al thefields and field labels completely included within the space formed
by dragging the mouse will have handles, indicating they were selected.

Click the Lock L abels button on the Main Toolbar to turn on the L ock
L abelsfunction. When you select afield, its corresponding field 1abel will
be selected also.

Select the I nvoice No. label and field and drag them to the upper left
corner of the Invoice Details frame. (Their field |abels will be selected,
too, because you have the Lock Labels function turned on.)

Select the I nvoice Date label and field and drag them to the upper right
corner of the Invoice Details frame (at approximately 8 cm on the
horizontal ruler).

Select the Tax-point Date label and field and drag them under the Invoice
Date label and field.

10

Select the Customer’s P.O. No. label and field and drag them under the
Invoice No. label and field (but not on the same line as the Tax-point Date
label and field).

11

Select the P.O. Date label and field and drag them below the Tax-point
Date label and field.

12

Select the Delivery Note Number label and field and drag them below
the Customer’s PO. No. label and field.

13

Select the Delivery Date label and field and drag them below the PO.
Datelabel and field.

14

Select the L ocation ANA Code label and field and drag them below the
Delivery Note Number label and field (and indented about half a
centimetre).

Note
You will add static text later in thistutorial to label al thefields providing
customer details. Therefore, leave extra space between the Delivery Note
Number and Delivery Date labels and fields, and the Location ANA Code
and Location Own Code labels and fields, to insert the static text between
them.
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(Contd)
Sep

Action

15

Select the L ocation Own Code label and field and drag them to the right
of the Location ANA Code label and field (at approximately 7 cm on the
horizontal ruler).

16

Select the following fields and labels, and drag them below the Location
ANA Code label and field:

» Name

» AddressLinel
» AddressLine?2
» AddressLine3
» AddressLine4
» Post Code

17

Select the Payment Termslabel and field and drag it below the Post Code
field. (The left margin of the Payment Terms label should be aligned with
the left margin of the Delivery Note Number label.)

Note

L eave extra space between the Post Code field and label, and the Payment
Termsfield and label, to designate the end of the Customer Details
section.

18

Select the I nvoice Notes label and fields (there are four fields, three of
which are unlabelled) and drag them below the Payment Terms label and
field.

19

Select the Line Itemslabel and list box and drag them below the fourth
Invoice Notes field (the second, third, and fourth Invoice Notes fields are
unlabelled).

Note
L eave extra space above the Line Items field and list box to add column
headings (using static text) to label the datain the list box.

20

Click and drag theright or |eft handle on the Line Items list box until the
list box is approximately 11.25 cm wide. The list box must be at least
11.25 cm wide to be able to display al of the summary list data.

Note
Use the horizontal ruler to help you measure width.

21

Select the VAT Summary label and list box and drag them below the Line
Items label and list box.

Note
L eave extra space above the VAT Summary field and list box to add
column headings (using static text) to label the datain the list box.
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(Contd)
Sep

Action

22

Click and drag the right or left handle on the VAT Summary list box until
the list box is approximately 4.5 cm wide. The list box must be
approximately 4.5 cm wide to display al of the summary list data

appropriately.

23

Select the following fields and labels and drag them below the VAT
Summary list box (so that the fields and labels are approximately centred
horizontally on the frame):

» Invoice Amount (Excluding VAT)

» Invoice Amount (Ex. Settlement Disc.)
» Invoice Amount (Ex. VAT Inc. VAT)

» VAT Totd

» Total Invoice Amount (Inc. Sett. Disc.)

24

Click the Lock L abels button on the Main Toolbar to turn off the L ock
L abels function.

Note
To seefieldsthat are not displayed currently on the frame, use the scroll
bar to scroll down the frame.

How to align the
fieldsand field
labels

Now that the fieldsin the Invoice Details frame are resized and moved to their proper
locations, you can aign the fields and |abels.

Use this procedure to align the fields and field labels on the Invoice Details frame.

Step

Action

1

Select the following field labels:

» InvoiceNo.

» Customer’'sPO. No.

» Délivery Note Number

» Payment Terms

» Invoice Notes

» Lineltems

» VAT Summary

Note

To select more than one field, click thefirst field, then press CTRL and

click the second field. Repeat the process of pressing CTRL and clicking
the field for each subsequent field you want to select.
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(Contd)
Sep

Action

2

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected field
labels are aligned.

Select the following field labels:
» Invoice Date

» Tax-point Date

» PO.Date

» Dédlivery Date

Note

To select agroup of items, click and drag the mouse diagonally across all
the fields/labels you want to select.

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected field
labels are aligned.

Select the following field labels:
» Location ANA Code

» Name

» AddressLinel

» AddressLine?2

» AddressLine3

» AddressLine4

» Post Code

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected field
labels are aligned.

Select the following field labels:

» Invoice Amount (Excluding VAT)

» Invoice Amount (Ex. Settlement Disc.)
» Invoice Amount (Ex. VAT Inc. Sett.)

» VAT Totd

» Tota Invoice Amount (Inc. Sett. Disc.)

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected field
labels are aligned.
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(Contd)
Sep

Action

9

Select the following fields:

» InvoiceNo.

» Customer'sPPO. No.

» Dédlivery Note Number

» Location ANA Code

» Name

» AddressLinel

» AddressLine?2

» AddressLine3

» AddressLine4

» Post Code

Note

Select the Location ANA Codefield last, so that it is the reference. The
reference istheitem (field, field label, list box, or static text) relative to
which all other selected items are formatted. The referenceisindicated by
an outline of diagonal lines, whereas all other selected items are outlined

by asolid line. The last item selected in agroup of selected itemsisthe
reference.

10

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. Theleft margins of the selected fields are
aigned.

11

Select the Line Items and VAT Summary list boxes.

Note
Select the VAT Summary field last, so that it isthe reference.

12

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. Theleft margins of the selected list boxes
are aligned.

13

Select the following fields:
» InvoiceDate

» Tax-point Date

» PO.Date

» Dédlivery Date

Note
Select the Tax-point Date field last, so that it is the reference.

14

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected fieldsare
aigned.
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(Contd)
Sep

Action

15

Select the following fields:
» Payment Terms

» Invoice Notes (all four fields)

Note
Select the Payment Termsfield last, so that it is the reference.

16

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected fields are
aligned.

17

Select the following fields:

» Invoice Amount (Excluding VAT)

» Invoice Amount (Ex. Settlement Disc.)
» Invoice Amount (Ex. VAT Inc. Sett.)

» VAT Totd

» Total Invoice Amount (Inc. Sett. Disc.)
Note

Select the Total Invoice Amount (Inc. Sett. Disc.) field last, sothat it isthe
reference.

18

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected fields are
aligned.
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(Contd)
Sep Action

19 To alignthetopsof all of thefield labels, fields, and list boxes, select each
row of items (one row at atime), select Align Controls from the Display
menu, then select Top from the Align Controls cascading menu. Theitems
in each row are listed below:

» Invoice No. label and field, Invoice Date label and field

» Tax-point Date label and field

» Customer’'s PO. No. label and field, PO. Date label and field

» Delivery Note Number label and field, Delivery Date label and field

» Location ANA Code label and field, Location Own Code label and
field

» Namelabel and field

» AddressLinel label and field

» AddressLine?2label andfield

» AddressLine3label and field

» AddressLine4 label and field

» Post Codelabel and field

» Payment Termslabel and field

» Invoice Noteslabel and field (first Invoice Notesfield only)

» Lineltemslabel and list box

» VAT Summary label and list box

» Invoice Amount (Excluding VAT) label and field

» Invoice Amount (Ex. Settlement Disc.) label and field

» Invoice Amount (Ex. VAT Inc. Sett.) label and field

» VAT Total label and field

» Total Invoice Amount (Inc. Sett. Disc.) label and field
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Adding static text
totheframe

(Contd)

Sep Action

20 The Invoice Details frame now should look like this;

Inwolce Detalls
el m— :“
Tau-pui't[)ate|:|
| P.0O. Drabar I:l
| Delteay Date |:|

Iz bm, |

Cugtomer's P.O. Mo |

0 afver Mobe Kumber |

e e (L —

Mamn | |

Addies Line 1

#ddies Line 3

| |
Addies Line 2 | |
| |
| |

dddins Line 4

Post Coda

[ ]

Pk T

Iz b ok

Ling Ibems *

Note

Depending on the size of your monitor, you will see more or fewer of the
fieldsin the example above. To see fields that are not displayed currently
on the frame, use the scroll bar to scroll down the frame.

You will add static text (text that is aways included in the screen entry template) to the
Invoice Details frame for these three purposes.

» Tolabd the area of the frame containing customer detail fields
» Toadd column headings to the Line Items list box
» To add column headings to the VAT Summary list box

When you moved the fields on the frame, you already left space in the appropriate
locations for the static text. In this section of the tutorial, you will add the static text and
move it to the proper locations in the frame.
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How to add the
customer details
label

How to add
column headings
tothelineitemslist
box

Use this procedure to add static text that will label the group of customer detail fields on

the frame.
Sep Action

1 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame. If the template is larger
than the frame (there is a scroll bar on the right side of the frame), the
static text is displayed in the upper |eft corner of the part of the template
that is displayed, not at the top of the template.

2 Select the new text field and enter CUSTOMER DETAILS, al in capital
letters. The Text Properties dialog is displayed as you are typing. Click
OK to add the text.
System Response
The text you added is displayed in the upper left corner of the frame.

3 Select the CUSTOMER DETAIL S static text and drag it below the

Delivery Note Number label and field (The left margin of the static text
should be aligned with the left margin of the Delivery Note Number
label.).

Sterling Gentran: Server labels the fields on the Line Items frame, but does not label the
column headings for the Line Items list box on the Invoice Details frame. The Line Items
list box displays the information entered into the fields on the Line Items frame. To label
the columnsin the Line Items list box, you must add the column headings with static text.

After you add the column headings and move each column heading to its proper location,
the Line Items list box and the column headings should look like this:

Lie ez

lles Produet Ly, Frice:

Use this procedure to add and position the column headings.

Step

Action

Click Add Text on the Main Toolbar.

System Response

Text isadded to the current frame, displayed in the upper left corner of the
frame. If the template is larger than the frame (there is a scroll bar on the

right side of the frame), the static text is displayed in the upper left corner
of the part of the template that is displayed, not at the top of the template.
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(Contd)
Sep

Action

2

Select the new text field and enter Item. The Text Propertiesdialog is
displayed as you are typing. Click OK to add the text.

Click and drag it to above the Line Items list box, starting about 1 cm
from the left margin of the list box (so it looks like the example on 3 -
125).

Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

Select the new text field and enter Product. The Text Properties dialog is
displayed as you are typing. Click OK to add the text.

Click and drag it to above the Line Items list box, to the right of the Item
column heading.

Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

Select the new text field and enter Qty. (note the full stop in the text). The
Text Propertiesdialog is displayed as you are typing. Click OK to add the
text.

Click and drag it to above the Line Items list box, nearly 8 cm. from the
left margin of the list box.

10

Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

11

Select the new text field and enter Price. The Text Propertiesdialog is
displayed as you are typing. Click OK to add the text.

12

Click and drag it to above the Line Items list box, near the right margin of
the list box.

13

To ensure that the column headings (static text) you just added are aligned
properly, select al the static text you just added (Item, Qty., Product,
Price). Select Align Controlsfrom the Display menu, then select Top
from the Align Controls cascading menu.

Note
To select agroup of items, click and drag the mouse diagonally across all
the items you want to select.

Adding column  Sterling Gentran: Server labels the fields on the VAT Summary frame, but does not |abel
headingsto the vat the column headings for the VAT Summary list box on the Invoice Detailsframe. The VAT
summary list box Summary list box displays the information entered into the fields on the Line Items frame.
To label the columnsin the VAT Summary list box, you must add the column headings
with static text.
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After you add the column headings and move each column heading to its proper location,
the VAT Summary list box and the column headings should look like this:

WAT
Code : WAT Habe - Lires Subkalel

WAT Summay 1]

+*

Use this procedure to add and position the column headings.

Sep Action

1 Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

2 Select the new text field and enter Code. The Text Propertiesdialog is
displayed as you are typing. Click OK to add the text.

3 Click and drag it to above the VAT Summary list box, immediately to the
right of the left margin of the VAT Summary list box (so it looks like the
exampleon 3 - 127).

4 Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

5 Select the new text field and enter VAT. The Text Propertiesdialog is
displayed as you are typing. Click OK to add the text.

6 Click and drag it to above the “ Code” static text.

7 Click Add Text on the Main Toolbar to add text to the current framein the

upper left corner.

8 Select the new text field and enter VAT Rate. The Text Properties dialog
isdisplayed as you are typing. Click OK to add the text.

9 Click and drag it to above the VAT Summary list box, about 1 cm from the
left margin of the list box.

10 Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

11 Select the new text field and enter Lines Subtotal. The Text Properties
dialog isdisplayed as you are typing. Click OK to add the text.

12 Click and drag it to above the VAT Summary list box, nearly to the right
margin of the list box.
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(Contd)
Sep

Action

13

To ensure that the column headings (static text) you just added are aligned
properly, select the following static text:

] Code
» VAT Rate
» LinesSubtotd

14

Select Align Controls from the Display menu, then select Top from the
Align Controls cascading menu.

Note
To select agroup of items, click and drag the mouse diagonally across all
the items you want to select.

15

Select the VAT and Code static text.

16

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu.

17

The Invoice Details frame now should look like this;

Note

Depending on the size of your monitor, you will see more or fewer of the
fields in the example above. To see fields that are not displayed currently
on the frame, use the scroll bar to scroll down the frame.
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How to set thetab
sequence on the
invoice details
frame

The tab sequence is the order in which the cursor moves from field to field in the screen
entry translation object when a user presses TAB. When you create a screen entry form,
the system automatically positions the fields and sets the tab sequence for those fields.
However, you usually will want to modify the tab sequence of the fields to meet your
screen entry requirements and the new positions of the fields on the frame.

Use this procedure to set the tab sequence for the fields on the Invoice Details frame.

Sep

Action

1

Select Set Tab Order from the Display menu. Numbers are displayed in
the fields on the frame to indicate the current tab sequence.

Note

Depending on the size of your monitor, you will see more or fewer of the
fieldsin the example above. To see fields that are not displayed currently
on the frame, use the scroll bar to scroll down the frame.
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(Contd)
Sep

Action

2

Click thefields and list boxes listed below in the order in which they are
listed. Asyou click each field, the tab sequence number for that field will
change to the next sequential number in the tab sequence.

Note

If you click afield out of sequence, you must begin setting the tab
sequence again. To start over, select Set Tab Order from the Display menu
so that the tab sequence numbers are no longer displayed in the fields on
the frame, and then begin these steps again.

Invoice No.

Invoice Date

Tax-point Date

Customer’s PO. No.

P.O. Date

Delivery Note Number

Delivery Date

Location ANA Code

Location Own Code

Name

AddressLine 1

AddressLine 2

AddressLine 3

AddressLine 4

Post Code

Payment Terms

Invoice Notes (first field)

Invoice Notes (second field, unlabelled)
Invoice Notes (third field, unlabelled)
Invoice Notes (fourth field, unlabelled)
Line Items

VAT Summary

Invoice Amount (Excluding VAT)
Invoice Amount (Ex. Settlement Disc.)
Invoice Amount (Ex. VAT Inc. Sett.)

. VAT Totd

aa. Tota Invoice Amount (Inc. Sett. Disc.)

NS XS<EM VW TQDOSI AT T TQ 000

The new tab sequence should look like this:

Note

When you click the last field in the sequence (Total Invoice Amount (Inc.
Sett. Disc.)), the tab sequence is set, and the tab sequence numbers no
longer are displayed in the fields.

Note

Depending on the size of your monitor, you will see more or fewer of the
fields in the example above. To see fields that are not displayed currently
on the frame, use the scroll bar to scroll down the frame.
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Arranging the Fieldson theLineltems Frame

Overview

How toresizethe
lineitemsframe

Forms Integration TRADACOMS Tutorial Guide

Now that the fields, labels, and static text are arranged on the Invoice Details frame, you
are ready to arrange the fields on the Line Items frame. You will place the fieldsin a
logical order, then align the fields (as you did with the fields on the Invoice Details frame)
to give the frame a consistent and orderly appearance. When you finish arranging the
fields, the Line Items frame in your form should look like the one in the example bel ow.

Line hems

et - R —
Suppier's Product Cods | |

Cuchome's Product Code | |

Cluanliy I:l Uk of plmerziam I:E

Unil Piiea [Ex WAT) | | W4T Code |:| EI

Dreaacrnlion |

=

Before you begin arranging the fields on the Line Items frame, you should resize the frame
so that it isthe same width asthe Invoice Detail s frame. When thisform is compiled into a
tranglation object, the fields will be arranged according to how the frames and the fields
contained on them were arranged when the form was compiled. You should eliminate
unnecessary space as you arrange the fields on each frame.

Note
When theform is generated, the upper left corner of each frameintheformisplacedinthe
upper left corner of the Layout Window.

Sep Action
1 Click the ILD group (in the ODD group) to display the Line Items frame
in the Layout Window.
2 Toresizethe Line Items frame, click and drag the right side of the frame

to the 14 cm mark on the ruler so that the form is wide enough to format
the fields according to the instructionsin this tutorial .

Note
Use the horizontal ruler at the top of the frame to help you resize the
frame.
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(Contd)
Sep

Action

3

To display more of the form on your screen, click and drag the centre bar
between the EDI File Format Window and the Layout Window to the left
until the Layout Window iswide enough to display as much of theform as
you want to view.

The Line Items frame now should look like this;

Line kems

I

ot E—

E4M Coda

Supplien's Prioduct Code

Cuatomes’s Product Cods |

Bty [ |

Lrit of M=awre

Uik Piice: |[Ex YAT]

Yot Code:

=

Dexciiption |

O

How toresizethe
fields

Use this procedure to resize the fields on the Line Items frame of the screen entry form.

Step

Action

1

Select the following fields:

» Item No.
» Quantity
Note

To select more than one field, click thefirst field, then press CTRL and
click the second field. Repeat the process of pressing CTRL and clicking
the field for each subsequent field you want to select.

Select Size to Length from the Display menu. All selected fields will be
resized to the lengths specified in the Display Length field of the Display
Properties dialog for each field.
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How to move and Use this procedure to move and align thefields on the Line Items frame of the screen entry

align thefields  form.

Sep

Action

1

Select the Unit of Measure field and drag its bottom handle so that the
field islong enough for four codes to be displayed in it when the drop-
down part of the drop-down list is open (approximately 2 cm on the
vertical ruler).

Note
Use the vertical ruler to the left of the frame to help you measure length.

Select the VAT Code and Unit of Measure fields (in that order).

Note
Select the Unit of Measure field last, so that it is the reference.

Select Size Equally from the Display menu. The VAT Code field isthe
same size as the Unit of Measure field.

Note

The Unit of Measure and VAT Code drop-down list boxes have slightly
different appearances. When the Exclusive check box is marked in the
Advanced section of the Field Properties dialog, the text box is attached to
the drop-down arrow. When the Exclusive check box is not marked, there
is a gap between the text box and the drop-down arrow.

Select each field and list box on the frame individually and move it closer
to its respective label.

Click the Lock L abels button on the Main Toolbar to turn on the L ock
L abelsfunction. When you select afield, its corresponding field 1abel will
be selected also.

Select the Item No. label and field and drag them to the upper left corner
of the frame. (When you select the field, its label will be selected, too,
because you have the Lock Labels function turned on.)

Select the EAN Code label and field and drag them to the upper right
corner of the frame.

Select the following fields and labels and drag them below the Item No.
label and field:

» Supplier’s Product Code
» Customer’s Product Code
» Quantity

Select the Unit of M easurelabel and list box and drag them to the right of
the Quantity label and field.
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(Contd)
Sep Action

10 Select the Unit Price (Ex. VAT) label and field and drag them below the
Quantity label and field.

11 Select the VAT Code label and field and drag them under the Unit of
Measure label and list box.

12 Select the Description label and field and drag them below the Unit Price
(Ex. VAT) label and field.

13 Click the Lock L abels button on the Main Toolbar to turn off the L ock
L abels function.

Resizingtheline  ToresizetheLine Itemsframe, click and drag the bottom of the frame to below the
itemsframe  Description label and field.

Note
Allow enough space between the Description label and field, and the bottom of the frame,
for the VAT Code drop-down list box to be opened.

The Line Items frame now should look like this:

Line kems
e — e —
Euppliad'e Froduct Coda | |
Custamer’s Product Cade | |
Buenixy :l Uri of Menzue :E
Uni Price [Ex. WAT) | VAT Coda I:l EI
Diaccriptan | |
3.
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How to align the
fieldsand field

Use this procedure to align the fields and field labels on the Line Items frame.

|abels
Sep

Action

Select the following field labels:

» Item No.

» Supplier's Product Code

» Customer’s Product Code

» Quantity

» Unit Price (Ex. VAT)

» Description

Note

To select more than one field, click thefirst field, then press CTRL and

click the second field. Repeat the process of pressing CTRL and clicking
the field for each subsequent field you want to select.

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected field
labels are aligned.

Select the following fields:

» ItemNo.

» Supplier's Product Code
» Customer’s Product Code
» Quantity

» Unit Price (Ex. VAT)

Note
Select the Customer’s Product Code field last, so that it is the reference.

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. Theleft margins of the selected fields are
aligned.

Select the following labels:

» EAN Code

» Unit of Measure
» VAT Code
Note

To select agroup of items, click and drag the mouse diagonally across all
the fields and labels you want to select.

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected field
labels are aligned.

Forms Integration TRADACOMS Tutorial Guide
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(Contd)
Sep

Action

7

Select the following field and list boxes:

» EAN Code

» Unit of Measure
» VAT Code
Note

Select the Unit of Measure list box last, so that it is the reference.

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected items are
aigned.

Select the Description and EAN Code fields.

Note
Select the EAN Codefield last, so that it is the reference.

10

Select Align Controlsfrom the Display menu, then select Right from the
Align Controls cascading menu. The right margins of the of the selected
fields are aligned.
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(Contd)
Sep

Action

box

11 To alignthetopsof all of thefield labels, fields, and list boxes, select each
row of items (one row at atime), select Align Controls from the Display
menu, then select Top from the Align Controls cascading menu. Theitems
in each row are listed below:

» Item No. label and field and EAN Code label and field

» Supplier’s Product Code label and field

» Customer’s Product Code label and field

» Quantity label and field and Unit of Measure label and drop-down list

» Unit Price (Ex. VAT) label and field and VAT Code label and drop-
down list box

» Description label and field

The Line Items frame now should look like this;

Line Heme
et — R —
Sunplers Prochact Cods | |
Cucsome's: Froduct Code | |
Qluanliy I:l Unk of Mezum I:E
Uil Piim [Ex WAT) | | WTCak [ ][]
Dsacriplion | |
1=
How to set thetab Use this procedure to set the tab sequence of the fields on the Line Items frame.
sequence on the
lineitemsframe
Sep Action
1 Select Set Tab Order from the Display menu. Numbers are displayed in
the fields on the frame to indicate the current tab sequence.

Forms Integration TRADACOMS Tutorial Guide
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(Contd)
Sep

Action

2

Click thefields listed on the next page in the order in which they are
listed. Asyou click each field, the tab sequence number for that field will
change to the next sequential number in the tab sequence you are now
setting.

Note

It isimportant to click each field in the order listed below. If you click a
field out of sequence, you must begin setting the tab sequence again. To
start over, select Set Tab Order from the Display menu so that the tab
sequence numbers are no longer displayed in the fields on the frame, and
then begin these steps again.

a.  EAN Code

Supplier’s Product Code
Customer’s Product Code
Quantity

Unit of Measure

Unit Price (Ex. VAT)
VAT Code

Description

Item No.

‘Te@mpapCT

Note

The Item No. field isthe last field in the tab sequence, athough it isthe
first field in the layout of the Line Items frame. Thisfield is display-only,
displaying the next consecutive lineitem number (the line item number is
generated by an extended rulein the ILD group). By placing the Item No.
field last in the tab sequence, thisfield can be skipped easily by users
entering data. Thefirst field in the sequenceisthe EAN Codefield, which
isthe first field into which users can enter avalue.

10

The new tab sequence for the Line Items frame should look like this:

LInE hems
i I |

l1@m Mo, D

Suppiers Product Cods E |

Cuptomer's Product Code ﬂ |

Quaniity Unk of Messauns

Uril Piicaa [Ek. WAT] H T Code E E

Deacsplicn m |

|
Note

When you click the last field in the sequence (Item No.), the tab sequence
is set, and the tab sequence numbers no longer are displayed in the fields.
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Arranging the Fields on the VAT Summary Frame

Overview  Just asyou arranged thefields, labels, and static text on the Invoice Details and Line Items
frames, now you will arrange the items on the VAT Summary frame. You will place the
fieldsin alogical order, then align the fields to give the frame a consistent and orderly
appearance. When you finish arranging the fields, the VAT Summary frame in your form
should look like the one in the example bel ow.

VAT Summany J‘
+

AT Codn
AT Aam
Mumber ol Line |lemz

L]

1]

[ ]
Lirex Subinlal [Excuding VAT] :l

]

1

UAT Amout Papabla

Fapable Subtold |Inc, S, Dies |

L+

How toresizethe  Before you begin arranging the fields on the VAT Summary frame, you should resize the
VAT summary  framesothat it isthe same width as the Invoice Details and Line Items frames. When this
frame  formiscompiledinto atranslation object, the fields will be arranged according to how the
frames and the fields contained on them were arranged when the form was compiled. You
should eliminate unnecessary space as you arrange the fields on each frame.

Note
When the form is generated, the upper left corner of each framein theformisplacedinthe
upper left corner of the Layout Window.

Sep Action
1 Click the STL segment to display the VAT Summary frame in the Layout
Window.
2 To resize the VAT Summary frame, click and drag the right side of the

frameto the 14 cm mark on theruler, so that all the fields on the frame are
visible. After you arrange the fields on this frame, you will resize the VAT
Summary frame so that it matches the other framesin the invoice.

Note
Use the horizontal ruler at the top of the frame to help you resize the
frame.
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(Contd)
Sep Action

3 To display more of the form on your screen, click and drag the centre bar
between the EDI File Format Window and the Layout Window to the left
until the Layout Window iswide enough to display as much of theform as
you want to view.

The VAT Summary frame now should look like this:

VAT Summary
m
VAT Codn |:|
e —
Humber ol Line b I:l
Lirme Subkalal [Excluding WAT| I:l
v ot Pt I—

Fapable Sublobs [Inc. Sell, 0|

]
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How toresizethe  Sterling Gentran:Server bases the lengths of fields on the widths of lowercase letters. For
VAT codefield example, if afield has a display length (defined on the Display Properties dialog) of five,
then Sterling Gentran: Server produces afield with alength able to accommodate the
average width of lowercase letters.

The VAT Code field will contain a code in an uppercase |etter. Therefore, you should
adjust the width of the field to prevent the code in the VAT Code field from being

truncated.

Use this procedure to resize the VAT Codefield.

Sep

Action

1

Select the VAT Code field.

2

Drag itsright or left handle so the field is approximately twice as wide as
its original width.

How to move and Use this procedure to move and align the fields on the VAT Summary frame of the screen

align thefields  entry form.

Step

Action

1

Select the VAT Amount Payable and Payable Subtotal (Inc. Sett. Disc.)
fields and labels, and drag them closer to the Lines Subtotal (Excluding
VAT) field and label.

Note
You may need to temporarily adjust the width of the frame so that the
Payable Subtotal (Inc. Sett. Disc.) field isvisible.

Select all of the fields on the frame.

Note
Select the VAT Amount Payable field last, so that it is the reference.

Select Align Controls from the Display menu, then select L eft from the
Align Controls cascading menu. The left margins of the selected field
labels are aligned.
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How toresizethe  Usethis procedure to resize the VAT Summary frame.
VAT summary
frame Sep Action

1 Click and drag the bottom of the frame to below the Payable Subtotal (Inc.
Sett. Disc.) label and field.

The VAT Summary frame now should look like this:

VAT Summary J‘
+

YT Coda
YAT Rata
Mumber al Ling Ibemz

[

[

[ ]
Lines Subtaid (Evchuding WAT) ]

[ ]

[ ]

VAT amouk Papable

Papabla Subtnld [Inc Seit. Diec |

[=]]

Whereas in the Invoice Details and Line Items frame you set the tab sequence for the
fields on the frames, you do not need to set the tab sequence for the VAT Summary frame.
All the fields on this frame (other than the hidden fields) are display-only. Screen entry
tranglation object users will not be able to enter avalue in any of the fields, so the tab
sequenceisirrelevant.
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Changing the Invoice Details Frame Title

Overview  Thesystem automatically titlesthe framesin a screen entry form when the form is created,
based on the name of thefile, segment(s), or group(s). You can modify the frametitles (for
example, at the file or message level) to distinguish one form from the others. The parent
frame of the invoice currently istitled Invoice Details. You will give this frame amore
descriptive title to distinguish it from other invoices that your company uses.

Procedure  Usethis procedure to change the frametitle.

Sep Action

1 Click the INVOIC file icon with the right mouse button to access the
shortcut menu.

2 Select Properties from the shortcut menu.

System Response
The File Format Properties dialog is displayed.

3 In the Frame Caption field, enter TRADACOMS ANAOOL INVOIC
Release 9 - Pet Zone.

4 Click the OK button.

System Response
The new frametitle is displayed in the frame title in the Layout Window.

5 Click Generate Layout on the Main Toolbar to refresh the display of the
screen entry form.

6 Select Save from the File menu to save the form.

You have completed your Invoice form. Now, you are ready to finalize the form.
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Finalize the Form

Overview

Introduction Now that you have created and customized a screen entry form, you are ready to compile
the form to generate the translation object (*.TPL) that Sterling Gentran; Server uses
before you print the report and test the compiled trandlation object.
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Compiling the Form

Overview  The Compile function compiles the form. The form that you create using Sterling
Gentran: Server is a source form. When that source form is compiled, the result isa
compiled translation object.

This tranglation object must be registered with the Sterling Gentran: Server system before
you can useit. You will use the Compile function after the form is completed and saved.

Procedure  Usethis procedure to compile the form.

Sep Action

1 Select Compile from the File menu to display the Run-Time Trandlation
Object Name dialog.

Run-Time Transzlation Object Hame

Save in; I 5 TransObi

Pet_810s.tpl

File narme: IpE‘.‘lliI"l'-r'S.TF'L
Save as lype: ITransIatinn Objects = TFL) j Cancel |

2 Click Save to accept the trandlation object name (pettinvs.tpl) in the “File
name” field.

This name for the compiled translation object (.TPL file) is the same
filename as the source form (.STP file). Preserving the same filename
(with different file extensions) ensures that the relationship between the
source form and the compiled translation object remains evident.

CAUTION

BE VERY CAREFUL NOT TO OVERLAY THE SOURCE
FORM WITH THE COMPILED TRANSLATION OBJECT.
USE THE .TPL FILE EXTENSION TO DISTINGUISH THE
COMPILED TRANSLATION OBJECT.

The system will compile the form and generate an error report. The error
report is displayed in the Compile Errors dialog.
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(Contd)
Sep Action

3 Click OK to exit the Compile Errors dial og.

Note

If the Compile Errors dialog contains errors, you must fix the problem(s)
by redoing the appropriate section of the tutorial. Recompile the form
after you correct the error(s) and save the form.

4 Select Save from the File menu to save the form. The date on which you
compiled the form is loaded automatically into the Compiled on field on
the Trandlation Object Details dialog.

Sterling Gentran:Server — May 2011 Forms Integration TRADACOMS Tutorial Guide



Printing the Report

Overview  The Sterling Gentran: Server report enables you to validate and review the translation
object, and make modifications as needed. If you review the report and determine that the
tranglation object isincorrect, you should reiterate the form creation process as many
times as necessary (make the modifications, save the form, recompile the form, and print
the report again).

Procedure  Usethis procedure to print the Sterling Gentran: Server report.

Step

Action

1

Select Print from the File menu to access the Print Options dial og.

Click OK to accept the defaults on thisdialog (all options marked), so the
report includes al sections and only the activated form components.

System Response
The Print dialog is displayed.

Do you need to change setup options (to select a specific printer, paper
orientation, or size and source of paper) ?

» If yes, click Properties. Set the appropriate options. Click OK to
begin the print process.

» If no, click OK to begin the print process.
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Testing the Trangation Object

Overview  After you compilethe form, print and verify the report, and register the translation object
with Sterling Gentran: Server, you should test the translation object to verify that the data
istrandated correctly. To test the compiled trandlation object, you should use the
trand ation object to create a new document. You also should verify acknowledgement
processing (if applicable) and verify communications with your network.

Important

The trandlation object must be registered with the Sterling Gentran: Server system before

you can useit.

Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows User Guide for
information on registering the translation object.

Procedure  Usethis procedure to test the screen entry translation object you just created.

Step

Action

Register the PETTINVS.TPL trandation object with Sterling
Gentran:Server.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on registering a translation object.

If you have not done so aready, import the PETZONE4.PAR partner
relationship into Sterling Gentran: Server.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on importing a partner.

Import the division lookup table (INVAT CO.L K P) for the system partner
(Internal System User) into Sterling Gentran:Server.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on importing a table.

The default full path for the lookup tableis:
C\GENSRVNT\TUTORIAL\INVATCO.LKP
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(Contd)

Sep Action
4 Verify (in Partner Editor) that the Screen TRADACOMS INVOIC Pet
Zone screen entry trandation object is selected for the Outbound
Relationship.
Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on selecting outbound translation objects.

5 Create a new document (partner PETZONE4 and relationship
PETZONE4 TRADACOMS INVOIC) to enter the datain the screen
entry translation object you created.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on creating a document.
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Notices

Thisinformation was devel oped for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program, or
service is not intended to state or imply that only that IBM product, program, or service
may be used. Any functionally equivalent product, program, or service that does not
infringe any IBM intellectual property right may be used instead. However, it isthe user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not grant you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.SA.

For license inquiries regarding double-byte character set (DBCS) information, contact the
IBM Intellectual

Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law

IBM Japan Ltd.

Forms Integration TRADACOMS Tutorial Guide Sterling Gentran:Server — May 2011



1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

Thefollowing paragraph doesnot apply to the United Kingdom or any other country
wheresuch provisionsareinconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION "ASIS' WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do
not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

Thisinformation could include technical inaccuracies or typographical errors. Changes
are periodically made to theinformation herein; these changes will be incorporated in new
editions of the publication. IBM may make improvements and/or changes in the
product(s) and/or the program(s) described in this publication at any time without notice.

Any references in thisinformation to non-IBM Web sites are provided for convenience
only and do not in any manner serve as an endorsement of those Web sites. The materials
at those Web sites are not part of the materials for thisIBM product and use of those Web
sitesisat your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which has
been exchanged, should contact:

IBM Corporation

JBAIGA

555 Bailey Avenue

San Jose, CA__95141-1003

U.SA.

Such information may be available, subject to appropriate terms and conditions, including
in some cases, payment of afee.

The licensed program described in this document and al licensed material available for it
are provided by IBM under terms of the IBM Customer Agreement, IBM International
Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly.
Some measurements may have been made on devel opment-level systems and thereis no
guarantee that these measurements will be the same on generally available systems.
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Furthermore, some measurements may have been estimated through extrapolation. Actual
results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has not
tested those products and cannot confirm the accuracy of performance, compatibility or
any other claimsrelated to non-IBM products. Questions on the capabilities of non-IBM
products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Thisinformation is for planning purposes only. The information herein is subject to
change before the products described become available. This information contains
examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examplesinclude the names of individuals, companies, brands,
and products. All of these names are ficticious and any similarity to the names and
addresses used by an actual business enterpriseis entirely coincidental.

COPYRIGHT LICENSE:

Thisinformation contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy, modify,
and distribute these sample programs in any form without payment to IBM, for the
purposes of developing, using, marketing or distributing application programs conforming
to the application programming interface for the operating platform for which the sample
programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs. The sample programs are provided "ASIS", without warranty
of any kind. IBM shall not be liable for any damages arising out of your use of the sample
programs.

Each copy or any portion of these sample programs or any derivative work, must include a
copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations may
not appear.

Trademarks I1BM,thelBM logo, and ibm.com are trademarks or registered trademarks of International
Business Machines Corp., registered in many jurisdictions worldwide. Other product and
service names might be trademarks of IBM or other companies. A current list of IBM
trademarks is available on the Web at “ Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or
other countries.
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www.ibm.com/legal/copytrade.shtml

IT Infrastructure Library is aregistered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered
trademarks of Intel Corporation or its subsidiariesin the United States and other countries.

Linux is aregistered trademark of Linus Torvaldsin the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

ITIL isaregistered trademark, and a registered community trademark of the Office of
Government Commerce, and isregistered in the U.S. Patent and Trademark Office.

UNIX isaregistered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle and/or its affiliates.

Cell Broadband Engine is atrademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks of
HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Rea time®, Gentran: Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of others.
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GLOSSARY

Glossary

?In Documents  This Sterling Gentran: Server browser contains alist of messages that were received by the
system but failed compliance checking or that do not have an identifiable partner or
transaction set.

?0ut Documents  This Sterling Gentran: Server browser contains a list of messages that were imported into
the system via unattended processing but are invalid.

acknowledgement  Thisterm is used to indicate the ANSI 997 functional acknowledgement, the EDIA 999
acceptance/rejection advice, and the EDIFACT CNTRL message.

activation This function enables you to make map components available for use. The system
activates all the groups, segments, composites, and elements that are defined as
“mandatory” (must be present) by the standard. The system does not enable you to
deactivate the mandatory groups, segments, composites, and elements. When trandlating
data, the system does not process groups, segments, composites, and elements (or records
and fields) that are not activated. Therefore, you must activate the groups, segments,
composites, and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

AIAG  The Automotive Industry Action Group (AIAG) is the standards-setting group for the
automotive industry. The standards form a subset of the ANSI X12 standard.

ANA  Article Numbering Association.

ANSI American National Standards Institute. ANSI sets standards for many products and
services, such as safety glasses and battery capacities. The ANSI X12 committeeisthe
chief EDI standards-setting organisation for the United States.

application file  If you are creating an import or export map, you must define your application to the
Application Integration subsystem. In Sterling Gentran: Server terminology, your
application fileis also referred to as a fixed-format file or a positional file. Your
application file must contain all the information that you either need to extract from your
partner’s message (if the map is inbound) or need to send to your partner (if themapis
outbound), so that your system can accurately process the data.
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application system

browser

check box

codelist tables

colours

communications
session

Communicator

compile

compliant

component data
element

composite data
element

Computer systems, outside of EDI, designed to fulfil specific business functions. These
include accounting, purchasing, materials control, human resources, shipping, and other
systems.

A browser isawindow that displaysalist of items, such as messages (transaction sets),
interchanges, tranglation objects, etc. A message browser displays only messages.

A check box enables you to select or clear options from alist. You can select as many
options from the list as you need. A selected check box contains a checkmark. The labels
of unavailable options are dimmed.

These are used by EDI standards as repositories for lists of codes. Each EDI standard
provides a code list for each element that can be further defined with a code.

This feature enables you to select foreground and background colours to visually define
the various map components. The use of colour is optional.

Everything sent and received to/from one tel ephone number in one continuous period of
connection. This could include sending two or three interchange envel opes to a network,
each for adifferent trading partner.

Thisisthe Sterling Gentran: Server communications software. The Communicator enables
you to send, receive, resend, establish communication port definitions, establish
communication profiles, establish communication scripts, and view and delete
communication sessions.

This function compiles the form and creates atranslation object. The form that you create
using Sterling Gentran: Server is a source form. When that source form is compiled, the
result is a compiled translation object. This translation object will need to be registered
with the Sterling Gentran:Server system before you can use it.

This means that the message conforms to the EDI standards as defined by the translation
object.

A simple data element that bel ongs to a composite data element. Component data
elements are also called sub-elements.

A contains two or more component data elements or sub-elements. Composites are
defined by the EDI standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards).
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Seerelational conditions.

This standard rule enables you to move aliteral constant value to the specified element or
field, indicate a qualifying relationship with another element or field, and map the current
date or time to the specified element or field.

Thistable is created in Partner Editor and is used to convert your values to your trading
partner's values during outbound processing, or your partner's values to your values during
inbound processing.

Thistype of field or element contains a date or time. If you specify that afield or element
will be a date/time type, you must specify exactly how the date or time must be formatted.

This function enables you to make map components unavailable for use by the system.
The system does not enable you to deactivate the mandatory groups, segments,
composites, and elements.

A predefined value — programs use these built-in values unless you specifically override
them.

One transaction set containing actual data and treated as a single entity. The amount of
data does not affect whether something is a message or not, only the fact that it is treated
asasingle entity. For example, regardless of whether a purchase order contains oneitem
or ten thousand, if it is one purchase order, it is one message.

If atrading partner sends you a communication containing 10 purchase orders, you have
received 10 messages. If the communication contained 15 invoices, you have received 15

messages.

International Article Numbering Association, Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can exchange
business messages directly from application to application by computer without paper
messages being produced.

The EDI File Format Pane contains the EDI file format. When you click a segment or
group in the EDI file format, the corresponding frameis displayed in the Layout Window.
When you click an element in the EDI file format, the corresponding layout component is
highlighted in the Layout Window.
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EDI standard  Thisisthe rules for turning a business message into an EDI message.

EDIA  The Electronic Data Interchange Association, formerly known as the Transportation Data
Coordinating Committee (TDCC).

EDIFACT  Thisisthe standards organisation of the United Nations Economic and Socia Council.
The acronym is short for the Electronic Data Interchange for Administration, Commerce,
and Transport.

element The smallest piece of usable information defined by the standards. Examples might
include a quantity, unit price, or description. An individual element can have somewhat
different meanings depending on context. Therefore, elements are normally not
considered to have useful meaning until they are combined into segments. An element is
the EDI map component that is mapped (linked) to a corresponding application field to
move data to and from the EDI file.

There are three types of data elements, asillustrated in the table below:

Data Element Definition

Simple dataelement | A single piece of information
defined by the standards.

Composite data A data element that is made up of
element multiple component elements.
Component data A simple data element that belongs
element to acomposite data el ement.

Component data elements are also
called sub-elements.

envelope A way of separating information in transmissions for ease of processing. Each envelope
contains a header segment and a trailer segment, which separate the envel ope from other
envelopes and provide information about the contents of the envelope.

There are three levels of envelopes, asfollows:

Transaction Set
Each transaction set (business message) is contained within atransaction set envelope.

Functional Group
An envelope containing related business messages. The standards define which
transaction sets should be placed together into a functional group envelope.
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equalize

export map

export trandation

object

extended rules

field

fixed-format file

form

frame

functional group

Interchange Envelope

All material being sent to onetrading partner in one communication. The term Interchange
Envelopeisthe term used by ANSI. EDIA uses the term Transmission Envelope to refer
to thislevel of envelope. Since we use the term transmission for other uses, we will refer
to Interchange Envelope only.

Note

A communications session could easily include a number of interchange envel opes. For
this reason, the standards-setting bodies are considering afourth level of envel opeto cover
an entire communications session.

This function enables you to reinstate the two sides of the map with focusin equal
dimensions. The use of the Equalize function is optional.

This map defines how to move data from the EDI standard-formatted messages that your
partners send you to your application file (flat file definition). An export map is necessary
for inbound processing.

See export map.

These rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any mapping operation you require.

The smallest piece of information defined in the application file. A field is the application
map component that is mapped (linked) to a corresponding EDI element to move data to
and from your application file.

See application file.

A formisaset of instructions you define in the Forms Integration subsystem that indicates
how the system should format data.

A frame contains the groups, repeating segments, and elements at that level (single
segments are not represented on the frame). Sterling Gentran: Server uses framesto format
the EDI file for the trandation object.

A group of transaction sets that the standards-setting body (such as ANSI) has defined as
fitting together with other related transaction sets. An example might be a Functional
Group defined as containing all purchasing transaction sets.
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group

import

import map

import translation
object

inbound mapping

In Documents

In Drawer

integer

interchange

I nterchanges
browser

A looping structure that contains related records/segments and/or groups that repeat in
sequence until either the group data ends or the maximum number of timesthat theloopis
allowed to repeat is exhausted. If you create agroup that is subordinate to another group (a
sub-group), this corresponds to a nested looping structure (aloop within aloop). The
application (positional) file and the EDI file are both groups and therefore, they isvisually
represented the same way as other groups and sub-groupsin Sterling Gentran: Server.

This command enables you to import datafrom an external application file. Depending on
the content of the file, the system may prompt you for partner, transaction, or translation
object information.

This map defines how to move data from your application file (flat file definition), which
may contain multiple messages, to the EDI standard-formatted messages that your
partners expect to receive from you. An import map is necessary for outbound processing.

See import map.

The system translates your trading partner’s EDI standard formatted business message to
your application file format, so you can receive messages from you partners. To translate
inbound data, you need to create an export map.

This Sterling Gentran: Server browser contains alist of messages that the system received
but that have not yet been processed by the user. Once the messages are processed (printed
or exported) the messages will be transferred to the In Drawer.

This Sterling Gentran: Server browser contains alist of messages that were received and
processed.

An integer is a number that has an implied decimal point (e.g., “2.01" isformatted as
“201").

Theinterchange contains all the functional groups of messages (transaction sets) sent from
one sender to one receiver in the same transmission.

This Sterling Gentran: Server browser enables you to view a hierarchical list of al the
interchanges that were sent or received. It contains status information about the
interchanges, (e.g., whether or not afunctional acknowledgement was received and the
status of that acknowledgement). This browser also enables you to access the messages
within the interchanges. The I nterchanges browser can always be accessed.
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Layout Pane  The Layout Pane contains the actual format of the translation object. Each group (with a
maximum usage greater than one) and repeating segment has a corresponding frame in the
Layout Window. When you click a segment or group in the EDI file format, the
corresponding frame is displayed in the Layout Window. When you click an element in
the EDI file format, the corresponding layout component is highlighted in the Layout
Window.

list box A list box displaysalist of choices. Scroll bars are provided if there are more choices than
can fit in the box.

literal constant  These are used by the system as arepository to store information that will be used at a
later point in the map. Typically, constants are used in an outbound map to generate a
qualifier.

location table  Thisisatable created in Partner Editor that is used to contain address-related information
about the partner.

lookup table  Thisisatable created in Partner Editor that is used to select information related to avalue
in inbound or outbound data.

loop count This standard rule enables you to count the number of times aloop is repeated, if the
element or field is part of aloop. If theloop isanested |oop, you can track the current loop
or the outer loop. For example, if the Y loop is nested within the X loop, and the Y loop
has cycled through 15 iterations and the X loop has cycled through 3 iterations, you can
choose to count either the “15” (Y loop) or the “3” (X loop).

loop start/loop end  Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS and LE
segments differentiate between two or more loops of the same type. If the transaction
contains LS and L E segments and depending on whether your map is inbound or
outbound, you will need to define the LS and LE segments for the loops you will be using
in the map in one of two different ways.

map A setof instructions you define in the Application Integration subsystem that indicates the
corresponding relationship between your application file and the EDI standards, and
defines how the system should trand ate data.

networ k Also known as a Third Party Network or Value-Added Network (VAN) that accepts and
holds transmissions from companies until it is convenient for atrading partner to accept
them.
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number

ODETTE

outbound mapping

Out Documents

Out Drawer

partner

Partner Editor

positional file

post

predefined

printout

print trandation
object

Thistype of field or element contains either an integer or real number. If you specify that a
field or element will be a number type, you must designate the format by specifying a
format of either “N” (integer) or “R” (real) and the number of decimal places.

The Organisation for Data Exchange by Tele-Transmission in Europe.

The system tranglates your application file format to EDI standard formats, so you can
send messages to your partners. To tranglate outbound data, you need to create an import
map and a system import map in the Application Integration subsystem.

This Sterling Gentran: Server browser contains alist of messages that are ready to be sent.
After the messages are successfully sent, they are automatically transferred to the Out
Drawer.

This Sterling Gentran: Server browser contains alist of messages that were successfully
sent out by the system.

Another firm with which your company trades messages. Also referred to as atrading
partner.

This Sterling Gentran: Server function enables you to define, edit, and delete all partner
information for your company and all of your trading partners.

See application file.

This Sterling Gentran: Server function enables you to move compliant messages from the
Workspace to the Out Documents.

On adataentry translation object, adefault value for aparticular element. You can change
the value as necessary.

Thisis produced when data received from a trading partner passes through a print
tranglation object. You do not have to actually print the data. The printout could beto afile
on your hard disk.

A print translation object organizes and formats the printout of EDI messages that are
received from or sent to the trading partner(s) for which you have established atrading
relationship (inbound or outbound) that uses that print translation object. The print
transl ation object enables you to view the EDI message in an easily readable format.
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This function extracts one iteration (instance) of a group or repeating segment. This
enables you to map unique data from your application file, and/or enter a specialized
definition. Sterling Gentran: Server specifies that only one-to-one (no loops) or many-to-
many (loop) mapping relationships are valid.

Thisisan element that has a value expressed as a code that gives a specific meaning to the
function of another element. A qualifying relationship is the interaction between an
element and its qualifier. The function of the element changes depending on which code
the qualifier contains.

Radio buttons indicate a group of mutually exclusive options. You can only select one
option at atime. Select an option by clicking the radio button or pressing the Space Bar
until the option you want is selected. The selected option contains a black dot. The labels
of unavailable choices are dimmed.

A real number has an explicit decimal point (e.g., “2.01" isformatted as“2.01"), and
truncates trailing zeroes.

This Sterling Gentran: Server function enables you to manually initiate a communications
session to receive data from a network through an invocation of the Connection Manager.

Contains agroup of related fields. A record can occur once or can repeat multiple times.

This function enables to connect fields together for syntax or compliance reasons. For
example, Field A isinvalid unless Field B is present. Therefore, if you set up acondition
that pairs Fields A and B, the system will generate acompliance error if one of thosefields
is not present.

This Sterling Gentran: Server function enables you to create a turnaround message (using
the Turn Around translation object in the partner relationship) in response to one or more
selected message(s) in the In Drawer.

An organisation that devel ops and updates standards for EDI communications. These
organisations include ANSI, EDIA, AIAG, UCS, EDIFACT, ODETTE, and VICS.

A screen entry translation object provides a standardized format for keying an EDI
message into the Document Editor, for trandation and transmission to your trading
partner(s), for which you have established an outbound trading relationship that utilizes
that screen entry translation object. The screen entry trand ation object ensures that your
users key all the data necessary to create the required EDI message.
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segment

salect

send

set

simple mapping

split

standard rules

static text

status bar

A group of related elements or composite data elements that combine to communicate
useful data. Segments are defined by the EDI standards. A segment can occur once or can
repeat multiple times. For example, a catal ogue price segment might consist of elements
for item description, volume, price, lead time, etc. By themselves, none of these elements
would communicate useful information. Together, they provide the information necessary
for someoneto tell if theitem iswhat is desired, whether the priceis reasonable, etc. A
number of segments together form a transaction set.

This standard rule enables you to select entries from alocation table, cross-referencetable,
partner table, or lookup table (all tables created in the Sterling Gentran: Server Partner
Editor). You can then map the fields in those tables to one or more fields in the data. The
Select function uses the value of the current field to perform the selection.

This Sterling Gentran: Server function enables you to manually start a communications
session to send data to a network through an invocation of Connection Manager. Only
sel ected messages are enveloped and sent. If no messages are selected, ALL messageswill
be sent. Successfully sent messages are moved to the Out Drawer.

See Transaction Set.

Seelink.

This function enables you to split (break) a group or repeating segment into two loops.
You will typically use this function when you need more than one instance of the same
map component that still occurs multiple times.

Theserules give you access to functions that are necessary for mapping operationsthat are
more complex than simple linking, but less involved than extended rules. Each of the
standard rules are mutually exclusive (you can use only one on a particular field).

Static text istext that is always included in the screen entry or print translation object.
Examples of static text include legends and column headings. Field labels, which usually
accompany fields to identify the contents of the fields, are not considered static text.

The status bar of an application window definesinformation about a selection, command,
or process, defines Menu Bar items as the user highlights each item, and indicates any
current keyboard-initiated modes for typing (e.g., CAP for the “Caps Lock” key or NUM
for the “Num Lock” key, etc.).
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Thistype of field or element contains one or more printable characters. If you specify that
afield or element will be a string type, you must designate the format by specifying a
syntax token.

This function enables you to designate a“token” that defines ranges of characters and/or
numbers that are allowed to be used for a string-type element or field. You can then use
the syntax tokens in the Format field of the Field Properties dialog. This enables you to
define what type of characters should be used while compliance checking each element/
field (i.e., aphanumeric within a certain range, numeric within a certain range, etc.).

The translator uses this map to determine which trading relationship (established in
Partner Editor) corresponds to each message in the application file, so the system will
know which import map to use to process the message. You need a system import map
that is defined in EDIMGR.INI to trandlate outbound data.

See system import map.

These trandl ation objects control the creation and separation of interchanges, functional
groups, and transaction sets. They also used to generate and reconcile functional
acknowledgements. All the required system translation objects are automatically installed
with the Sterling Gentran: Server system.

See EDIA.

TDF isthe Transaction Data File. Thisfile serves as afilter between your message files
and the Sterling Gentran: Server trandlator. For outbound processing, dataisimported from
aTDF file and translated to EDI format using a TDF Import translation object. The datais
then ready to be posted and sent to your trading partner. For inbound processing, EDI
messages that are received by Sterling Gentran: Server can be exported to a TDF-formatted
file using a TDF Export translation object. This datafile is then ready to be processed or
converted to your internal application files.

See Network.

The title bar of an application window contains the name of the application and enables
you to move the window to another position on your desktop.

This contains buttons that graphically represent commands available in the Menu Bar.
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TRADACOMS  TheU.K. standards for EDI that are published by the Article Numbering Association
(UK) LTD.

trading partner Another firm with which you company trades messages. Also referred to as a partner.

transaction set A business form as defined by the standards. Examples include an ANSI 850 purchase
(message) order or an UCS 880 invoice. The standards define each transaction set in terms of the
segments and elements that make up the form, the order in which they appear, and the

relationships among them. Thisis also known as “message” in Europe.

trandlation object A predesigned layout set up to ensure that input or output for a particular transaction set
exists and is presented in a usable fashion. You must specify which translation object(s)
will be used by each partner relationship.

Inbound Trandation Objects:

Turn Around: Thistranslation object is used when amessage is received, to create the
natural response message that contains as many elements from the received message as
possible.

Export File: Thistranslation object indicates that when a message is received, it will be
exported to a specified file format.

Print: Thistrandation object is used to print messages.

Outbound Translation Objects:

Import: Thistranslation object is used to import data from an application file.
Print: Thistrandation object is used to print messages.

Data Entry: Thistranslation object is used to enter data into the Message Editor facility.

translator Thisisthe engine that processes data for the Sterling Gentran:Server, Application
Integration subsystem and Forms Integration subsystem.

transmission See Communications Session.

transmission chain A path an EDI communication could follow, including one company, one trading partner,
and one or more network services.

turnaround A message into which data elements from the source message have been automatically
document  transferred using aturnaround map.
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turnaround map A series of instructions that the system uses to create a turnaround message (a logical
response message to the source) from an inbound (source) message, by transferring data
from the source message to elements in the target message (trand ation object).

UCS  The Uniform Communications Standard is the standard used by the grocery industry.

update  Thisstandard rule enables you to update a specific field in a message record, envelope
segment, interchange, group, current partner, or message (if the map side format type is
EDI), with the contents of the element or field.

Note

Please note that this function updates the internal Sterling Gentran: Server database tables.
We recommend that you use this function only if you are sure you really want to update
theinternal database tables.

Typicaly, you will only use this function if you want to update the message name and
reference in the message table. Any other use of this function could have disastrous
consequences!

use accum This standard rule gives you access to a set of numeric variables that you can manipulate
via numeric operations, and then transfer to and from fields. This function enables you to
add, change, or delete calculations for the element/field, including hash totals (used to
accumulate numeric field values, i.e., quantity, price, etc.). This function also enables you
to map the accumulated total into a control total field, and use accumulators.
Accumulators are used generally for counting the occurrences of a specific element or
generating increasing or sequential record or line item numbers.

usecode  Thisstandard rule enables you to match an element or field against a predefined code
table, specify whether or not a compliance error will be generated if the element or field
does not contain one of the values in the code table, and store a code’s description in
another element or field.

user translation These trandl ation objects control data entry, importing, exporting, message turnaround,
object and creating printed reports. These translation objects are created using the Application
Integration or Forms Integration subsystems. The Application Integration subsystem
enables you to generate import, export, and message turnaround translation objects. The
Forms Integration subsystem enables you to generate data entry and print translation
objects.

version Each standards-setting body updatesits standards on aregular basis. Each formal updateis
referred to asaversion.
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VICS  TheVoluntary Inter-industry Communication Standards is the standards-setting body for
the retail industry, a subset of ANSI X12.

Workspace  This Sterling Gentran: Server browser contains alist of outbound “Work in Progress”
messages. It also contains recently imported or data entry messages.

X12  The ANSI committee that sets and publishes standards for EDI.
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